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Preface 

The national model for freight transportation in Sweden is called Samgods and is aimed to 

provide a tool for forecasting and planning of the transport system in Sweden. Samgods can be 

used for forecasting of possible future scenarios, such as the evaluation of the effects of 

transport policies. Samgods consists of several parts, where the logistics module is the core of 

the model system. In the logistic module, different types of commodities are assigned to different 

types of transport chains based on minimization of the total logistics cost.  

 

To make Samgods more user-friendly, a graphical user interface (GUI), incorporated in Cube, 

has been developed to facilitate the handling of the model.  

This document is the manual for how to use the model system where Samgods has been 

implemented in Cube. For more information about the actual Samgods model, please refer to
1
: 

 the method report for a description of the logistics module of the Samgods model 

 the method report for a description of Railway Capacity Management  

 the program documentation for the logistics module 

 the program documentation for mps.jar 

 the base matrices report.  

 the program documentation for GUI interface 

 the VTI report for a description of the representation of the Swedish transport and 

logistics system in the logistics module 

Trafikverket has commissioned Citilabs to incorporate Samgods in Cube and produced the first 

version of the manual. Trafikverket and Sweco have carried out substantial part of testing and 

troubleshooting of the system. An extended version of the manual is produced in cooperation 

with Trafikverket. During 2014 added functionality has been included in the system to facilitate 

the handling of the rail capacity management procedures (RCM). 

For questions regarding the system, please contact Petter Hill at Trafikverket 

Petter.Hill@Trafikverket.se 

                                                           
1
 See Section 10 (References) for a full reference list 
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Introduction 

This document is the manual for how to use of the graphical user interface of the Samgods 

model in Cube. It describes how to setup input files to run the Logistics Module of the Samgods 

model, how to visualize the output (modal split, traffic work, etc.), and how to compare the output 

from different scenarios. Moreover, the manual aims to show how to use different tools 

developed to facilitate the handling of the large amounts of data produced by the model. 

The system consists of a set of main software components: 

 The Logistic module, which is the core of the system. 

 The Rail Capacity module, which is a new feature to manage rail link flow constraints. 

 Cube Base, where the graphical user interface of Samgods is incorporated. 

 Cube Voyager, which is a transport modelling software used to implement supply and 

assignment models. 

 Cube GIS, which is the geographical information system where the network of the model 

is implemented. 

Below is the outline of the manual: 

Chapter 1: Practical instructions for how to install the Samgods GUI in Cube, together with 

system requirements. 

Chapter 2: General description of the structure of the GUI, the different windows and how to 

work with the applications. It also contains a table with all data that can be accessed via the Data 

Section window in the GUI. 

Chapter 3: Detailed description of all applications, in terms of input data, possible actions and 

choices for how to use the different applications in the system and how to set up the results. This 

chapter should be used more as a look-up guide per application, rather than to be read from start 

to end. 

Chapter 4: General instructions for how to use the graphical user interface, listed after the kind 

of action the user wants to do. A new user to the system is advised to start reading here, after 

having read Chapter 2. 

Chapter 5: Instructions for how to make different kinds of scenario setups. 

Chapter 6: Advanced user options 

Chapter 7: Log reports from the Samgods GUI. 

Chapter 8: Check-list when errors occur. 

Chapter 9: Examples of maps on outputs 

Chapter 10: References. 

Chapter 11: Appendices. 

For the reader who is interested in getting started quickly and who already has some knowledge 

of the Cube system, it is recommended to make sure that the system is properly installed 

(Chapter 1) and then jump to Chapter 4 and 5 for the specific analysis that he/she wants to carry 

out.  

For the reader without previous knowledge of the Samgods GUI or Cube, it is recommended to 

start with Chapter 2 and then read Chapter 4 and 5 from the beginning and refer to Chapter 3 for 

more information on the specific applications. The appendix (Chapter 11) also contains 

explanations on some parts of the model. 
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The use of Cube Base and Cube Voyager is described in the reference guides 

RG_CubeBase.pdf and RG_CubeVoyager.pdf, which can be found where Cube is installed 

(under Citilabs\Cube folder). 

Finally, a technical description of the Samgods GUI is available. See Chapter 10 References 

point 3. 
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Glossary 

Below some important glossaries used in this manual are collected. Observe that for some 

glossaries the explanation is specific for this context.  

 

Application – a group of programs 

Assignment model – a model where the transport demand is assigned to the network. In this 

context, Voyager is used as an assignment model. The automobile and lorry assignments are 

based on generalized time for route choices and all-of-nothing solution. 

Base scenario (or base) – the scenario that is used as reference scenario. See Scenario. 

Commodity or Product group -  commodity type in the model. 

Catalog – the folder where the Samgods model and its set of scenarios are stored. Several 

catalogs, with their corresponding base scenarios, can be included in a project. 

Demand model – a model of the transport demand in terms of OD matrices. In this context, the 

Logistics Module in the Samgods model is a demand model. The Logistics Module has the 

purpose to produce the OD matrices (demand for vehicle movements on legs) from the fixed 

transport demand provided in the PWC matrices (PWC = Production Warehouse Consumption). 

Domestic – transport volumes between domestic zones. 

EOQ - Economic Order Quantity 

Feature class - used in ArcGIS. This is a collection of geographic features with the same 

geometric type (such as point, line or polygon), the same attributes and the same spatial 

reference. Feature classes can be stored in geodatabases, shape files, coverages or other data 

formats. Feature classes allow homogeneous features to be grouped into a single unit for data 

storage purposes. 

Geodatabase (or short: gdb) – a database designed to store and handle geographic 

information and spatial data.  

Keys – a varying input into an application (i.e., parameter settings). Catalog keys are used to 

specify settings for the applications etc.   

MAT - extension for matrix file produced in Cube (binary format) 

Layer – used in GIS. This is the visual representation of a geographic dataset in any digital map 

environment.  

LOS (Level Of Service) matrix (or skim matrix) – a matrix where a particular measure, such as 

time, distance, cost, are summarized link-by-link along the minimum cost path for each OD pair 

(OD = Origin Destination). The distance, domestic distance, fee/toll, and extra cost LOS matrices 

(defined per vehicle type) are mandatory input to the Samgods model. 

Program – a single task or an instance. 

regional diff DT – Reference to regional differentiation by domestic and total domestic. 

regional diff DTI –  Reference to regional differentiation by domestic, total domestic and 

international. 

RCM - Rail Capacity Management module. 

S/A user - Standard User / Advance User. 

Scenario – refers to a set of input files or values. A scenario can be a base scenario, or it can be 

an alternative scenario that is studied in relation to the base scenario, e.g., a child to the base 

scenario. An existing scenario means that the scenario-specific tables are included in the main 

geodatabase. 
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Scenario folder – the folder containing all the data for a specific scenario, located in the 

Scenario_Tree folder. 

Skim matrix – see LOS matrix 

Standard outputs/reports – the outputs/reports that the Samgods GUI always produces. 

STAN group - aggregation of commodity groups 

STD - STanDard Logistics module. 

Supply model – In this context, a supply model (or network model) is the model of the network 

where the transport infrastructure, such as nodes and links (i.e., ports, railways, roads, etc.), are 

implemented. In this context, Voyager is used as supply models.  

TOC – Table Of Content, see Section 4.15. 

Total domestic (or Tdomestic) – same as domestic + domestic part of international transports 

V/C – flow volume over capacity ratio for rail flows. 

#LEA-vehicles –  Reference to loaded, empty and all vehicles respectively. 
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1. Installation Instructions 

This chapter describes the installation requirements, required programs for the Samgods GUI 

and their download locations and the installation procedures for each required program. It also 

describes how to setup the Samgods model in Cube. 

1.1. Minimum system requirements 

Cube Base will run on any Intel Pentium 4-compatible personal computer (including Pentium 4, 

Centrino, Xeon, AMD, and Cyrix chips) running the Windows XP/7/8 or Windows Server 

2003/2008 operating system. The requirements for processor speed, amount of RAM and hard 

disk space are directly related to the operating system, the network, and other file sizes. At a 

minimum, Citilabs recommends: 

 Intel Pentium 4, AMD Athlon 

 1 GB of RAM 

 10 GB for the application and supporting applications and data (like GIS); ATAPI IDE, 

5,400 rpm 

 100+ GB for output files 

 24 bit capable graphics accelerator OpenGL version 2.0 runtime and Shader Model 3.0 

or higher is recommended; ATI or Nvidia GPU is strongly recommended for any 3D GIS 

work or Cube Dynasim micro simulation 

 17-inch monitor, 1024 x 768 higher at Normal size (96dpi); 24 bit color depth 

 Mouse or other pointing device  

 Colour printer or plotter 

A system with additional resources may be more appropriate for certain applications of this 

software. 

Running the Samgods model at an acceptable performance puts a demand on the hardware as 

well as on the operating system. The hardware should preferably have several processors 

available for parallel executions and several GB of RAM to support the allocation of memory to 

each execution and must be based on 64-bit technology. The operating system needs to be able 

to allocate a certain amount of memory to the different processors, see the list below. 

In tests, the Samgods group has lowered the total execution time from over 24 hours to 6 hours 

by using a server with 16 processors on a 64-bit Windows Server 2008 R2 Operating System, 

instead of a laptop with a single processor. 

The graphical interface of the Samgods model allows the user to set the number of commodity 

groups to run simultaneously, in order to have an optimal performance of the system (note that 

this option is available only if Java runtime environment is installed see Section 1.4 below). The 

monitoring of the parallel executions is done by a Java program underneath the GUI, but the 

actual work of allocating memory and tasks to each processor is done by the operating system 

itself. 

There is an upper limit on how many processors that may be used: 

 It is strongly recommended never to use more parallel executions than the number of 

available processors 

 Each processor should in average have at least 1.8 GB of RAM available, or the 

program may encounter out-of-memory problems 

 it is mandatory to run the model on a 64-bit system for RCM procedure. 
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 The model has 34 commodity groups and this number constitutes the upper limit for the 

number of parallel processes for the main part of the logistics model (should the 

hardware allow it). One task involves construction of OD-matrices for 35 vehicle type, 

and this can in principle be parallelized into 35 parallel processes. 

1.2.  Cube Software  

For the Samgods GUI to function, certain Cube software is required. They are: 

 Cube Base: 6.1.0 service pack 1  

 Cube Voyager: 6.1.0 service pack 1  

 Cube GIS: ArcGIS 10.1 service pack 1  

This software is available at ftp://citilabsftp.com/release/cube610SP1setup.exe. 

For the above Cube software, Citilabs License 2013 is required (but newer software and license 

versions may be available later on). Please contact Citilabs for further information regarding this. 

The installation also requires programs necessary for getting spanning tree data from a scenario. 

These programs may be downloaded from Trafikverket. Please contact the project manager 

Petter Hill. 

1.3.  Cube Installation 

To install and run the model full administration rights are required on the PC, or more specifically 

on the model folder, the Citilabs program folder, the ArcGIS program folder and the user folder. 

Do the following steps to install Cube (observe that these steps can be slightly different 

depending on previous installations, newer software versions, etc.): 

1) Attach the dongle to the back of the machine 

2) Install Citilabs License 2013 (or later available license versions) 

3) Install Cube Base (double-click on the cube610SP1setup.exe file) 

4) When requested, install ArcGIS Runtime 10.1 and ArcGIS Runtime 10.1 Service pack 1 

5) Restart the computer 

After having installed standard Cube, you have to install additional new programs contained in 

the Java_Voyager_programs.7z file, following instructions: 

 Files under Voyager_131013 must be copied in the following directories: 

o File Highway.rsc in C:\Program Files (x86)\Citilabs\CubeVoyager\resource 

o File hwyload.dll in C:\Program Files (x86)\Citilabs\CubeVoyager 

o File HWYLOAD.TDF in C:\Program Files (x86)\Citilabs\CubeVoyager 

o File tppdlibx.dll in C:\Program Files (x86)\Citilabs\CubeVoyager 

 File under AppMan must be copied in the following directory: 

o File AppManager.exe in C:\Program Files (x86)\Citilabs\Cube 

 

1.4. Other programs 

If the user wishes to use the advanced options for the logistics module (please refer to Section 

3.5.1 or 4.6 for details), it is also required to have: 

 Java runtime environment (jre-7-windows-x64.exe). Platform: 1.6. Product: 1.6.0_17 

(later program versions are also possible to use) 

Important Note: Update the above programs prior to open the model in Cube! 

ftp://citilabsftp.com/release/cube610SP1setup.exe
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Location for the runtime environment: http://www.java.com/sv/download/    

1.5. Samgods GUI installation 

Unzip the zipped file Samgods.rar, and select a destination folder. The default folder is C:\, 

however, any other folder is working as well. It is recommended to select a folder name without 

any blank value neither special characters (å, ä ö). Moreover, an advice is to put the folder rather 

close to the root (e.g., E:\Samgods\Workfolder\Destination-of-folder).
 

The folder structure for the GUI is displayed in Table 1. 

 

C:\Samgods\ Samgods.cat Catalog file 

 01_Programs Folder 

 02_Applications Folder 

 03_GIS_Data Folder 

 04_Media Folder 

 05_Input_Data Folder 

 06_Reports Folder 

 07_Python Folder 

 Scenario_Tree Folder 

Table 1 Folder structure. 

The scenario folder for a specific scenario is located in the Scenario_Tree folder.  

For the complete list of folders and files, see the technical documentation of the Samgods GUI. 

See Reference on Section 10, point 3. 

To properly install all the programs connected to the model (GIS tools, user programs), do the 

following: 

1) Open the catalog file (Samgods.cat) in Cube Base (double click on the catalog file or 

double click on the Cube icon on the desktop -> welcome screen -> open an existing 

catalog -> browse to Samgods.cat) 

2) To update the paths for the application, double click on each application (in total 8 

applications) under “Applications” window, and click “Yes” to the following question (8 

times): 

“The base path of this Application has been moved from {Old folder} to {Selected folder}. 

Do you wish to update the path for all Application (.APP, .PRJ) and Control (.CTL) files in 

the Application structure? (Note the same subdirectory structure as in the original 

Applications will be assumed)” 

3) To set the properties of the catalog file, go to “Scenario” menu on the toolbar and select 

“Properties”. On the Catalog Properties window, select the “Model User” tab, and set the 

Model User as “Model Applier”. Under Model Applier section select "Developer" as 

shown in Figure 2 

 

 

http://www.java.com/sv/download/
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Figure 1 Right Setting of the catalog file. 

4) Then, select the “Data Panel” tab, and set the values as in  

 

 

 
Figure 2 Setting of properties of the catalog file. 

 

5) Click “OK” to continue 

6) Modify the catalog keys (i.e., parameter settings) below from the interface in the 

following manner: 

a) Select Scenario_Tree scenario 

b) Select the Installation application 

c) Double-click on the Scenario_Tree scenario 

d) For the following catalog keys, change to its corresponding installed version if 

needed
2
 (see Figure 3 for an example): 

                                                           
2
 If you are using Swedish Windows 7/8, the system name of the standard Program folder is 

Program Files. So in the keys in the Installation application, use “C:\Program Files\...”, not 
“C:\Program\...”. 
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i) “Cube Software” (pre-defined: version 6.1.0 Sp1)* 

ii) “ArcGIS Software” ( pre-defined:  10.1 Sp1)* 

iii) “Python Software” (pre-defined: version 27)  

iv) “Logistics Model Software” (pre-defined: 20140627) 

v) For the catalog key “Location of Cube Program” change if needed the 

folder where Cube is installed (pre-defined: C:\Program Files (x86)\)* 

vi) For the catalog key “Location of ArcGIS Program” change if needed the 

folder where ArcGIS is installed (pre-defined: C:\\Program Files (x86)\)*. 

Because this path is used by Python, it is important to use “/” or “\\” 

instead of “\” in this key, see Figure 3 below for an example 

vii) For the catalog key “Location of Python program” change if needed the 

folder where Python 27 is installed (pre-defined: C:\Python27\ArcGIS10.1) 

viii) For the catalog key “Location of Java program” change if needed the 

folder where Java is installed (pre-defined: C:\Windows\System32) 

ix) For the catalog key “Scenario name for the BASE scenario” point to the 

scenario that should be used as base scenario (pre-defined: Base2006) 

 

 

Figure 3 Example of catalog key values for the Installation application. 

 

e) Run the Installation application by clicking “Run” in the scenario interface, or by 

selecting Application -> Run Application -> OK on the main toolbar. (If “OK” is clicked 

instead of “Run”, the application will not run – the changes in the settings will only be 

saved.)  

 

Now the GUI is installed. 

 

* To properly set the values for the catalog keys indicated with *, see the information under the 

Menu Bar; Help -> About (see Figure 4 and Figure 5 below for an example). 
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Figure 4 How to access the “About ...” information. 

 

 

 
Figure 5 Example of the “About ... “ window. 
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2. Cube Interface components 

This chapter outlines the main components of the Cube Interface and explains their functions. 

The Cube Interface has five different windows as shown in Figure 6. When opening the model, 

two different user types can be selected – model developer or model Standard and Advanced 

user. The model developer role is mainly used when setting up or installing the system, while the 

model Standard user Advanced user role typically is used when running the model and for 

scenario handling. The set of active windows depends on the user role, and this manual is 

relevant to both types of model users. 

The large area to the right is a workspace where manager windows and messages are shown, 

e.g., when the user wants to manage a scenario, the Scenario manager window is shown here. 

There are also Application manager windows and Data section manager windows. The manager 

windows are opened from the corresponding window on the left hand side. 

For more information on the Cube interface, please refer to the Cube Help, accessed from the 

main toolbar: Help -> Cube Help. 

 

 

Figure 6 Cube Interface and the five windows. 

2.1.  Scenarios window 

The purpose of the Scenarios window is to list the scenarios that exist in the model. 

A scenario refers to a set of specific input files/values. An application is a group of programs. In 

the Samgods GUI a set of applications are defined with different types of functionalities. Different 

scenarios can be set up in the GUI by using the set of available applications. A scenario can be 

opened and managed using different applications by double-clicking on the scenario name in the 

Scenarios window (in model Standard user Advanced user mode). For example, the input data 

and parameters to the scenario can be displayed or edited. When the scenario is open in the 

Scenario manager window, it is possible to select the application you want to use by the scroll 

down menu. Another way to open the application you want to use is to select the application in 

the Applications window and then double-click on the scenario in the Scenarios window. The 

application is then run by clicking “Run”. 

Application manager window 

Data Section 
window 

Keys 
window 

Applications 
window 

Scenarios 
window 
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The tree structure of the scenarios included in the Samgods GUI is visualized in the 

Scenario_Tree in the Scenarios window. The Scenario_Tree is used for scenario management.  

The default base scenario is included in the Scenario_Tree and is called Base2006. In the base 

scenario all the input data is defined and it represents the parent for future sibling and child 

scenarios. 

An example of a Scenario manager window for the application Edit the data is given in Figure 7 

below. 

 

 

Figure 7 Example of Scenario manager window. 

The keys which are possible to set values for in the Scenario manager window are strictly 

connected to the application selected in the Applications window. In Chapter 3, tables of keys 

connected to the respective applications are presented. 

 

 

2.2.  Applications window 

In the Applications window all applications defined in the model catalog can be found. An 

application group is the collection of programs and sub-groups belonging to the respective 

application. When an application is selected (by clicking on it in the Applications window) the 

application group is shown in the Application manager window. In the Application manager 

window you can see Program boxes (e.g. MATRIX, HIGHWAY, NETWORK, and PILOT) and/or 

other applications (called sub-groups) belonging to the application group (see Figure 8). In the 

Applications window, you can see the main application at the highest level, and go through the 

tree structure down to lower levels. 

Tip. Open an application (in model applier mode) to set the parameters for a particular 

scenario by double-clicking on the scenario and select the application in the scroll down menu. 

Keys 

Data 

Section 

window 
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Figure 8 View of an application and its corresponding application groups. 

In the Samgods GUI, the defined applications are (see the Applications window in model 

developer mode): 

 Installation 

 Create the editable files 

 Edit the data 

 Samgods Model 

 Compare Scenarios  

 Handling Scenario 

 PWC_Matrices 

 Change matrix format 

2.3. Data Section window 

The Data Section window provides direct access to the main input and output files, which can be 

utilized when working with the model (editing, controlling, etc.). It allows the user to display and 

edit the input data, as well as to display the outputs and reports for specific scenarios and runs. 

In conjunction with the Scenario manager window, it enables the user to easily access all data, 

without needing to know where it is actually stored. The structure of the Data Section window is 

described in Table 2, which also shows the location of the files, the names of the tables/maps, a 

short description of its contents and which application that produces or uses the files.  

There are three main folders in the Data Section window: Scenario Inputs, Scenario Outputs and 

Scenario Reports. The General tables under Scenario Inputs are always accessible from the 

Data Section window. The Editable data (also found under Scenario Inputs) is accessible only 

during the edit phase or if the user has selected not to delete the temporary geodatabase (see 

explanation for the Edit the data applications in Section 3.4). 

The available output in the Scenario Outputs folder depends on the choices made when running 

the Samgods Model application. The available outputs in the folder Scenario Outputs\Samgods 

Report are always listed in the log report Scenario Outputs\Samgods Report\Existing Outputs. 

There are two other log reports except Existing Outputs: Report for the import phase and Report 

for the edit phase, which state any error messages or other messages from the applications 

Application group 
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Handling scenario and Edit the data. For more information on the log reports, see Table 2 and 

Chapter 0. 

Moreover, the Data Section window includes the 17 standard reports per Standard Logistic 

Module and 18 standard reports for Rail Capacity Management, also called summary reports, 

which summarize the output from running the Samgods GUI, in Word format. The summary 

reports are found in the Scenario Reports folder and are listed last in Table 2. To browse to 

different pages in the reports, use the arrows in the main toolbar. It is possible to export the 

tables to Excel, by selecting the table in the Word format report, right-clicking and selecting 

“Export” and type in a name with an Excel file format ending. Some of the standard reports are 

also available as spread sheet reports in the Scenario Outputs folder, where they are marked 

with the same report number as in Scenario Reports (see, e.g., Scenario Outputs\Samgods 

Report\Logistic Module\OD Covered).  

For some of the data files, the variable names that appear in the headings are explained in 

tables in the appendix. 

Before using and analyzing any output data regarding empty vehicles/vehicle kilometres or the 

total number of vehicles (i.e. loaded + empty vehicles), please read the Section 11.2 about empty 

vehicles in the appendices. 

The GUI allows producing different aggregations in the results for Standard Logistic Module. The 

model could produce the total number of loaded, empty and tonnes for all the commodity groups, 

or just for a specific commodity or STAN group. The outputs will be saved with different name 

files ending with a number of a suffix. Depending on the user choice, the possible values could 

be: 

 0 (zero): all the commodities are aggregated, so the volumes and tonnes represent totals 

 A number among 1 and 35: a single commodity has been run  

 A suffix STAN1 to STAN12: an aggregation of results based on STAN group definition 

In order to access to the different aggregations, e.g. different files, it is requested to set the value 

for catalog key “Select commodities for the Logistics module (…)” in the Samgods Model 

application to the commodity or commodity group number you want to view and clicking “Save” 

(please refer to Section 3.5 for more information). 

For Rail Capacity Management Module (RCM) there are not options and the only available 

choice is 0. That is related to the matter that the process requires all the volumes to properly 

assess the congested level on the rail network, therefore a run for a specific commodity or STAN 

group would be meaningless. 

Folder Name Description Used by application 

Scenario Inputs  This folder contains 

all the inputs for the 

scenarios 

All 

Scenario 

Inputs\Model 

Operating instructions 

Model Operating 

Instructions 

Rtf file with a short 

description on how to 

run the Samgods GUI 

All 

Scenario 

Inputs\General tables 

Link Categories Lookup table for the 

categories in the 

network 

All 
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Folder Name Description Used by application 

 NodeClass 

description 

Lookup table for the 

numbering system (no 

longer required for the 

VY part) 

All 

 Transfer Type at 

terminals 

Lookup table for the 

transfer type coded in 

the 

Nodes_Commodities 

data 

Samgods Model 

 List and codes for 

modes (only visible in 

developer mode) 

Alphanumerical codes 

for modes  

All 

 Zoning System Lookup table for the 

ID_Region and 

ID_Country codes 

All 

 Modes Lookup table for 

codes used for modes 

All 

 V101 Speed Flow 

Curves 

Speed flow table with 

parameter values for 

defining the delay 

functions for vehicle 

class 101 (light lorry) 

Samgods Model 

 V102 Speed Flow 

Curves 

Same as previous but 

for vehicle classes 

102-105  

Samgods Model 

 Ranges for node 

classes (only visible in 

developer mode) 

For node classes from 

12 to 19 the range of 

allowed values for 

node numbers 

Edit the data 

 Default values for the 

frequency matrices 

(only visible in 

developer mode) 

Default frequencies 

for different vehicle 

classes based on the 

terminal type  

Edit the data 

 Port area 

classification 

Port areas 

classification for 

Swedish ports 

Edit the data 

 Lower and upper 

bounds for 

consolidation factors 

Default upper and 

lower bounds for the 

consolidation level 

ranking output per 

submode 

See Section 10 point 

4 for reference. 

Samgods Model 
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Folder Name Description Used by application 

 Empty vehicle 

fractions per vehicle 

type and distance 

Function applied in 

extract procedure per 

vehicle type. The 

empty vehicles are 

calculated as fraction 

of loaded ones based 

on function depending 

on distance. See 

Section 10.6 for 

reference. 

Samgods Model 

 County names List of Sweden 

counties (in Swedish: 

län) and related 

identification code 

Samgods Model 

 Other statistics 2006 Statistics on Kiel 

Canal, Öresund 

bridge and Jylland in 

year 2006 used in the 

calibration procedure 

Samgods Model 

Scenario 

Inputs\General 

tables\Logistics 

module (only visible in 

developer mode and 

advanced user) 

Main vehicle class for 

BuildChain 

The main vehicle type 

used in the 

BuildChain process 

by submode id (i.e. 

vehicle submode A-U) 

and commodity (P1-

P35). 

Samgods Model 

 Vehicle types by 

chain and submode 

(ChainChoi) 

List of vehicle types 

(VHCL_NR) by 

submode id and 

commodity  for 

ChainChoi 

Samgods Model 

 Direct Access Whether or not direct 

access is active by 

commodity (P1-P35) 

and type of firm-to-

firm flow (0-9, see 

table Type of Flow 

MATRIX below) 

Samgods Model 

 Type of Flow MATRIX Lookup table with 

codes for type of flow 

matrices 

Samgods Model 

 List of Chains List of Chain types Samgods Model 

 Vehicle type (Vessel 

Type, vessel  ship) 

Lookup table with 

codes for vehicle 

types  

Samgods Model 
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Folder Name Description Used by application 

 Consolidation factors 

by commodity groups 

(i. e. STAN product 

groups)  

Individual 

consolidation bounds 

for all submodes 

[LB,UB] Default 

values and specific 

values for STAN 

groups 2, 8 and 9 

Samgods Model 

Scenario 

Inputs\Editable data 

Input_Data.mxd General map to 

visualize all 

georeferenced data 

Edit the data 

 EMME Network (211 

format)  

The Emme transport 

network with all link 

and node attributes 

(see Section 5.1 for 

further details) 

Edit the data 

 EMME Speed table  Emme speed table 

(see Section 5.1 for 

further details) 

Edit the data 

 General parameters 

(only visible in 

developer mode) 

Table with the 

scenario parameters 

catalog key settings 

Edit the data 

 Logistics model 

parameters (only 

visible in developer 

mode) 

Table with logistics 

module parameters  

Edit the data 

 Cargo Table General values per 

commodity   

Edit the data 

 Vehicles Parameters General values for 

each vehicle type. 

The attribute 

“EMPTY_V” (1 or 0) 

concerns whether the 

number of empty 

vehicles will be 

calculated (1) or not 

(0) (see the appendix 

and Section 5.4)  

Edit the data 

 Vehicle Parameters 

Exceptions 

Specific values for 

some commodities. 

(see Section 5.5 for 

further details). 

Edit the data 

 Scenario Network Network (links and 

nodes) for all modes 

(GIS map) 

Edit the data 
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Folder Name Description Used by application 

 Nodes Commodities GIS map with all 

terminals and 

specifications on 

allowed transfer types 

and commodities per 

terminal 

Edit the data 

 Nodes GIS map of zones 

and terminals with 

values for the logistics 

module and port area 

classification 

Edit the data 

 Ports Sweden GIS map of Swedish 

ports with the pilot 

fees by vehicle type 

(sea mode only) 

Edit the data 

 Frequency network  GIS map with service 

frequencies 

(transports per week) 

per mode/combination 

of modes and origin-

destination 

connection. For more 

information on the 

frequency network, 

see the appendix 

Edit the data 

 Tax by country Table Tax by country and 

vehicle type 

Edit the data 

 Tax by Linkclass  Tax by link type and 

vehicle type 

Edit the data 

 Tax by link  Tax for specific links 

by vehicle type 

Edit the data 

 Toll bridges Bridge tolls per 

vehicle type 

Edit the data 

 Rail capacity table Daily bidirectional 

capacity for domestic 

rail links 

Edit the data 

Scenario 

Inputs\Emme tables 

Default values for the 

EMME macros (only 

visible in developer 

mode) 

Table containing 

matrix names for LOS 

matrices in emme 

format 

Edit the data 
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Folder Name Description Used by application 

Scenario 

Inputs\Others  

In-zone distances – 

default values (only 

visible in developer 

mode) 

Default values for 

distances within each 

zone (diagonal values 

in the distance 

matrices). Applied 

when origin and 

destination are in the 

same zone 

Samgods Model 

 Geodatabase file for 

exported matrices 

Location of the 

geodatabase file 

Change matrix format 

 Rail capacity table 

with EMME node 

numbers 

As Rail capacity table 

with added 

information of EMME 

nodes 

Samgods Model 

Scenario 

Inputs\PWC_Matrices 

PWC matrix for 

commodity 

Displays the PWC 

matrix in Voyager 

format for a specific 

commodity, see 

Section 3.8 for 

instructions 

PWC_Matrices 

Scenario 

Inputs\Calibration 

factors 

Port area differences 

(RCM) (only visible in 

developer mode) 

Differences between 

modelled and 

surveyed tonnes per 

port area and STAN 

group 

Samgods Model 

 Parameters for Port 

Area Calculation (only 

visible in developer 

mode) 

Step length, minimum 

value, cut off value 

and default minimum 

value for calibration of 

port area throughputs  

Samgods Model 

 Parameters for Kiel 

Canal Calculation 

(only visible in 

developer mode) 

Step length, minimum 

value, cut off value 

and default minimum 

value for calibration of 

Kiel canal flows 

Samgods Model 

 Port Area Scaling 

factors (only visible in 

developer mode) 

Resulting scaling 

factors applied per 

STAN group and port 

area to TIME skims 

Samgods Model 

 Kiel Canal Scaling 

factor (only visible in 

developer mode) 

Resulting scaling 

factor for the Kiel 

canal applied to TOLL 

value 

Samgods Model 

Scenario Outputs Existing Outputs (Log 

report) 

List of available 

outputs in the 

Samgods Report 

Samgods Model 
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Folder Name Description Used by application 

Scenario 

Outputs\Scenario_Im

port_function_Report 

Report for the import 

phase (Log report) 

Report with any 

warnings or 

messages from the 

Scenario import 

function (in the 

Handling scenario 

application) (see 

Section 7.3 ) 

Handling scenario 

Scenario Outputs\Edit 

the data Report 

Report for the edit 

phase (Log report) 

Report with any 

warnings or error 

messages from the 

Edit the data 

application (see 

Section 7.1) 

Edit the data 

Scenario 

Outputs\Samgods 

Report\LOS matrices 

generation 

LOS Road Mode 

LOS Raíl Mode 

LOS Sea Mode 

LOS Air Mode 

LOS matrices 

between zones (both 

terminals and actual 

zones) per vehicle 

type for: 

time – T [hours], 

distance – D [km],  

extra costs – X [SEK],  

domestic distances – 

DD [km] 

Samgods Model 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Vehicles 

MAT 

Road – Vehicle Flows 

Rail – Vehicle Flows 

Sea – Vehicle Flows 

Air – Vehicle Flows 

OD matrices of 

loaded vehicle flows 

by vehicle type. The 

sheet name indicates 

the vehicle type and 

the scenario name 

Samgods Model 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Tonnes 

MAT 

Road – Goods Flows 

Rail – Goods Flows 

Sea – Goods Flows 

Air – Goods Flows 

OD matrices in tonnes 

by vehicle type. The 

sheet name indicates 

the vehicle type and 

the scenario name 

Samgods Model 
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Folder Name Description Used by application 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Empty 

Vehicles MAT 

Road – Empty vehicle 

Flows 

Rail – Empty vehicle 

Flows 

Sea – Empty vehicle 

Flows 

Air – Empty vehicle 

Flows 

OD matrices of empty 

vehicle flows by 

vehicle type. The 

sheet name indicates 

the vehicle type and 

the scenario name. 

For important 

explanations of the 

output in terms of 

empty vehicles, see 

appendix section 11.2 

Samgods Model 

Scenario 

Outputs\Samgods 

Report\Logistics 

Module\OD Covered 

Output by vehicle 

class (spread sheet 

for summary report 

no. 2: Logistics 

module) 

Summary table with 

information by vehicle 

type (number of 

shipments, number of 

loaded vehicles, 

transport distances, 

tonnes, tonne kms, 

average loading 

factors, average 

distances), split up on 

domestic, 

international and total 

Samgods Model 

 Output by chain 

(spread sheet for 

summary report no. 2: 

LM chains) 

Summary table with 

information by chain 

type (total numbers of 

shipments, transport 

distances, tonnes, 

tonne kms, logistic 

costs, average costs 

per tonne km), split up 

on domestic, 

international and total  

Samgods Model 

 Loaded Demand 

(spread sheet for 

summary report no. 2: 

LM Demand) (new) 

Summary table of the 

tonnes transported 

and the tonnes in the 

PWC-matrices 

together with 

allocation success 

rates  

Samgods Model 

 Report #3 Tonkms 

per Mode with 

statistics 2006 STD 

(Spread sheet for 

summary report no. 3) 

Tonne-kms  in 

millions on domestic 

movements per main 

mode (Road, Rail, 

Sea) and international 

(Air) in standard 

logistics module 

Samgods Model 
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Folder Name Description Used by application 

 Report #5 Logistics 

costs at zone level 

(Spread sheet for 

summary report no. 5) 

Logistics costs per 

zone per commodity 

(P01-P35) and from/to 

flows to a zone 

Samgods Model 

 Report #6 Goods flow 

through terminals 

(Spread sheet for 

summary report no. 6) 

Goods flow (tonnes) 

through terminals per 

commodity (P01-P35) 

and divided by direct 

access to 

(DAIMPORN),and 

from (DAEXPORN) or 

regular (REGULARN). 

Regular refers to 

flows not having direct 

access 

Samgods Model 

 Report #7 Domestic 

tonne kms with 

container per mode 

(road, rail, sea, air) 

(Spread sheet for 

summary report no. 7) 

Transport work (tonne 

kms) in Sweden for 

containers per 

commodity and 

vehicle type 

Samgods Model 

 Report #8 Domestic 

vehicle kms with 

container per mode 

(road, rail, sea, air) 

(Spread sheet for 

summary report no. 8) 

Traffic work (vehicle 

kms) in Sweden for 

container transports 

per commodity and 

vehicle type 

Samgods Model 

 Report #10 Tonnes 

km per mode, 

commodity, domestic, 

total domestic and 

international (Spread 

sheet for summary 

report no. 10) 

Transport work (tonne 

kms) per commodity, 

mode. Split into three 

categories: domestic, 

total domestic and 

international 

respectively 

Samgods Model 

 Report #11 Tonnes 

per mode, commodity, 

domestic, tdomestic 

and international 

(Spread sheet for 

summary report no. 

11) 

Transported tonnes 

per commodity. Split 

into three categories: 

domestic, total 

domestic and 

international 

respectively 

Samgods Model 

 Report#12 node and 

link costs per vehicle 

and product group 

(Spread sheet for 

summary report no. 

12)(new) 

Link and node costs 

per vehicle type, per 

commodity and split 

into total domestic 

and  international 

respectively 

Samgods Model 
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Folder Name Description Used by application 

Scenario 

Outputs\Samgods 

Report\Assignment 

Road Assigned 

Network 

Rail Assigned 

Network 

Sea Assigned 

Network 

Air Assigned Network 

GIS map with the 

assignment of the 

freight flows to the 

transport network per 

vehicle type, in tonnes 

and in number of 

vehicles (loaded and 

empty). For important 

information on the 

empty vehicles, see 

appendix Section 

11.2. 

Samgods Model 

Scenario 

Outputs\Samgods 

Report\Reports 

Assigned Network GIS map with the 

assignment of the 

freight flows to the 

transport network with 

all vehicle types in the 

same network, in 

tonnes  and in 

number of vehicles 

(loaded and empty) 

For important 

information on the 

empty vehicles, see 

appendix Section 

11.2. 

Samgods Model 

 Report #1 VHL and 

VHCLKM (Spread 

sheet for summary 

report no. 1) 

Summary table of 

number of vehicles 

and vehicle kms per 

vehicle type and 

mode (split up into 2 

regional categories 

domestic and total 

domestic and 3 

aggregation levels 

loaded/empty/all 

vehicles). See 

appendix Section 

11.2. 

Samgods Model 

 Report #4 TONNES 

AND TONNESKM 

(Spread sheet for 

summary report no. 4) 

Summary table of 

tonnes and tonne kms 

(domestic, 

international and total) 

per vehicle type and 

mode road, rail, sea 

and air.  

Samgods Model 
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Folder Name Description Used by application 

 Report #9 Vehicle 

kms, tonne kms, 

empty vehicle kms 

and total vehicle kms 

per geographic region 

per mode (road, rail) 

(Spread sheet for 

summary report no. 9) 

Summary table of 

vehicle kms (split up 

into loaded, empty 

and all vehicles) and 

tonne kms per 

geographic region 

and mode (road and 

rail). See appendix 

Section 11.2. 

Samgods Model 

 Report #13 Port area 

statistics STD 

(Spread sheet for 

summary repost no. 

13) 

Tonnes per port area 

and STAN group and 

comparison with 

statistics (results from 

standard logistics 

module) 

Samgods Model 

 Report #14 Oresund 

Kiel canal STD 

(Spread sheet for 

summary report no. 

14) 

Results on Öresund 

bridge, Kiel canal and 

Jylland and 

comparison with 

statistics (results from 

standard logistics 

module) 

Samgods Model 

 Bidirectional tonnes 

per mode STD 

Network with 

bidirectional 

tonnes/100.000 per 

mode road, rail and 

sea (results from 

standard logistics 

module) 

Samgods Model 

 Report #16 VHCLKM 

and distribution per 

road vehicle type and 

county – totals 

(Spread sheet for 

summary report no. 

16) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on all the 

roads (results from 

standard logistics 

module) 

Samgods Model 

 Report #17 VHCLKM 

and distribution per 

road vehicle type and 

county – Category 11 

(Spread sheet for 

summary report no. 

17) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on E10 

(European roads = 

category 11) (results 

from standard 

logistics module) 

Samgods Model 
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Folder Name Description Used by application 

 Report #18 VHCLKM 

and distribution per 

road vehicle type and 

county – Other roads 

(Spread sheet for 

summary report no. 

18) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on all 

types roads except 

E10 (results from 

standard logistics 

module) 

Samgods Model 

Scenario 

Outputs\RCM Report 

Rail Capacity table for 

current scenario 

Definition of rail 

bidirectional 

capacities per day for 

the current scenario 

Samgods Model 

 Rail Capacity table 

with revised 

capacities from Adjust 

procedure 

Definition of rail 

bidirectional 

capacities per day for 

current scenario after 

applying the Adjust 

procedure10.6 for 

reference. 

Samgods Model 

Scenario 

Outputs\RCM 

Report\Logistic 

Module\OD Vehicles 

MAT 

Road – Vehicle Flows 

Rail – Vehicle Flows 

Air – Vehicle Flows 

Sea – Vehicle Flows 

OD matrices of 

loaded vehicle flows 

by vehicle type 

(results from Rail 

Capacity 

Management 

module). The sheet 

name indicates the 

vehicle type and the 

scenario name. 

Samgods Model 

Scenario 

Outputs\RCM 

Report\Logistic 

Module\OD Tonnes 

MAT 

Road – Goods Flows 

Rail – Goods Flows 

Air – Goods Flows 

Sea – Goods Flows 

OD matrices in tones 

by vehicle type 

(results from Rail 

Capacity 

Management 

module).  The sheet 

name indicates the 

vehicle type and the 

scenario name 

Samgods Model 

Scenario 

Outputs\RCM 

Report\Logistic 

Module\OD Empties 

MAT 

Road – Empty vehicle 

Flows 

Rail – Empty vehicle 

Flows 

Air – Empty vehicle 

Flows 

Sea – Empty vehicle 

Flows 

OD matrices of empty 

vehicle flows by 

vehicle type. 

Samgods Model 
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Folder Name Description Used by application 

Scenario 

Outputs\RCM 

Report\Logistic 

Module\OD Covered 

Output by vehicle 

class (RCM) 

Summary table with 

information by vehicle 

type (number of 

shipments, number of 

loaded vehicles, 

transport distances, 

tonnes, tonne kms, 

average loading 

factors, average 

distances) and 

regional diff DTI.  

Samgods Model 

 Output by chain 

(RCM) 

Summary table with 

information by chain 

type (total numbers of 

shipments, transport 

distance, tonnes, 

tonne kms, logistic 

cost, average cost per 

tonne km) and 

regional diff DTI. 

Samgods Model 

 Loaded Demand  

(RCM) 

Summary table of the 

tonnes transported 

and the tonnes in the 

PWC-matrices 

together with 

allocation success 

rates  

Samgods Model 

 Report #3 TonsKm 

per mode with 

statistics 2006 RCM 

(Spread sheet for 

summary report no. 3) 

Tonne-km in millions 

on domestic 

movements per main 

mode (Road, Rail, 

Sea) and international 

(Air)  

Samgods Model 

 Report #5 Logistic 

costs at zone level 

(RCM) (Spread sheet 

for summary report 

no. 5) 

Logistics costs per 

zone per commodity 

(P01-P35) and from/to 

flows to a zone 

Samgods Model 

 Report #6 Goods flow 

through terminals 

(Spread sheet for 

summary report no. 6) 

Goods flow (tonnes) 

through terminals per 

commodity (P01-P35) 

and divided by direct 

access to 

(DAIMPORN),and 

from (DAEXPORN) or 

regular (REGULARN). 

Regular refers to 

flows not having direct 

access 

Samgods Model 
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Folder Name Description Used by application 

 Report #7 Domestic 

tonne kms with 

container per mode 

(road, rail, sea, air) 

(RCM) (Spread sheet 

for summary report 

no. 7) 

Transport work (tonne 

kms) in Sweden for 

container transports 

per commodity and 

vehicle type  

Samgods Model 

 Report #8 Domestic 

vehicle kms container 

per mode (road, rail, 

sea, air) (RC) (Spread 

sheet for summary 

report no. 8) 

Traffic work (vehicle 

kms) in Sweden for 

container tranports 

per commodity and 

vehicle type   

Samgods Model 

 Report #10 Tonnes 

km  per mode, 

commodity, domestic, 

tdomestic and 

international (RCM) 

(Spread sheet for 

summary report no. 

10)  

Transport work (tonne 

kms) per commodity, 

vehicle type and 

regional diff DTI 

domestic/total 

domestic/international  

Samgods Model 

 Report #11 Tonnes 

per mode, commodity, 

domestic, tdomestic 

and international 

(Spread sheet for 

summary report no. 

11) 

Tonnes per 

commodity, vehicle 

type and regional diff 

DTI  

Samgods Model 

 Report #12 node and 

link costs per vehicle 

and product group 

(RCM) (Spread sheet 

for summary report 

no. 12) 

Link and node costs 

per vehicle type, per 

commodity and 

regional diff DTI  

Samgods Model 

Scenario 

Outputs\RCM 

Report\Assignment 

Road Assignment 

Network (RCM) 

Rail Assignment 

Network (RCM) 

Sea Assignment 

Network (RCM) 

Air Assignment 

Network (RCM) 

GIS map with the 

assignment of the 

freight flows to the 

transport network per 

vehicle type, in tonnes 

and in number of 

loaded and empty 

vehicles respectively  

Samgods Model 
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Folder Name Description Used by application 

Scenario 

Outputs\RCM 

Report\Reports 

Assigned Network GIS map with the 

assignment of the 

freight flows to the 

transport network with 

all vehicle types in the 

same network, in 

tonnes and in number 

of loaded and empty 

vehicles respectively  

Samgods Model 

 Report #1 VHL and 

VHCLKM (RCM) 

(Spread sheet for 

summary report no. 1) 

Summary table of 

number of vehicles 

and vehicle kms per 

vehicle type  and 

mode (split up into 

regional diff DT and 

into loaded/empty 

total number of 

vehicles).  

Samgods Model 

 Report #4 TONNES 

and TONNESKM 

(RCM) (Spread sheet 

for summary report 

no. 4) 

Summary table of 

tonnes and tonne kms 

by regional DTI per 

vehicle type and 

mode  

Samgods Model 

 Report #9 Vehicle 

kms, tonne kms, 

empty vehicle kms 

and total vehicle kms 

per geographic region 

per mode (road, rail) 

(RCM) (Spread sheet 

for summary report 

no. 9) 

Summary table of 

vehicle kms (split up 

into #LEA-vehicles) 

and tonne kms per 

geographic region 

and mode (road and 

rail)  

Samgods Model 

 Report #13 Port area 

statistics RCM 

(Spread sheet for 

summary report no. 

13) 

Tons per port area 

and STAN group and 

comparison with 

statistics  

Samgods Model 

 Report #14 Oresund 

Kiel canal RCM 

(Spread sheet for 

summary report no. 

14) 

Results on Öresund 

bridge, Kiel canal and 

Jylland and 

comparison with 

statistics  

Samgods Model 

 Report #15 Trains per 

day  (tot, empty, 

loaded) from RCM 

procedure (Spread 

sheet for summary 

report no. 15) 

Number of loaded and 

empty trains per day 

bidirectional and 

differences between 

totals and capacities  

Samgods Model 
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Folder Name Description Used by application 

 Report #15b Rail 

Capacity Network 

Network with 

capacities and #LEA-

trains per day (same 

statistics as in Report 

#15 but shown in the 

network) 

Samgods Model 

 Bidirectional tonnes 

per mode RCM 

Network with 

bidirectional 

tonnes/100.000  

Samgods Model 

 Report #16 VHCLKM 

and distribution per 

road vehicles and 

county – totals (RCM) 

(Spread sheet for 

summary report no. 

16) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on all the 

roads  

Samgods Model 

 Report #17 VHCLKM 

and distribution per 

road vehicles and 

county – Category 11 

(RCM) (Spread sheet 

for summary report 

no. 17) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on E10 

(European roads = 

category 11)  

Samgods Model 

 Report #18 VHCLKM 

and distribution per 

road vehicles and 

county – Other roads 

(RCM) (Spread sheet 

for summary report 

no. 18) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on other 

road types than E10  

Samgods Model 

 Comparison Ml Tons 

RCM vs Standard per 

mode 

Absolute and  

percentage 

differences per mode 

road, rail and sea (in 

millions of tonnes) 

between RCM and 

STD 

Samgods Model 

Scenario 

Outputs\Compare\LO

S matrices generation 

LOS Road Dif 

LOS Raíl Dif 

LOS Sea Dif 

LOS Air Dif 

Absolute cost 

differences between 

the current scenario 

and the scenario used 

for comparison for the 

LOS matrices 

Compare Scenarios 



Cube Interface components 

37 
 

Folder Name Description Used by application 

Scenario 

Outputs\Compare\Log

istics Module\OD 

vehicles MAT 

Road OD Dif 

Rail OD Dif 

Sea OD Dif 

Air OD Dif 

Absolute differences 

in loaded vehicles 

between the current 

scenario and the 

scenario used for 

comparison for the 

OD matrices 

Compare Scenarios 

Scenario 

Outputs\Compare\Log

istics Module\OD 

Tonnes MAT 

Road TON Dif 

Rail TON Dif 

Sea TON Dif 

Air TON Dif 

Absolute differences 

in tonnes between the 

current scenario and 

the scenario used for 

comparison for the 

OD matrices 

Compare Scenarios 

Scenario 

Outputs\Compare\Log

istics Module\OD 

empty MAT 

Road EMP Dif 

Rail EMP Dif 

Sea EMP Dif 

Air EMP Dif 

Absolute differences 

in empty vehicles 

between the current 

scenario and the 

scenario used for 

comparison for the 

OD matrices. 

 

Compare Scenarios 

Scenario 

Outputs\Compare\Log

istics Module\Tot Gen 

Att 

TRIPEND Road Dif 

TRIPEND Rail Dif 

TRIPEND Sea Dif 

TRIPEND Air Dif 

Total generation (sum 

of each row) and 

attraction (sum of 

each column) for the 

vehicle OD matrices 

and absolute 

differences to the 

scenario used for 

comparison  

Compare Scenarios 

Scenario 

Outputs\Compare\Ass

ignment 

Compared Load Net 

STD 

Compared Load Net 

RCM 

GIS map with 

absolute differences 

between the current 

scenario and the 

scenario used for 

comparison of loaded 

vehicles flows for all 

vehicle types and 

modes 

Compare Scenarios 

Scenario 

Reports\Logistic 

Module (contains the 

summary reports for 

standard logistic 

module) 

Report_1_Tot VHC 

and VHCKM by VHC 

Type 

Number of vehicles 

and vehicle kms per 

vehicle type (#LEA).  

And regional diff DT.  

Samgods Model 



Cube Interface components 

38 
 

Folder Name Description Used by application 

 Report_2_Logistics 

Module 

Summary table of no. 

of shipments, no. of 

loaded vehicles, 

transport distances, 

tonnes, tonne kms, 

average load factors 

and average distance 

by vehicle type by 

regional diff DTI  

Samgods Model 

 Report_2_LM_CHAIN

S 

Summary table of no. 

of shipments, costs, 

vehicle kms, tonnes, 

tonne kms and 

average logistic costs 

per tonne km, by 

transport chain type 

Samgods Model 

 Report_2_LM_DEMA

ND 

Summary table of the 

tonnes transported 

and the tonnes in the 

PWC-matrices 

together with 

allocation success 

rate  

Samgods Model 

 Report_3_TonKm_per

_Mode_with_2006Sta

tisticsSTD 

Tonne-kms in millions 

on domestic 

movements per main 

mode (Road, Rail, 

Sea) and international 

(Air) 

Samgods Model 

 Report_4_Total 

tonnes and tkms by 

VHC type 

Summary table of 

tonnes and tonne-kms 

(regional diff DTI) per 

vehicle type 

Samgods Model 

 Report_5_Total 

logistic cost at zone-

level 

Total logistics costs 

per commodity type 

(P01-P35) split by 

import and export at 

geographical zone 

level 

Samgods Model 

 Report_6_Goods flow 

through terminals 

(number of tonnes in 

and out per year) 

No. of tonnes through 

terminals (described 

as zones) per 

commodity (P01-

P35), split into from/to 

flows for direct access 

and flow for other 

terminals (without 

direct access 

Samgods Model 
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Folder Name Description Used by application 

 Report_7_Domestic 

tonne kms  with 

container per mode 

(road, rail, sea, air) 

and vehicle cl  

Domestic tonne kms 

with container 

transports per mode 

and vehicle type, split 

by commodity. 

Total volume is also 

reported  

Samgods Model 

 Report_8_Domestic 

vehicle kms with 

container per mode 

(road, rail, sea, air) 

and vehicle cl 

Domestic vehicle kms 

with container 

transports per mode 

and vehicle type, split 

by commodity Total 

volume is also 

reported 

Samgods Model 

 Report_9_Vehicle 

kms and Tonnes kms 

per geographic region 

Vehicle kms (for 

#LEA-vehicles) and 

tonne kms per 

geographical region 

(road and rail mode).  

Samgods Model 

 Report_10_Transport 

work (tonne kms) per 

mode and vehicle cl, 

total and split per 

commodity, domestic, 

tdomestic and 

international 

Transport work (tonne 

kms) per mode and 

vehicle type and 

commodity. Regional 

diff DTI  

Samgods Model 

 Report_11_ 

Transported goods 

volume per mode 

vehicle cl, total and 

split per commodity, 

domestic, tdomestic 

and international 

Transported goods (in 

tonnes) per mode and 

vehicle type and 

commodity, as well as 

regional diff DTI  

Samgods Model 

 Report_12_node and 

link costs per vehicle 

and product group 

Node and link costs 

per vehicle type and 

product group, divided 

in total domestic and 

international 

Samgods Model 

 Report_13_Tons_per

_PortArea_and_STA

N_Group 

Tonnes per port area 

and STAN group and 

comparison with 

statistics  

Samgods Model 

 Report_14_Oresund 

Bridge_Kiel Canal 

and Jylland 

Results on Öresund 

bridge, Kiel canal and 

Jylland and 

comparison with 

statistics 

Samgods Model 
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Folder Name Description Used by application 

 Report_16_VHCLKM 

and distribution by 

county - totals STD 

Vehicle kms per 

county and vehicle 

type and their 

distribution on all the 

roads  

Samgods Model 

 Report_17_VHCLKM 

and distribution by 

county - E10 roads 

STD 

Vehicle kms per 

county and vehicle 

type and their 

distribution on E10 

(category 11) 

Samgods Model 

 Report_18_VHCLKM 

and distribution by 

county Other roads 

STD 

Vehicle kms per 

county and vehicle 

type and their 

distribution on all the 

roads except E10 

Samgods Model 

Scenario Reports\Rail 

Capacity 

Management 

(contains the 

summary reports for 

rail capacity 

management) 

Report_1_Tot VHC 

and VHCKM by VHC 

Type (RCM) 

Number of vehicles 

and vehicle kms 

(#LEA) Regional diff 

DT 

Samgods Model 

 Report_2_Logistics 

Module (RCM) 

Summary table of no. 

of shipments, no. of 

loaded vehicles, 

transport distances, 

tonnes, tonne kms, 

average load factors 

and average 

distances by vehicle 

type, split up into 

regional diff DTI  

Samgods Model 

 Report_2_LM_CHAIN

S (RCM) 

Summary table of no. 

of shipments, costs, 

vehicle kms, tonnes, 

tonne kms and 

average logistic costs 

per tonne km, by 

transport chain type 

Samgods Model 

 Report_2_LM_DEMA

ND (RCM) 

Summary table of the 

tonnes transported 

and the tonnes in the 

PWC-matrices 

together with 

allocation success 

rate 

Samgods Model 
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Folder Name Description Used by application 

 Report_3_TonKm_per

_Mode_with_2006Sta

tistics (RCM) 

Tonne-kms in millions 

on domestic 

movements per main 

mode (Road, Rail, 

Sea) and international 

(Air) 

Samgods Model 

 Report_4_Total 

tonnes and tkms by 

VHC type (RCM) 

Summary table of 

tonnes and tonne-kms 

(regional diff DTI) per 

vehicle type 

Samgods Model 

 Report_5_Total 

logistic cost at zone-

level (RCM) 

Total logistics costs 

per commodity  (P01-

P35) split by from/to 

flow at geographical 

zone level 

Samgods Model 

 Report_6_Goods flow 

through terminals 

(number of tonnes in 

and out per year) 

(RCM) 

No. of tonnes through 

terminals per P01-

P35. 

Samgods Model 

 Report_7_Domestic 

tonne kms  with 

container per mode 

(road, rail, sea, air) 

and vehicle cl (RCM) 

Domestic tonne kms 

with container 

transports per mode 

and vehicle type, split 

by commodity Total 

volume is also 

reported 

Samgods Model 

 Report_8_Domestic 

vehicle kms with 

container per mode 

(road, rail, sea, air) 

and vehicle cl (RCM) 

Domestic vehicle kms 

with container 

transports per mode 

and vehicle type, split 

by commodity Total 

volume is also 

reported 

Samgods Model 

 Report_9_Vehicle 

kms and Tonnes kms 

per geographic region 

(RCM) 

Vehicle kms (#LEA) 

and tonne kms per 

geographical region 

(road and rail mode).  

Samgods Model 

 Report_10_Transport 

work (tonne kms) per 

mode and vehicle cl, 

total and split per 

commodity, domestic, 

tdomestic and 

international (RCM) 

Transport work (tonne 

kms) per mode, 

vehicle type and 

commodity, and 

regional diff DTI  

Samgods Model 



Cube Interface components 

42 
 

Folder Name Description Used by application 

 Report_11_ 

Transported goods 

volume per mode 

vehicle cl, total and 

split per commodity, 

domestic, tdomestic 

and international 

(RCM) 

Transported goods (in 

tonnes) per mode and 

vehicle type, 

commodity, and 

regional diff DTI  

Samgods Model 

 Report_12_node and 

link costs per vehicle 

and product group 

(RCM) 

Node and link costs 

per vehicle type and 

product group, divided 

into regional diff DTI  

Samgods Model 

 Report_13_Tons_per

_PortArea_and_STA

N_Group (RCM) 

Tons per port area 

and STAN group and 

comparison with 

statistics  

Samgods Model 

 Report_14_Oresund 

Bridge_Kiel 

Canal_Jylland (RCM) 

Results on Öresund 

bridge, Kiel canal and 

Jylland and 

comparison with 

statistics  

Samgods Model 

 Report_15_Trains per 

day 

(tot,empty,loaded) 

(RCM) 

Number of loaded and 

empty trains per day 

bidirectional and 

differences between 

totals and capacities  

Samgods Model 

 Report_16_VHCLKM 

and distribution by 

county - totals (RCM) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on all the 

roads  

Samgods Model 

 Report_17_VHCLKM 

and distribution by 

county - E10 roads 

(RCM) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on E10 

(category 11)  

Samgods Model 

 Report_18_VHCLKM 

and distribution by 

country - Other roads 

(RCM) 

Vehicle kms per 

county and vehicle 

type and their 

distribution on all the 

roads except E10  

Samgods Model 

Table 2 List of inputs and outputs accessible from the Data Section window. 

 

2.4. Keys window 

The model is based on Scenario Manager and Application Manager. Applications represent the 

flow chart of the model containing calculation and specific programs, while the purpose of 
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Scenario Manager is to allow an application to be conveniently executed with a varying set of 

inputs. This allows the user to compare the effects that different input values have on the results. 

A set of input values is a scenario and the varying inputs to the applications are called “keys”. 

Catalog keys define items that vary each time an application in a catalog is run. They may 

represent a file, number, character string, or Boolean flag. For instance, using a key it is possible 

to specify different values for parameters, different networks for LOS calculation and assignment, 

different control parameters for the Logistics Module or more. 

In general terms the keys may serve different purposes; in summary: 

 To manage input data 

 To give general settings for the model 

 To enable different ways to run the model 

A key can for example be: 

 The name of an input data file 

 A directory 

 A check box with true or false value 

 A check list to choose a specific value 

 A constant 

 A radio button 

Different kinds of keys appear in applications and other places where it is possible to select the 

settings.  

In Chapter 3, the available catalog keys for each specific application are listed. Catalog keys are 

defined as keys for setting up parameters in the applications. The Keys window is available in 

developer mode and it is also possible to display from Main toolbar -> Scenario -> View -> Show 

Keys.  

The following keys in the Cube interface are called system keys:  

 {CATALOG_DIR} is the directory where the .cat file is located 

 {SCENARIO_DIR} is the directory where the scenario folder is located 

 {SCENARIO_CODE}, {SCENARIO_SHORTNAME) are defined in the Scenario 

Properties, see Figure 10 below 

 {SCENARIO_FULLNAME} = 

{SCENARIO_SHORTNAME_PARENT}.{SCENARIO_SHORTNAME}, where 

{SCENARIO_SHORTNAME_PARENT} is the base scenario to the current scenario 

These keys are important components in each scenario. Please refer to the online Cube Voyager 

help available from the menu bar for further information (see for instance Scenario Manager > 

Working with applications and catalogs > Cube Voyager and TP+ scripts). “Scenario properties” 

is accessed by right-clicking on the topical scenario in the Scenarios window and select 

“Properties” (see Figure 9). 

Each time a scenario is created all catalog keys should be given a value. Some of the keys have 

a default value. If the default value is changed by the user, it will become specific for that 

scenario. When a scenario is created as the child to another scenario, it will inherit all the catalog 

key settings from the parent.  

In the Keys window information on the origin of the keys can be found. The keys for a specific 

scenario and application can be viewed by selecting the scenario in the Scenarios window by 

clicking on it, and selecting the application in the Applications window in the same way. The keys 

marked in black in the Keys window are undefined. The keys are shown in bold font if they have 

mk:@MSITStore:C:/Program%20Files%20(x86)/Citilabs/Cube/CubeBase.chm::/ScenarioManager.16.1.html#1087887
mk:@MSITStore:C:/Program%20Files%20(x86)/Citilabs/Cube/CubeBase.chm::/ScenarioManager.16.31.html#1087887
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been explicitly defined by the user and in italics if they have been inherited from the parent 

scenario. If the value is in grey font, it is a default value that has not been changed by the user, 

neither for the current scenario, nor for its parent. 

More information about the keys and the scenarios can be found in the Cube Help, accessed 

from the main toolbar (Help -> Cube Help -> Cube Base -> Scenario Manager -> 

Keys/Scenarios). 

 

 

Figure 9 How to open the “Scenario Properties” window. 

 

 

Figure 10 Set {SCENARIO_SHORTNAME} and {SCENARIO_CODE} in “Scenario Properties”. 

 

 

2.5. Application manager window 

{SCENARIO_SHORTNAME} 

{SCENARIO_CODE} 
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The Application manager window is accessed by double-clicking on an application in the 

Applications window, and it provides a flow chart of a transportation modelling process, see 

Figure 11. The view is in a hierarchical flow style that offers: 

 a view of the individual processes, the flow of data from one application to another, the 

sequence in which the processes are run 

 a clear structure of what the input data and the output data are in each process 

 a convenient interface for running specific parts of the process or the whole model 

 

 

Figure 11 Application manager window. 

 

2.6. Task Monitor program and the help function 

The Task Monitor program is started automatically from the Application manager when the user 

runs either a single program or an application. The main purpose of the Task Monitor is to report 

the progress of the program/application execution, and to allow control of the run by pausing or 

abandoning it. When a run finishes successfully, a message box will indicate that the run is 

finished without any problem. If a failure occurred, a dialog box, showing the return code and 

error information, will appear.  

The return code from the process gives the information on how the run completed. The codes 

are shown below. 

 

 

 

 

 

 

 

 

 

Return codes: 

Return code = 0 – the run completed successfully 

Return code = 1 – along the process, a few warning messages were printed but the run was 

completed successfully 

Return code = 2 – the run ended with a fatal error 

Return code = 3 – the process was aborted by the user 

STEP 1 

STEP 2 

STEP 3 

Execution order 



Cube Interface components 

46 
 

There are facilities that allow showing: 

 The report for the whole run 

 The report for the step that failed, if the run ended with a fatal error 

For more details on the Task Monitor, see reference guide RG_CubeBase.pdf under 

Citilabs\Cube folder, Chapter 16. 

When the user needs help about the Cube Interface, the help function can be consulted. It is 

found on the Menu Bar; Help -> Cube Help. 
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3. Description of the applications 

This chapter introduces the different applications in the Samgods GUI, how they are used and 

how the settings are made. The chapter is written as a catalog with detailed descriptions of the 

applications and should be consulted for the specifications of the applications rather than for 

instructions on how to use the entire Samgods model. For instructions on how to get started with 

Samgods, how to create and use scenarios etc., we refer to Chapter 4. The chapter commences 

with an explanation of the different Model User roles, followed by the description of the 

applications in the Samgods model GUI. 

3.1.  Model User roles 

In the Samgods model GUI, three Model User roles are available: 

 Standard user - should be used by the normal user when setting up scenarios and 

running the model 

 Advanced user - should use when it is requested to manage some general parameters 

and values such as wait time for the prompt command or for running RCM process. 

 Developer -  should in general be used when advanced system settings are made, for 

instance when administrating the system by making installations and setting up the 

system 

As mentioned earlier, in order to set the Model User roles, to go Scenario menu on the toolbar 

and select “Properties”. On the Catalog Properties window, select the “Model User” tab, where 

the settings for the Model User roles are made, as described below: 

 Standard User – set the Model User to “Model Applier” and Current Applier group to 

“Standard User” 

 Advanced User – set the Model User to “Model Applier” and Current Applier group to 

“Advanced User” 

 Model Developer – set the Model User to “Model Applier” and Current Applier group to 

“Model Developer” 

More details for when the Model User roles are used are given in the catalog key tables. Most of 

the catalog keys for the respective applications are described; however, not all keys are explicitly 

explained.  

 

 

 

 

 

 

 

3.2. Installation application 

The Installation application is only enabled in developer mode. A screenshot of the application is 

displayed in Figure 12. The purpose of the Installation application is to set the general 

information to properly run different programs involved in the model. In particular we have the 

following programs: 

 Logistics module (executable programs buildchain.exe and chainchoi.exe) 

General guidelines for which Model User role to use:  

Standard user – should be used by the normal user when running different scenarios 

Advanced user – should be used by an experienced user of the model that would control some 

specific settings and parameters 

Model developer – should be used when setting system keys, no restrictions are applied in this 

case 
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 Rail Capacity Management module (executable programs buildchain4RCM.exe, 

chainchoi4RCM.exe, LP2CC.exe, MPS.jar, LP_solve.exe) 

 Citilabs Cube Software 

 ArcGIS Esri Software 

 Python software 

See the installation instructions in Section 1.5 for further details on how to access the keys and 

set the right values. 

The first group of catalog keys, called “Software versions”, is introduced to avoid inconsistency of 

version problems over time. Different versions of the programs can be implemented (typically 

when a software is updated to a newer version), and it is important to know which software 

versions that were used for a particular scenario study to enable proper analysis and consistency 

of the outcome. The keys are displayed in Table 3. 

 

Catalog key name Example of value 

Cube Software 6.1.0 Sp1 

EMME Software 2.9.6 

ArcGIS Software 10.1 Sp1 

Python software 27 

Samgods Model software (20140627) 

Table 3 “Software versions”. 

The second group of catalog keys, “Installation parameters”, handles the possible problem of 

having different installation folders on different PC’s by setting the path of the programs. Since 

the path for the ArcGIS program is used by Python, the “\” signs must be replaced by “/” or “\\” in 

this key, see Table 4 for an example.  

 

Catalog key name Example of value 

Location of Cube Program C:\Program Files\ 

Location of EMME Program C:\Program Files\ 

Location of ArcGIS Program C:/Program Files/ 

Location of Python Program C:\Python27\ArcGIS10.1  

Location of Java Program C:\Windows\System32 

Table 4 “Installation parameters”. 

The last key in the second group, see Table 5 below, defines the base scenario that is used in 

the current model. The base scenario is used as a reference when storing the data for other 

scenarios. Only the differences between the base scenario and other scenarios are stored in the 

database. The value of this key is related to the Handling scenario application; please refer to 

Section 3.7 for more information.  

 

Catalog key name Example of value 
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Scenario name for the BASE scenario Base2006 

Table 5 Base scenario definition. 

 

 

Figure 12 The Installation application. 

 

To open the overview of the application as illustrated in Figure 12 double-click on the application. 

To access the catalog keys of a specific scenario, mark the application, and double-click on the 

specific scenario in the Scenario window. Please refer to Chapter 3 for further instructions on 

how to use the Samgods GUI.   

3.3.  Create the editable files application 

A view of the Create the editable files application can be seen in Figure 14. The purposes of this 

application are to: 

 Create the essential files for visualizing or editing the input data from the graphical user 

interfaces (Cube GIS window, DBI editor) 

 For a new scenario, allow to copy all the parent scenario data to the new scenario 

The concept of this is that all the input data connected to a specific scenario is stored in the 

database as the differences between the current scenario and the base scenario (i.e., the 

reference scenario). The benefits of this are: 

 A smaller amount of data is stored, that is, only the differences between the base 

scenario and the alternative scenario(s) 

 It makes different alternative scenarios independent of each other, by letting the 

alternative scenarios having only the base scenario as a reference. The only redundancy 

of the system occurs when children are added to an alternative scenario since all 

scenarios (including child and parent scenarios) are independent of each other and only 

have the base scenario as a reference 

 When changes are made to the base scenario, there is no need to change all the other 

scenarios. This facilitates the handling of the overall scenarios. Furthermore the changes 
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and edits will be done only once, in the base scenario, avoiding risk of mistake when 

updating the correlated scenarios 

 

To create the editable files for a specific scenario and the scenario specific tables, two 

applications work in conjunction:  

 the Create the editable files application, that merges the base scenario with the scenario 

specific tables to view and edit a scenario, and   

 the Edit the data application, that stores the scenario-specific tables into the database 

after any edits have been made. 

 

 

Figure 13 Database structure and scenario data of the Samgods GUI. 

 

The main database is always present in the model, in the 05_Input_data folder (see Table 1 in 

Section 1.5). The temporary database (Scenario_data.mdb) is created in the scenario folder in 

each run of this application and is deleted on request by the user. The temporary database can 

also be viewed in the GUI. 

The catalog keys available in the Create the editable files application are shown in Table 6 

below. 

 

 Catalog key name Example of value Model User’s 

rights 

1 Which scenario do you want to copy as new 

scenario? (Default is Base2006) 

Base2006 S/A user 

2 Location of Python program C:\Python27\ArcGIS10.1 Developer 

3 Scenario name for the BASE scenario Base2006 Developer 

4 Wait time for prompt messages during 600 Developer 
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execution (default 10 minutes = 600 seconds) Advanced user 

Table 6 Create the editable files catalog keys. 

The first key is relevant during the creation of a new scenario. When the scenario already exists, 

no action is needed. Keys number 2 and 3 are for installation purposes only. The last key 

represents a model run setting, specifying the wait time for prompt message during execution. 

For a normal user its value is set to 10 minutes, only for an expert user (advanced user right) it is 

possible to change the definition to a small value (for instance 10 secs). A different settings is 

required when several scenarios must be run and it would be minimize the interaction with the 

user. 

To create a new scenario, the application copies the scenario-specific tables from the scenario 

(as indicated in the first catalog key in Table 6) and stores them in the temporary database. The 

Edit the data application will then store them back to the main database. 

 

 

Figure 14 The Create the editable files application. 

When the application has been executed, the output (i.e., the editable files) can be found in the 

folder Scenario Inputs\Editable data in the Data Section window. If the Create the editable files 

application has been executed before and the user after that has not selected to delete the 

temporary geodatabase, all the data will be available without the need to run the application 

again. If the temporary database has been deleted, it may always be reconstructed by running 

the Create the editable files application. 

 

Please note: This application has to be run at least once for each scenario, including the base 

scenario. Otherwise, the necessary files for using the scenario will not be created. 

The Create the editable files application is the only application that is necessary to run for each 

scenario - including the base scenario. For all other scenarios except the base scenario it is also 

necessary to run the Edit the data application. 

 

 

 

Tip: The date and time of the last modification of the temporary and the main geodatabase are 

checked by the application to avoid inconsistencies between the two datasets. If any 

differences are found, the user is asked to choose whether the execution should be completed 

(the temporary geodatabase will then be overwritten) or cancelled, so that the temporary 

geodatabase could be saved to the main geodatabase by the user. 
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3.4.  Edit the data application 

The Edit the data application is used to store the scenario-specific tables into the database after 

any edits have been made. 

A view of the application is shown in Figure 15. The purposes of the application are to: 

 Enable editing of the scenario data by using the Scenario manager window or the Data 

Section window. All georeferenced data is visualized using the GIS Cube window and 

the other data is displayed in a database window. See the reference guide for Cube 

Base (RG_CubeBase.pdf under Citilabs\Cube folder) for further information on these 

tools; 

 Store the modified data (the scenario-specific tables) to the main database after editing.   

The catalog keys are ordered in two steps. The first ones are shown in Table 7 below.  

 

 Catalog key 

name 

Example of value and 

explanation of values 

Description Model 

User’s 

rights 

1 Do you want to 

lock the scenario 

from further 

editing? 

Yes This key is 

introduced due to 

data security 

reasons, where the 

user can choose to 

lock the scenario 

from further editing. 

Further explanation 

is given below 

S/A user 

2 Select from which 

interface you want 

to import your 

edits 

GIS Window (Use input files 

constructed by the Cube 

GUI) 

This key indicates if 

the edits are saved in 

a Voyager Network 

or in an EMME 

Network. 

If option “GIS 

window” is selected, 

the next two catalog 

keys (no. 3 and 4 

below) do not need 

to be specified 

S/A user 

Please note: 

 The location of the main database is in the 05_Input_data folder (see Table 1 in 

Section 1.5).  

 The location of the temporary database, Scenario_data.mdb, is in the scenario folder, 

which can be found in the Scenario_Tree folder (see Table 1 in Section 1.5). It is 

available after each run. It can also be viewed from the GUI. 
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3 Use emme 

network file: 

C:\Temp\EMME_NET_Emm

e2006.211 

The network data 

can be edited by 

importing Emme data 

(format: .211). The 

file should be 

specified here. It is 

necessary that the 

network file exists in 

the specified folder, 

otherwise the system 

will prompt the user 

with a message 

during the execution 

S/A user 

4 Use emme speed 

table: 

C:\EMME\NetworkBase2011\

V101_1_02_SPEEDS.DAT 

See key no. 3, 

except for the format, 

that is .DAT for 

speed table file 

S/A user 

5 General 

parameters [Table] 

C:\Samgods\Scenario_Tree\

Base2006\Scenario_Data.md

b\General_Base2006 

This is the scenario 

data for the scenario, 

generated by the 

system 

Developer 

6 Attribute name for 

extra cost on 

specific link [SEK] 

EC_V Please refer to 

Section 5.2 for 

further explanation 

S/A user 

7 Attribute name for 

extra cost on 

specific link 

[SEK/km] 

EC_KM_V Please refer to 

Section 5.2 for 

further explanation 

S/A user 

8 Daily factor for all 

modes (except for 

Rail Mode) [days 

per year] 

365 This key represents 

a value used to 

convert the annual 

flows into hourly 

flows and is 

expected to be 

changed rarely 

Developer 

9 Daily factor for Rail 

Mode [days per 

year] 

250 This key represents 

a value used to 

convert the annual 

flows into hourly 

flows and is 

expected to be 

changed rarely 

Developer 

10 Peak Hour Factor 0.12 This key represents 

a value used to 

convert the annual 

flows into hourly 

flows and is 

expected to be 

changed rarely 

Developer 

11 Number of zones 

in network (see 

1120 Maximum number of S/A user 
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value in scenario 

network): 

zones in the network  

12 General 

parameters for 

Logistic Module 

[Table] (new) 

C:\SamGods\Scenario_Tree\

Base2006\Scenario_Data.md

b\LogMod_Base2006 

This is the Logistic 

Module  data for the 

scenario, generated 

by the system 

Developer 

13 Interest rate used 

in cost calculation 

[%/year] (new) 

0.1 Interest rate used in 

cost calculations 

[%/year] 

S/A user 

14 Stuffing cost [SEK 

per tonne] (new) 

18 Stuffing cost [SEK 

per tonne] 

S/A user 

15 Number of 

transport chain 

solutions for the 

Logistics module 

1: the optimal solution 

2: the second best solution 

… 

5: the fifth best solution 

See Table 5.2 in 

document under 

Section 10.3. The 

output is found in the 

Data Section 

window, in Scenario 

Inputs/Editable data/ 

General parameters 

table, in the field 

DATA. In the current 

implementation only 

the optimal solution 

is implemented. 

For the current RCM 

implementation it is 

strongly 

recommended to 

leave the number of 

alternatives set to 5. 

S/A user 

16 Output variables 

for the optimal 

transport solution 

[e.g.1,2,3, max is 

8] 

1: direct access 

2: (un)loading costs 

3: wait time costs 

4: main utilization rate 

5: number of vehicles 

6: detailed information (total 

cost, total distance, total 

times, commodity, etc.) per 

f2f-solution 

7: detailed information 

(transport cost share, total 

distance, total times, mode, 

etc.) per OD-leg. This table is 

linked to table 6 

8: Statistics of the avail 

function 

See Table 5.2 in 

document under 

Section 10.3. The 

output files are found 

in the scenario folder 

(see Table 1), in 

LogMod\ChainChoi\ 

OUTPUT and could 

be consulted by the 

advanced user. To 

reduce the amount of 

output files and 

produce meaning full 

reports it has been 

suggested to use 

reports 6 and 7. 

S/A user 
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Max is 8 

17 Initial consolidation 

factor in 

BuildChain (1 

iteration) 

0.75 
This key concerns 

which consolidation 

factor (for all modes) 

that should be used 

in BuildChain. See 

Section 10.3 for 

reference. 

S/A user 

18 ALL_LORRY_TYP

E_CONSOL (new) 

Yes  
This key will enable 

the consolidation of 

all lorries if the value 

is Yes. With No 

unconsolidated lorry 

transports will be 

enabled  

S/A user 

19 INDIVIDUAL_OD_

LEG_OPTIMIZE 

(new) 

Yes  
If Yes then each 

chain is evaluated 

one leg at a time, 

and the lowest cost 

vehicle is chosen. 

This can be done 

since the OD-legs 

are independent. The 

exception is OD-legs 

for vehicles rolling on 

and off a RoRo 

vessel, where an 

recursive 

optimization method 

is used for the three 

OD-legs (roll on 

vehicle – RoRo – 

rolloff vehicle). 

S/A user 

20 MINIMUM_ANNU

AL_TONNE_DEM

AND_4_FREQ_O

PTIMIZE [tonnes] 

(new) 

10 
If (Annual Demand / 

Nr Relations) <  

MINIMUM_ANNUAL

_TONNE_DEMAND_

4_FREQ_OPTIMIZE 

ChainChoi will exit 

20 step frequency 

optimization loop 

after the first 

iteration, where 

frequency 

corresponds to EOQ. 

S/A user 

21 Lower bound for 

consolidation 

factor [Tonnes] 

0.05 
Lower bound for the 

consolidation factors 

ranking output 

S/A user 
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(new) (applied to 

all commodities) 

22 Upper bound for 

consolidation 

factor [Tonnes]  

(new) (applied to 

all commodities) 

0.95 
Upper bound for the 

consolidation factors 

ranking output 

S/A user 

23 TONNES (new) DYNAMIC_MAX 
Parameter to control 

how the demand 

shall be used in the 

calculation of the 

shipment sizes in 

BuildChain. The 

following values are 

allowed: 

DYNAMIC, 

DYNAMIC_MAX 

DYNAMIC_AVERAG

E, 

DYNAMIC_GEOME

AN 

S/A user 

24 Do you want to log 

parameters from 

control files? (new) 

Yes  
If true the 

parameters from 

control file are 

logged in a log file 

(under LOG folder). 

S/A user 

25 Do you want to log 

reading of input 

data? (new) 

Yes  
If true the input data 

phase is logged in a 

log file (under LOG 

folder). 

S/A user 

26 Do you want to log 

cost values from 

vehicles files? 

(new) 

Yes  
If true the cost values 

read from LOS files 

are logged in a log 

file (under LOG 

folder). 

S/A user 

27 Do you want to 

delete the 

temporary 

geodatabase? 

(Tick=yes) 

Tick =yes 
This key gives the 

user the possibility to 

save hard disk space 

by deleting the 

temporary 

geodatabase 

(Scenario_Data.mdb)

. However, by 

keeping the 

temporary files, there 

is no need to run the 

Create the editable 

S/A user 
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files application 

again (for the current 

scenario) 

Table 7 Scenario parameters and handling keys. 

The first key (lock the scenario or not) is introduced due to data security reasons. The user can 

choose to lock the scenario from further editing. A new scenario is always editable, because it is 

expected that the user will make some changes to the scenario tables. To lock a scenario means 

that after the run, all the scenario data can be visualized in the interface, but if any edits are 

made, these edits will not be saved in the main geodatabase. The base scenario is locked by 

default and it should always be locked to enable comparison of the scenarios. In the database, 

only the relative differences between the base scenario and the scenarios alternatives are 

stored, this is why it is important not to change the base scenario when new scenario alternatives 

have been introduced. A prompt window gives information on whether the scenario has been 

locked or not during the execution of the following applications: Create the editable files, Edit the 

data, Samgods Model. 

The 11th key (Number of zones in network (see value in scenario network)) must be updated 

accordingly the number of zones in the EMME or Voyager network. The Emme network, in 

conjunction with the speed table, could be provided as input network and converted by the 

application. In this case the number of zones has specified as the record number in the emme 

node table for nodes starting with *. In Voyager the number could be identified and modified in 

the GIS window selecting the network in TOC and right clinking on that. For more details on the 

EMME network please refer to Chapter 5.1. 

The last key (no. 27) gives the user the possibility to reduce the run time during the creation of 

the temporary files. By deleting the temporary geodatabase, hard disk space could be saved. On 

the other hand, by keeping the files, run time can be saved since the Create the editable files 

application does not have to be run again for the specific scenario. The Create the editable files 

application needs about 5-10 minutes to merge all scenario specific tables with the base 

scenario. 

To avoid inconsistencies between the temporary and the main geodatabase, it is recommended 

to always control whether the two data sets have the same date and time of last modification, 

before running the Samgods Model. If they differ, there could be edits in the temporary 

geodatabase that have not been saved to the main geodatabase, so that edits will not be 

included in the execution of the model. In order to save edits in the main geodatabase, it is 

necessary to run the Edit the data application. For the Create the editable files application, this 

check is done by the application, in order not to overwrite any not saved edits in the temporary 

geodatabase by mistake (see Section 3.3).  

When “Next” is clicked in the Edit the data application in the Standard user Advanced user mode, 

a second set of catalog keys is displayed, see Table 8. These keys give access from the 

interface to all the input data for the specific scenario. The model Standard user / Advanced user 

does not need to do anything to define the key values. The tables and geodata can be edited by 

clicking on the “Edit…” button in Standard user Advanced user mode. All these files are also 

accessible from the Data Section window, under Scenario Inputs\Editable data. In Section 2.3 a 

brief explanation of all files in the Data Section window is given. 

 

Catalog key 

name 

Example of value Model 

User’s 

rights 

Name of file in 

Data Section 

window 
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ArcMap GIS 

Project File 

C:\Samgods\Scenario_Tree\Base2006\Input_

Data.mxd 

S/A user  Input_Data.mxd 

Commodity 

data [Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Cargo_Base2006 

S/A user Cargo Table 

General 

parameters of 

Vehicle 

Classes 

[Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Vehicles_Parameters_Base2

006 

S/A user Vehicles 

Parameters 

Specific 

parameters of  

Vehicle 

Classes in 

some 

commodities 

[Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Vehicles_exception_Base200

6 

A user Vehicle 

Parameters 

Exceptions 

Table with tax 

by country 

(SEK/km) 

[Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Tax_Country_Base2006 

S/A user  Tax by country 

Table 

Tax by 

Category 

(SEK) [Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Tax_Category_Base2006 

S/A user Tax by Link class 

Tax by Link 

(SEK) [Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Tax_Link_Base2006 

S/A user  Tax by link 

Toll for 

bridges (SEK) 

[Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Toll_Link_Base2006 

S/A user Toll bridges 

Network 

specific of 

scenario 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Network 

S/A user Scenario Network 

Port terminals 

(pilot fees 

values) 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Ports_Swe 

S/A user  Ports Sweden 

Zones and 

terminals 

attributes 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Nodes 

S/A user  Nodes 

Nodes 

commodities 

(interchanges 

allow) 

[Geodata] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb\Nodes_commodities 

S/A user Nodes 

commodities 

Frequency 

data 

C:\Samgods\Scenario_Tree\Base2006\Scen S/A user Frequency 
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[Geodata] ario_Data.mdb\Frequency_network network 

Table with 

Rail Capacity 

[Table] 

C:\Samgods\Scenario_Tree\Base2006\Scen

ario_Data.mdb \Rail_Capacity_Base2006 

S/A user  RailCapacity 

Table 

Table 8 Editable data. 

The last three catalog keys are only accessible in model developer mode with the exception for 

Wait time (that could be also specified by the Advanced user). They define the base scenario, 

the folder for the Python program and the wait time for prompt message during execution, see 

Table 9. 

 

Catalog key name Example of value Model User’s 

rights 

Location of Python Program C:\Python27\ArcGIS10.1 Developer 

Scenario name for the BASE scenario Base2006 Developer 

Wait time for prompt messages during execution 

(default 10 minutes = 600 secs): 

600 Developer 

Advanced user 

Table 9 Developer and advanced user keys. 

 

 

Figure 15 The Edit the data application. 

The output of the Edit the data application, a log report containing information on the execution of 

the application, can be found in the folder Scenario Outputs\Edit the data Report in the Data 

Section window. This file contains a list of numbered messages giving information on, e.g., 

whether any data is missing in the input data (e.g. a missing port in the ports_swe table). For a 

list of messages, see Chapter 0.  
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3.5.  Samgods Model application 

A schematic picture of the Samgods Model application is outlined in Figure 16. The Samgods 

Model application is the core of the system, since it has the purpose to: 

 run the Samgods model 

 make sure that all required input data exists (in the main geodatabase or created along 

the process) 

 save all the outputs in the right places (depending on the request of the user) 

The Samgods Model application provides three different processes integrated in a unique 

application: 

 The logistics module (in the document it could be referred to as Standard Logistics 

Module or STD - steps 4,5,6,and 7): the transport solutions are produced considering all 

the available chains and the results are summarized in vehicle, tonne and empty vehicle 

matrices assigned to the transport network. The solution considered for each firm-to-firm 

relationship is one and only one 

 The Rail Capacity Management module (steps 8,9 and 10): in an iterative process the 

transport chains solutions using rail infrastructure are modified with the goal to 

redistribute the flows and reduce the congestion on the rail network. In each iteration a 

new alternative per each firm-to-firm using rail links may be added, may since possibly 

existing alternatives are not added again, to the capacity problem manager (called LP 

since it involves the definition of a linear programming problem). The variables in the LP 

model are the usage split of the available solutions per f2f-relation.. The initial step is 

denoted LP0 and considers the best solution from logistic module and the second best 

choice. New alternatives are successively added in step LP1, LP2 etc. until the total LP 

model cost  is minimized, i. e. when the solution has converged according to defined 

stopping criteria. One alternative stopping criteria could be a maximum number of 

iterations. Should any rail link be overloaded after stopping, a heuristic procedure 

involving the use of a congested assignment of empty train flows and capacity 

adjustments of the constraints in the LP-model may be used. The heuristic is denoted 

Adjust Capacity procedure and is referred to as LP1b in some catalog keys. Note! Each 

step in this procedure is just as CPU time requiring as solving the last full LP-model.. 

 The calibration module (steps 1,2,11 and 12): details will be provide in the document 

listed in Section 10.7. It has been used to calibrate the current version. The standard and 

advanced user are not allowed to access to the catalog keys that control this process 

The steps related to the Logistics Module are: 

 LOS calculation (step 4)– the step where the Level Of Service matrices are calculated. 

There is one LOS matrix for each vehicle type providing transport time, transport 

distance, infrastructure fees/charges and the domestic distance for zone-to-zone 

relations. The LOS matrices are mandatory input to the Samgods model (We refer to the 

Method Report and/or the VTI report for further explanation, see Section 10 References) 

 Logistics module (step 5) – the step where the freight flows of the different commodities 

are assigned to transport chains 

 Assignment (step 6) – the step where the freight flows are assigned to the infrastructure 

network 

 Reports (step 7) – the step where all standard reports (also called summary reports) 

from the Samgods Model application are produced 
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The steps related to the RCM module are: 

 Rail Capacity Management (step 8): using the results from standard logistics module 

sets up the LP and provides a new revised set of vehicle and tonne OD matrices  

 Assignment RCM (step 9) – the step where the freight flows are assigned to the 

infrastructure network. The empty rail assignment considers the congestion on rail links 

by applying a vehicle-delay function that depends on bidirectional link flows, the other 

modes maintain the standard all-of-nothing assignment 

 Reports RCM (step 10) – the step where all standard reports (also called summary 

reports) from the Samgods Model application are produced with results for RCM 

 

We refer to the reference material listed in Section 10, for further information of the Samgods 

model. 

 

 

Figure 16 The Samgods Model application. 
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3.5.1. Standard Logistic Module 

The first four steps of the application represent the “standard” module where the capacity and 

congestion on rail links are not considered. This “standard logistic” module has different choice 

dimensions, depending on the results that the user wants to simulate (as showed in the Figure 

17). 

 

 

Figure 17 Different ways to run the Samgods Model application for the standard part.  

All the possible dimension are: 

 The model could be run as an uninterrupted process or step-by-step (illustrated in the 

figure by the blue arrows to the right) 

 It is possible to run all the commodities at once or one commodity at the time (illustrated 

by the yellow arrow at the top of the figure) 

 For the steps LOS Calculation and Assignment is it possible to run all the modes or only 

a specific mode (illustrated by the green boxes to the left in the figure) 

 It is possible to select which specific outputs to save from running the Samgods model 

Not all combinations of these choices are allowed. Details are given in the following paragraph.  

During the run, the user will be informed with a prompt window whether the selections made are 

coherent with each other. 

The option to run the model for one mode at a time is allowed only for the steps highlighted in 

green, i.e. LOS Calculation and Assignment. This is due to the fact that the Logistics module 

needs LOS matrices for all modes. A reason for running only a specific mode could be that the 

differences in the input data are related only to one mode. For instance, if no other changes have 
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been made in the input data, there is no need to rerun the whole scenario in the LOS Calculation 

step. Regarding the Assignment step, the user may be interested in examining the assignment of 

the freight to the network for only one mode.  

The fourth step, Reports, produces summary reports from running the Samgods model. Since 

this step summarizes the three previous steps, a full run of all four modes needs to be done to 

obtain complete reports.  

It is allowed to run all steps related the standard logistic module in the Samgods model 

application for only one specific commodity group (as illustrated by the blue arrows). With the 

new setting of empty add-on factors for empty rail flows, these will be correct at any level of 

disaggregation. For other vehicle types the empty flow distributions are not separable, i. e. the 

sum of individual commodity based empty flow generations will not sum to the empty flow 

generation from the combined set of commodities.  

If changes in the input data are detected after the LOS matrices have been created, the program 

will prompt the user with a message in the report file in the folder Scenario Outputs\Samgods 

report\Existing Outputs in the Data section window. During the execution, the user is provided 

with the option to cancel the run (by ticking the answer “Do you want to check data and skip the 

process?”). See Chapter 0 for further information on the log reports. 

The last step of the application represent the “Rail Capacity Management” module where 

capacity and congestion on rail links are taken into account. This module has several sub-steps: 

 Rail Capacity Management – the step where the freight flows of the different 

commodities are assigned to transport chains considering link congestion on rail 

 RCM Assignment – the step where the freight flows are assigned to the infrastructure 

network considering link congestion on rail 

 Results RCM – the step where all reports for the Rail Capacity Management module are 

produced 

For the “rail capacity management” it is not possible to select which commodity and mode to run, 

but it is mandatory run all the commodities and all the modes. In fact the rail capacity 

management module considers the congestion on the rail links, and to do this properly you have 

to consider all the commodities and modes simultaneously. Moreover, you cannot select which 

step to run but you need to run all the RCM steps (Rail Capacity Management, RCM Assignment 

and Results RCM).  

For the Samgods Model application there are several groups of catalog keys. 

The first group is “Parameters for Logistics Module” and it contains only one key that specifies 

the number of zones in the network. 

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Number of zones in the 

network (see value in 

scenario network) 

1120 Number of zones in 

the network 

S/A user 

Table 10 “Parameters for Logistic Module” key. 

The next group of catalog keys is only available in developer mode and it contains installation 

parameters. 
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 Catalog key name Example of value Description Model 

User’s 

rights 

1 Location of python 

program 

C:\Python27\ArcGIS10.1 It specifies the 

installation directory for 

Python program 

Developer 

2 Java folder C:\Windows\System32 It specifies the 

installation directory for 

Java 

Developer 

3 Scenario name for 

the BASE scenario 

Base2006 It specifies the name of 

the base scenario 

Developer 

Table 11 “Installation Parameters” keys. 

The next group of catalog keys, “Run Selections”, refers to the execution order specifying which 

steps to run (see Table 12). 

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Run only one 

application, or run all 

steps 

All It specifies which step 

that is to be run for 

Standard Logistic 

Module; it is possible 

to specify only one 

application or all the 

steps 

S/A user 

2 Year of PWC 

matrices 

2006 It specifies the year for 

the PWC demand 

matrices 

S/A user 

3 Select the mode for 

the LOS Calculation 

and the Assignment 

steps 

Road It specifies which mode 

that is to be run; it is 

possible to specify only 

one or all the modes 

NOTE: if you run RCM, 

you need to consider 

all the modes 

S/A user 

4 Select commodities 

for the Logistics 

Module (for all 

commodities, select 

0) 

0 It specifies which type 

of commodity that is to 

be run; it is possible to 

specify only one NSTR 

commodity type (value 

from 1 to 35), or only 

one STAN commodity 

type (value from 

STAN1 to STAN12) or 

all the commodities 

(value 0) 

NOTE: if you run RCM, 

you need to consider 

S/A user 
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all the commodities 

Table 12 “Run Selections” keys. 

Possible input values for the first key listed in Table 12 are: 

 LOS calculation: it indicates to run only “LOS calculation” step 

 Logistics module: it indicates to run only “Logistics Module” step 

 Assignment: it indicates to run only “Assignment” step 

 Reports: it indicates to run only “Results” step 

 Standard LogMod: it indicates to run all the “Standard LogMod” steps (LOS calculation + 

Logistic module + Assignment + Reports) 

 Rail Capacity Management: it indicates to run all the “Rail Capacity Management” steps 

(Rail Capacity Management + RCM Assignment + Results RCM) 

 All: it indicates to run all the steps 

Note that, when running Standard Logistic Module, the input for Rail Capacity Management 

procedure is created in the scenario folder. Therefore the Rail Capacity Management procedure 

could be run after a full run of Standard Logistic Module.  

Output is produced from all steps in the Samgods model application. Together with the Microsoft 

Office tools (such as Access and Excel) this output can be analyzed in-depth in various ways. 

The purpose of the standard reports produced in the Report step is to give the user a quick 

overview of the results from running the Samgods model application.   

Possible input values for the second key (Year of PWC matrices) in Table 12 are: 

 2006: PWC matrices for year 2006 

 2030: PWC matrices for year 2030 

 2030BnM: PWC matrices for year 2030 with 2006 demand for commodity 15  

Possible input values for the third key listed in Table 12 are: 

 All 

 Road 

 Rail 

 Sea 

 Air 

The last key has a more general function. It is used in all the applications where the output data 

is filtered by commodity. It is the most important catalog key of these three keys. If the Samgods 

model first is run for commodity type 1 (for instance), then for all the commodity types (key set to 

zero), then both the results for commodity type 1 and for all the commodities will be saved. In the 

scenario folder (under Scenario_Tree, see Table 1), the name of the specific output database is 

OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group. Switching from 

one set of output to another in the interface is easily made by changing the value of this catalog 

key and clicking “Save”. The possible values for this key are the numbers representing different 

commodities or zero, representing all commodities. The possible commodities are the NSTR 

commodity types (1-35) and the STAN commodity types (STAN 1-12). See the Appendix or for 

instance the Program Documentation (see References) for more information.  

The report “Existing Outputs” (in the folder Scenario Outputs\Samgods Report in the Data 

Section window) is updated during each run and it gives information on the output and the 

commodity class. 
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The next set of catalog keys, “Other options”, refers to the optional outputs which can be saved 

in the scenario folder, see Table 13 below. 

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Do you want to save 

the LOS matrices? 

Tick It indicates if you want 

to save the LOS 

matrices 

S/A user  

2 Do you want to 

produce 

buildchainxx.log files? 

Yes It indicates if you want 

to generate a log file 

containing any warning 

that can occur during 

the execution of the 

Buildchain program 

S/A user  

Table 13 “Other options” keys. 

The LOS matrices produced during the cost calculation step are stored in the scenario folder in 

Voyager format (i.e. in MAT format). 

With the second key the user selects whether the Buildchain program will produce log files or 

not. The log files (*.log) contain any warnings that can occur during the execution. Please refer to 

the Program documentation for the logistics model (see References) for more information. 

The next group of keys allows the user to set the advanced options for the logistics module 

(heading “Logistics module settings – advanced”) and is made up by three catalog keys, see 

Table 14 below. 

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Do you want to run 

the Logistics module 

on several 

processors? 

Yes It indicates if you want 

to run the model on 

several processors 

S/A user 

2 How many 

processors would you 

like to run 

simultaneously? 

4 It specifies the number 

of processes to run 

simultaneously 

S/A user 

3 Scaling factor for 

outputs 

Thousands It specifies the scaling 

factor for outputs 

S/A user  

Table 14 “Logistics module settings – advanced” keys. 

If the computer has more than one CPU available, it is possible to split up the processes 

between the CPUs to speed up the run time of the model, using the catalog keys above. The 

third key enables the user to define the scale of the output that will be presented in the reports. If 

the value is thousands, the output value (for instance 2.000.000 vehicle kilometers) will be 

presented as the value divided by thousand (i.e., 2.000 vehicle kilometers in the example).  

The next group of catalog keys is named “Stop points setting”. During the execution of the 

Samgods Model application is possible to pause the simulation running on each steps (LOS, 
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Logmod, LP0, LP1 LP1b). Using these keys listed in the Table 15, is it possible to define settings 

for the stop points. For a deep description of meaning of LP0, LP1 and LP1b see section for 

RCM.  

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Do you want to pause 

the run waiting for 

your action on steps 

LOS, Logmod, LP0, 

LP1, LP1b 

Yes It indicates if you want 

to pause the simulation 

running at each step  

If you select “yes”, the 

run will be paused at 

the end of the 

processes LOS, 

LogMod, LP0, LP1(or 

higher) and LP1b. 

S/A user 

2 Step completion Email It indicates how to 

inform the user that a 

step is completed 

S/A user 

3 Folder where is 

installed Media 

Player 

C:\Program Files 

(x86)\Windows Media 

Player\wmplayer.exe 

It specifies the 

installation directory for 

Media Player program 

Media Player is used 

to inform by a sound 

that a step is 

completed, if  the 

previous key is set to 

“Sound” or “Both” 

Developer 

4 Location of song to 

Play 

C:\Users\Public\Music\S

ample 

Music\Kalimba.mp3 

It specifies the sound 

file used to inform that 

a step is completed, if 

key number 2 is set to 

“Sound” or “Both” 

Developer 

5 Insert the email 

address for status on 

run 

name@account.com It specifies an e-mail 

address used to send 

an e-mail to inform that 

a step is completed, if 

key number 2 is set to 

“Email” or “Both” 

S/A user 

6 Email server address smtp.company.com It specifies the server 

address for sending e-

mail and it is your 

SMTP address; if 

IMAP address is used 

instead of SMTP, it is 

possible to convert it in 

SMPT address using a 

free software 

(http://www.roadkil.net/

Developer 

mailto:name@account.com
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downloads.php, DIG© 

2004-2009) 

7 Email password password It specifies the 

password of your e-

mail address  

Developer 

8 Email username name It specifies the 

username provided 

when setting up your 

e-mail 

Developer 

9 Sending account name@account.com It specifies sending 

account e-mail address 

Developer 

Table 15 “Stop points settings” keys. 

In the table above, for key no. 1 indicates if you want to pause the simulation running at each 

step and possible values are: 

 Yes – The run will be paused at the end of each step (LOS, LogMod, LP0, LP1(or 

higher) and LP1b). To continue the run, CUBE will wait for your confirmation 

 No – The run will not be paused at the end of each step (LOS, LogMod, LP0, LP1 (or 

higher), and LP1b) 

Key no. 2 how to inform the user that a step is completed and possible values are: 

 Sound – When a step is completed a sound starts 

 Email – When a step is completed an e-mail is sent to a specified e-mail address 

 Both – When a step is completed a sound starts and an e-mail is sent to a specified e-

mail address 

 None – When a step is completed do nothing 

Key no. 3 and 4 specify the program used to reproduce the sound and the sound file, while key 

no. 5 specifies the e-mail address for sending e-mail about the step completion. 

Keys from no. 6 to no. 9 specified your provider details and e-mail settings. 

If you set the first key to “Yes”, make sure to set properly all keys for e-mail settings. 

3.5.2. Rail Capacity Management 

Next group of catalog keys, specifies several parameters for Rail Capacity Management (see 

Table 19). For a complete comprehension we refer to documentation listed in 10.1 and 10.6. 

 

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Cut off criteria for 

RMC process (will 

consider links with 

V/C > XX% where XX 

is the value defined) 

50 It specifies a 

percentage value for 

exclusion of link flows. 

According to 

experience, railway 

links with flow to 

capacity rates (V/C) at 

this or lower levels will 

not have any impact on 

Advanced 

user 

mailto:name@account.com
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the solution 

2 Maximum number of 

iterations in Rail 

assignment 

500 It specifies the 

maximum number of 

iteration in the empty 

train rail assignment 

(considering link 

congestion)  

Advanced 

user 

3 Delay function for 

Empty assignment 

(Derivate) 

2*10000*(MAX(0,VOLC[

LI.ID_LINK]-C)) 

It specifies the delay 

function used for the 

assignment of empty 

vehicles 

Advanced 

user 

4 Options to save 

output files from RMC 

process 

Yes, for all iterations It indicates you want to 

save output file from 

Rail Capacity 

Management process 

for all the iterations (for 

instance LP0, LP1, 

LP2 etc.) or only in the 

last iteration.  

S/A user 

5 Maximum number of 

loops for Linear 

Programming 

process (LP) 

0 It specifies the 

maximum number of 

loops for the linear 

programming process 

(LP). The 0 value 

means that only LP0 

will be perform. A 

different number 

between 1 and 9 will 

iterate the process until 

that number (or earlier 

if convergence will be 

reach). 

S/A user 

6 Maximum number of 

loops for Adjust 

Capacity Procedure 

0 It specifies the 

maximum number of 

loops for the Adjust 

Capacity procedure. 

Similarly as for the 

previous catalog key, 0 

means that the Adjust 

Procedure will be 

skipped. 

S/A user 

7 Percentage of 

Overcapacity to be 

removed 

(over_capacity factor) 

0.5 It specifies the value 

for the over capacity 

factor. It represents the 

share of capacity 

overload to remove 

from the right hand 

side in the LP-model 

Advanced 

user 

8 File with list of locked 

solutions for RCM: 

LockedSTDLogMod_em

pty.txt 

Free format file placed 

under 

C:\Samgods\01_Progr

Advanced 

user 
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ams\Logmod\RCM 

with list of transport 

chains that must be 

excluded in setting up 

the LP problem. The 

solution evaluated in 

Standard Logistics 

Module will be applied.  

9 Link number to use in 

debug mode 

CheckLinkN_itXX.dat 

Max 10 links (Comma 

s, ex. 1,25,182,164) 

51,82,84,234,272,274 Providing the ID_Link 

list an extra report will 

be produced under 

RCM folder. 

Advanced 

user 

Table 16 “RCM Parameters” keys. 

The first key in the table above will filter the transport chain solutions for rail links where the 

ration between total vehicle flows and capacity is greater or equals the value specified in the 

catalog key. Since the linear programming problem could be huge (millions of records), this limit 

could cut down the dimension of the problem. It is recommended to keep the default value. 

The second key specifies the maximum number of iteration for the rail assignment with capacity 

constraints. 

The third key specify the delay function used for the assignment of empty vehicles; possible 

choices are: 

 2*10000*(MAX(0,VOLC[LI.ID_LINK]-C)) 

 4*10000*(MAX(0,VOLC[LI.ID_LINK]-C)^3) 

The fourth key indicates if you want to save output files from RCM process and possible choices 

are: 

 Yes, for all iteration 

 No, This option will save results only for the final iteration and the previous one 

The options for these keys are: 

 Run only LP0 

o Maximum number of loops for Linear Programming process (LP) = 0 

o Maximum number of loops for Adjust Capacity Procedure = 0 

 Run only LP1 

o Maximum number of loops for Linear Programming process (LP) = 1 

o Maximum number of loops for Adjust Capacity Procedure = 0 

 Run only LP1b 

o Maximum number of loops for Linear Programming process (LP) = 1 

o Maximum number of loops for Adjust Capacity Procedure = 1 

 Run LP2, LP1b 

o Maximum number of loops for Linear Programming process (LP) = 2 

o Maximum number of loops for Adjust Capacity Procedure = 1 

IMPORTANT NOTE - Warm start for Rail Capacity Management !!! 

The Samgods model could be run in several different ways. The current setup allows the 

following choices (using "Run only one step, or run all steps" catalog key and catalog keys 5 and 

6 in Table 16): 
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- All: an interrupted run from LOS to reports for RCM. The number of LP and Adjust LP will be 

specified by catalog keys 5 and 6; 

- Logistics Module or Assignment or Reports: a single step for standard log mod; 

- Standard LogMod: all the steps related to Standard Logistic module (LOS +Logistic Module 

+Assignment +Reports) 

- Rail Capacity Management: only the rail capacity management running the number of LP and 

Adjust Capacity loops specified via keys 5 and 6. 

If the user wishes to run an extra step for LP or LP Adjust, it would be sufficient set the three 

keys as shown below:  

For instance in a previous step LP1 has been run, and it is required to run LP2, it will be 

sufficient set the model in the following manner: 

- Run only one step, or run all steps=Rail Capacity Management 

- Maximum number of loops for Linear Programming process (LP) =2 

- Maximum number of loops for Adjust =1 

 

3.5.3. Calibration 

Next group of catalog keys specifies parameters and table for calibration and they are available 

for developer users only (see Table 17). The calibration procedure should be not used at all. The 

following keys should be not changed, except catalog key 7. 

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Initial values for port 

calibration by Port 

Area and STAN 

group 

C:\Samgods\05_Input_D

ata\Calibration\PortArea

sParameters_12082014.

txt 

It specifies a text file 

containing the initial 

values of factors for 

port areas; these 

values are specific by 

port area and STAN 

group. These scaling 

factors are applied to 

time for sea vessels 

301 – 321. 

Developer 

2 Starting value for 

scaling factor on Kiel 

canal 

1.55 It specifies the initial 

values of factor for Kiel 

canal. This scaling 

factor is applied to the 

canal toll 

Developer 

3 Maximum number of 

loops in calibration 

process 

1 It specifies the 

maximum number of 

loops to run in the 

process 

Developer 

4 Parameters for port 

calibration procedure 

(step length, 

C:\Samgods\ 

05_Input_Data\Calibrati

on\Parameters_portcalib

Step length, minimum 

value, cat off value and 

default minimum value 

Developer 
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minimum value, 

threshold, default) 

ration.dbf for calibration 

procedure on port 

areas 

5 Parameters for Kiel 

calibration procedure 

(step length, 

minimum value, 

threshold, default) 

C:\Samgods\ 

05_Input_Data\Calibrati

on\ 

Parameters_Kielcalibrati

on.dbf 

Step length, minimum 

value, cat off value and 

default minimum value 

for calibration 

procedure on Kiel 

canal 

Developer 

6 Restart process from 

loop 

1 The calibration 

procedure could be run 

for a fix number of 

loops. If the run 

crashes at a specific 

loop or it is required to 

run an extra loop, this 

catalog key sets the 

loop number to restart 

with. 

Developer 

7 Consolidation factors 

table 

C:\Samgods\05_Input_D

ata\Input_Data.mdb\Buil

dChain_CONSOL 

Individual consolidation 

bounds for all sub 

modes [LB,HB] Default 

values and specific 

values for STAN 

groups 2, 8 and 9 

Developer 

Advanced 

user 

Table 17 “Parameters and tables for calibration” key. 

The calibration procedure uses a set of initial values specified via catalog keys 1 and 2 and 

progressively changes those values comparing the results with statistics. It applies a revision to 

the values using a step length search specified in catalog keys 4 and 5. For further details on this 

please refer to document listed under Section 10.7. 

Catalog keys 3 and 6 are used to manage and control the calibration process. The first sets the 

maximum number of loops for the process, the second allows to run extra loops after a 

completed run.  

The catalog key 7 allows specification of a different consolidation factors table and could be used 

in setting up sensitivity tests for the lower and upper bounds for each submode. For further 

details on its usage refer to Chapter 5. 

The last catalog key is only accessible in model developer or advanced user mode and it defines 

the wait time for prompt message during simulation running (see Table 18). 

 

Catalog key name Example of 

value 

Model User’s 

rights 

Wait time for prompt messages during execution (default 

10 minutes = 600 secs): 

600 Developer 

Advanced user 

Table 18 Settings key. 

For a standard user the model will prompt window messages along the run and wait for the 

reaction from the user for 10 minutes. After that time it will apply the first choice available in each 

message and the run will continue to the next prompt window. The advanced user could decide 



Description of the applications – 

 

 

73 
 

to reduce the wait time to a small value, for instance 2 sec, just changing the value for this 

catalog key. This choice, in other words, is suitable when several scenarios must be run in a 

sequence, since it will not require any action from the operator.  

3.5.4. Outputs 

Based on the selections made by the user, different outputs are created – one set of outputs for 

each specific setting of the catalog key “Select commodities for the Logistics Module (…)” for 

Standard LogMod. The output files and their locations are listed in the file Scenario 

Outputs\Samgods Report\Existing Outputs in the Data Section window.  

Regarding empty vehicle calculations, the reader is referred to the appendix section 11.2 for 

further details. 

The available outputs from the respective steps in the Samgods model application that can be 

accessed from the interface are: 

LOS Calculation step 

 LOS matrices by mode showing distance, time, extra cost, domestic distance and 

generalized cost summarized link-by-link along the minimum cost path (if the LOS 

Calculation step or the whole run was selected) 

Logistics module step 

 The loaded vehicle matrices (number of vehicles) by vehicle type (if the Logistics module 

step or the whole run was selected) 

 Tonnes flow matrices – tonnes of freight by vehicle type (if the Logistics module step or 

the whole run was selected) 

 The empty vehicle matrices (number of empty vehicles) by vehicle type (if the Logistics 

module step or the whole run was selected and the attribute “EMPTY_V” in the Vehicles 

Parameters table was set to 1 for the specific vehicle type, see Section 5.4).  

 OD covered – various output reports per vehicle type, chain type, zone, and commodity 

– all the output used to create summary reports no. 2, 5-8, 10,11 and 12 (see Table 2) 

Assignment step 

 All freight flows in tonnes, number of loaded vehicles and number of empty vehicles 

assigned to the network by vehicle type (if the Assignment step or the whole run was 

selected).  

Report step 

 The freight flows in tones, number of loaded and empty vehicles assigned to the network 

with all modes in the same network (if the Report step or the whole run was selected).  

 Summary report no. 1. Summary table of number of vehicles and vehicle kilometres per 

vehicle type (domestic and in total) and per mode in the assigned network (if the Report 

step or the whole run was selected).  

 Summary report no. 4. Summary table of tonnes and tonne kms per vehicle type 

(domestic, international and total) and per mode (if the Report step or the whole run was 

selected) 

 Summary report no. 9. Summary table of vehicle kms, tonne kms, empty vehicle kms, 

and total vehicle kms per geographic region and mode (road and rail only) (if the Report 

step or the whole run was selected).  

 Summary report no. 13. Summary table of tons per port area and STAN group and 

comparison with statistics (if the Report step or the whole run was selected) 
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 Summary report no. 14. Summary table of results on Oresund bridge, Kiel Canal and 

Jylland and comparison with (if the Report step or the whole run was selected) 

 Network with bidirectional tonnes per rail vehicle type 

 Summary report no. 16. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads (if the Report step or the whole run was selected) 

 Summary report no. 17. Summary table of vehicle kms per county and vehicle type and 

their distribution on E10 (category 11) (if the Report step or the whole run was selected) 

 Summary report no. 18. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads except E10 (if the Report step or the whole run was 

selected) 

RCM Logistic Module step (if the Rail Capacity Management step or the whole run was selected) 

 The loaded vehicle matrices (number of vehicles) by mode and vehicle class  

 Tonnes flow matrices – tonnes of freight by mode and vehicle type  

 The empty vehicle matrices (number of empty vehicles) by mode and vehicle type  

 OD covered – various output reports per vehicle type, chain type, zone, and commodity 

– all the output used to create summary reports no. 2, 5-8, 10,11 and 12 (see Table 2) 

RCM Assignment step (if the Rail Capacity Management step or the whole run was selected) 

 All freight flows in tones, number of loaded vehicles and number of empty vehicles 

assigned to the network by mode  

RCM Report step (if the Rail Capacity Management step or the whole run was selected) 

 The freight flows in tones, number of loaded and empty vehicles assigned to the network 

with all modes in the same network   

 Summary report no. 1. Summary table of number of vehicles and vehicle kilometres per 

vehicle class (domestic and in total) and per mode in the assigned network. See 

appendix section 11.2 for details 

 Summary report no. 4. Summary table of tones and tonne kms per vehicle type 

(domestic, international and total) and per mode  

 Summary report no. 9. Summary table of vehicle kms, tonne kms, empty vehicle kms, 

and total vehicle kms per geographic region and mode (road and rail only) See appendix 

section 11.2 for details 

 Summary report no. 13. Summary table of tonnes per port area and STAN group and 

comparison with statistics  

 Summary report no. 14. Summary table of results on Öresund bridge, Kiel canal and 

Jylland and comparison with statistics  

 Summary report no. 15. Summary table of bidirectional number of trains and tonnes per 

day Summary report no. 15b. Summary table of bidirectional number of trains and 

tonnes per day indicating capacity and train flows above the capacity level  

 Network with bidirectional tons per mode 

 Summary report no. 16. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads  

 Summary report no. 17. Summary table of vehicle kms per county and vehicle type and 

their distribution on E10 (category 11)  

 Summary report no. 18. Summary table of vehicle kms per county and vehicle type and 

their distribution on all the roads except E10  
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3.6.  Compare scenarios application 

A view of the application can be seen in Figure 18 on the next page. The purpose of this 

application is to compare model outputs between different scenarios. Each scenario can be 

compared with any other scenario present under the Scenario_Tree structure. There are four 

catalog keys to handle this application, see Table 19. 

 

 Catalog key name Example of value Description Model 

User’s 

rights 

1 Select commodities 

for the Logistics 

Module (for all 

commodities, select 

0) 

0 It specifies which 

commodity type result 

has to be compared; it 

is possible specify only 

one NSTR commodity 

type (value from 1 to 

35), or only one STAN 

commodity type (value 

from STAN1 to 

STAN12) or all the 

commodities (value 0) 

S/A user 

2 What do you want to 

compare? 

LOS Matrices It specifies which set of 

result to compare; it is 

possible to specify a 

single step or all the 

steps 

S/A user 

3 Scenario name to use 

in comparison: 

Base2006 It specifies the name of 

the scenario to 

compare with the 

current scenario 

S/A user 

4 Scenario folder for 

comparison: 

C:\Samgods\Scenario_T

ree\Base2006 

It specifies the 

directory of the 

scenario to compare 

S/A user 

Table 19 Compare Scenarios application catalog keys. 

The user needs: 

 to select the scenario name that he/she wants to compare with the current scenario 

using the third catalog key; 

 to identify the folder location for the scenario used for comparison (e.g. folder where the 

outputs for scenario selected with previous catalog key are places., usually under 

Scenario_Tree folder plus short scenario name) and to update accordingly the fourth 

catalog key value; 

 to select which commodity type results to compare (select the commodity number, a 

STAN commodity group or 0 for all in first catalog key) between different scenarios. It is 

the user’s responsibility to verify that the same outputs exist for both scenarios. This 

could be done by looking in the Existing Outputs file for the respective scenario, found in 

the folder Scenario Outputs\Samgods Report in the Data section window. If the 

requested files do not exist for any of the scenarios, the process will be terminated with 

return code 2 from the Task Monitor program, see Section 2.6. 
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 With the second catalog key the user has the option to compare only a specific set of 

output (among the ones listed below) or all of the results 

 

 

Figure 18 Compare Scenarios application. 

Three sets of output will be produced by this application: 

 The LOS matrix comparison: the difference values with sign between the base scenario 

and the selected scenario for each matrix by mode; 

 Logistics Module output comparison: The OD matrices with number of vehicles (totals 

and empties) and the tonnes are analyzed as well as the margins of the matrices for the 

vehicle OD matrices (TRIPEND) (the margin is the sum of each row and column 

respectively, i.e., the totals of attraction and generation): the absolute differences 

between the base scenario and the selected scenario.; 

 The Assignment comparison: the differences between the assigned network for the base 

scenario and the selected scenario in absolute values. 

3.7. Handling scenario application 

Figure 19 shows an outline of the Handling Scenario application. As described earlier, the 

scenario data is stored in the main geodatabase as a group of scenario specific table\s, so 

managing this group of files requires dedicated tools to avoid creating any inconsistencies in the 

input data between scenarios. This application allows the user to delete all no longer required 

data, to easily import or export scenarios from or to other catalogs, to set up a new structure with 

a new base scenario, etc. 

This application has different subgroups with specific purposes, all of them related to handling 

the scenario data. The structure can be seen in the applications tree in the Applications window. 
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Figure 19 Handling scenario application. 

Each subgroup corresponds to a specific operation: 

 Delete: delete the scenario-specific tables completely in the main geodatabase 

 Compact: compress the geodatabase files to save disk space (see Section 4.9 for 

further information) 

 Scenario Export: This subgroup has two main purposes:  

1. One is to enable the set up of a new catalog, using the current scenario (i.e., the 

scenario that the application is executed for) as the base scenario in the new 

catalog. One case where it may be appropriate to create a new catalog with a 

new base scenario is if one of the scenarios in a catalog is being used as the 

base scenario in a new project. Another reason could be that the database 

becomes too large (with too many alternative scenarios, for instance), since it 

has a physical limit for its size. Then it may be appropriate to create a new 

catalog with a base scenario that is a copy of the original, where more 

alternative scenarios (belonging to the same overall project) may be stored  

2. Another one is to enable to export the scenario-specific tables for a specific 

scenario into another, already existing catalog with a different base scenario. 

The exported scenario can never become the base scenario in the destination 

catalog – if the user wants this, then alternative 1. above must be used. This 

function is useful e.g. when the user wants to set up a scenario in a new catalog 

with a certain base scenario, and already has a similar scenario in another 

catalog with another base scenario. Then the old scenario can be exported to 

the new catalog and the user only has to change some of the input data, instead 

of starting all over again 

 Scenario Import: When the scenario-specific tables have been exported to another 

catalog using the previous subgroup (Scenario Export), the Scenario Import tool is used 

to control whether the scenario parameters in the new catalog have the same values as 

those in the imported scenario 
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As showed in the Table 20, the first two groups of catalog keys specify scenario parameters and 

parameters for the logistics module. These keys are used only by the Scenario Import subgroup; 

no editing is required for these keys otherwise. 

 

 Catalog key name Example of value Model 

User’s 

rights 

1 Attribute name for extra cost on specific link 

[SEK] 

EC_V S/A user 

2 Attribute name for extra cost on specific link 

[SEK/km] 

EC_KM_V S/A user 

3 Daily factor for all modes (except for Rail 

Mode) [days per year] 

365 S/A user 

4 Daily factor for Rail Mode [days per year] 250 S/A user 

5 Peak Hour Factor 0.12 S/A user 

6 General parameters for Logistics Module 

[Table] 

C:\SamGods\Scenario_Tree\B

ase2006\Scenario_Data.mdb\L

ogMod_Base2006 

Developer 

7 Interest rate used in cost calculations 

[%/100/year] 

0.1 S/A user 

8 Stuffing cost [SEK per tonne] 18 S/A user 

9 Number of transport chain solutions for the 

Logistics Module 

2 S/A user 

10 Output variables for the optimal transport 

solution [e.g.1,2,3, max is 8] 

6,7 S/A user 

11 Initial consolidation factor in BuildChain (1° 

iteration) 

0.75 S/A user 

12 ALL_LORRY_TYPE_CONSOL Yes S/A user 

13 INDIVIDUAL_OD_LEG_OPTIMIZE Yes S/A user 

14 MINIMUM_ANNUAL_TONNE_DEMAND_4

_FREQ_OPTIMIZE 

10 S/A user 

15 Lower bound for consolidation factor 0.1 S/A user 

16 Upper bound for consolidation factor 0.95 S/A user 

17 TONNES DYNAMIC_MAX S/A user 

18 Consolidation factors table {CATALOG_DIR}\05_Input_Da

ta\Input_Data.mdb\BuildChain

_CONSOL 

S/A user 

19 Do you want to log parameters from control 

files? 

Yes S/A user 
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20 Do you want to log reading of input data? Yes S/A user 

21 Do you want to log cost values from vehicle 

files? 

Yes S/A user 

Table 20 Catalog keys for the Import subgroup. 

The third group of catalog keys is “Installation parameters“, and it is only available in developer 

mode, see Table 21. It defines the location of the Python program and the name of the base 

scenario. 

 

 Catalog key name Example of value Model 

User’s 

rights 

1 Location of Python program C:\Python27\ArcGIS10.1 Developer 

2 Scenario name for the BASE Scenario Base2006 Developer 

Table 21 “Installation parameter” keys. 

The next group, “Run Selections”, contains only one key that is for defining the commodity 

type(s), see Table 22. It is only used when the user wants to compress the geodatabase files. 

 

 Catalog key name Example of value Model 

User’s 

rights 

1 Select commodities for the Logistics 

Module (for all commodities, select 0) 

STAN1 S/A user 

Table 22 “Run Selections” key. 

The fourth group of keys is related to which subgroup the user wants to use, and how to use it, 

see Table 23. 

 

 Catalog key name Example of value Model 

User’s 

rights 

1 Do you want to delete the current scenario? 

(mandatory if you want to delete the 

scenario) 

Tick S/A user 

2 Do you want to compact the geodatabase 

files? 

Tick S/A user 

3 Select how you want to use the export 

function 

(1) Do you want to export the model into a 

new folder using the current scenario as 

base? 

(2) Do you want to export the current 

scenario into another model? 

(3) Do nothing 

3 S/A user 
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4 Where do you want to export the model (1) 

or scenario (2)?  

C:\Samgods_V20130701 S/A user 

5 Name of the base scenario in the new 

model (1), (2)  

Base2006 S/A user 

6 Do you want to check the imported 

scenario? 

Yes S/A user 

Table 23 Catalog keys for selecting actions. 

The first catalog key in Table 23 enables the application to delete the scenario specific tables for 

the current scenario. During the execution, a prompt window will ask the user to confirm the 

selections made to avoid mistakes.  

The second catalog key in Table 23 enables the application to compact all the geodatabase files 

for the scenario, for both the input and output data. It is recommended to do this regularly, 

especially after tables etc. have been deleted. Please refer to Section 4.9 for more information. 

The third catalog key activates the export function. It has a default value, (3) – “Do nothing”. To 

export the entire catalog (option (1), catalog = model in the Samgods GUI) (including the current 

scenario as the new base scenario), a folder location must be provided in the fourth catalog key 

and a new name should be given to the new base scenario in the fifth catalog key. If the user 

wants to export only the selected scenario to another catalog (option 2 in the third key), the folder 

where the .cat file for this catalog is located should be indicated in the fourth key. The name of 

the base scenario in the destination catalog should be specified in key no. 5. If the user wants to 

delete or compact a scenario (i.e. has selected “(3) Do nothing” for key no. 3), it does not matter 

what is typed in for keys no. 4 and 5, but since no keys can be left undefined, something must be 

put there because of the construction of the software (just typing in a random character works). 

The last catalog key (no. 6) enables the application to control the scenario parameters for an 

imported scenario. The scenario parameter values in the new catalog must be identical to the 

ones in the imported scenario. The execution of this subgroup produces a report, Report for the 

import phase, accessible from the Data Section window in the interface, in the folder Scenario 

Outputs\Import function report. The report provides a list of the scenario parameters that need to 

be changed. The parameters are changed by editing the catalogue keys for the imported 

scenario according to the report, under “Scenario Parameters” in the Handling Scenario 

application and then run the application again. 

Regarding output or reports from these functions: 

 No outputs are produced by the Delete and Compact subgroups, because they work on 

the tables inside the geodatabase or on the geodatabase itself; 

 The Scenario Export function creates a new catalog with a new base scenario, or a new 

scenario in an existing catalog, depending on the selections made; 

 The Import Scenario subgroup will create a report, Report for the import phase, as 

described above. 

 

 

3.8.  PWC_Matrices application 

A screenshot of the PWC_Matrices application is shown in Figure 20 below. The purpose of the 

application is to create the PWC matrices in Voyager format in order to enable visualization in 

the interface. 
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In Standard user /Advanced user mode there is only one catalog key to specify the year of the 

PWC matrices. In developer mode there is also a key to identify the base scenario. 

 

 Catalog key name Example of value Model 

User’s 

rights 

1 Year of PWC matrices 2006 S/A user 

2 Scenario name for the BASE Scenario Base2006 Developer 

Table 24 Catalog keys for the PWC_Matrices application. 

Possible input values for the first key (Year of PWC matrices) in Table 24 are: 

 2006: PWC matrices for year 2006 

 2030: PWC matrices for year 2030 

 2030BnM: PWC matrices for year 2030 (with PWC 2006 matrix for commodity 15) 

 

 

Figure 20 PWC_Matrices application. 

It is only necessary to run the PWC_Matrices once per year in order to create the matrices. PWC 

matrices for all commodities will be produced when running the application – 35 matrices in 

Voyager format are created in the folder 01_Programs\LogMod\Input\PWC\VY_F\, found in the 

Samgods folder (see Table 1 in Section 1.5). In order to access the matrices from the Data 

Section window (in Scenario Inputs\PWC_Matrices\PWC matrix for commodity), open the 

Samgods Model application in the Scenario Manager window and select a commodity using the 

catalog key “Select commodities for the Logistics Module (…)”. In this step, the application 

should not be run, just save the settings by clicking “Save” and the matrices can be found in the 

Data Section window. The value 0 (for all commodities) is not allowed for this application. This is 

because the PWC_Matrices application only allows showing one commodity at a time.  

3.9. Change matrix format application 

In Figure 21 below, the Change matrix format application is outlined. The purpose of the 

application is the following. All the data in a catalog is accessible using Microsoft Office Access 
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(2003 or later) (all data except the geodatabases could also be accessed using Excel or 

Notepad). The only exception is the data related to the matrix structure, which has a binary 

Voyager format. The matrix files have a .mat extension. There are two ways to export these files 

in order to use them in Access, Excel or a text editor. The first way is to use the functions in the 

Cube Interface. For further details, see the reference guide RG_CubeBase.pdf in Chapter 10 – 

Exporting matrix cell values. In short, this is done by choosing “Export…” from “File” on the menu 

bar and selecting the appropriate file format.  

 

Figure 21 Change matrix format application. 

The second way is provided by this application, as follows. The catalog keys in Table 25 below 

handle the export of Voyager format matrix files. 

 

 Catalog key name Example of value Model 

User’s 

rights 

1 Select commodities for the 

Logistic Module (for all 

commodities, select 0) 

STAN1 S/A user 

2 Do you want to export to CSV, 

DBF or GDB format? 

CSV S/A user 

3 Do you want to create a new 

geodatabase or use an existing 

one? 

Existing S/A user  

4 Define the GDB where the matrix 

should be exported.  

C:\Samgods\Scenario_Tree\ 

Base2006\Matrices_Base2006.mdb 

S/A user  

5 What kind of matrix do you want 

to export? 

COST S/A user 

6 What vehicle class do you want 

for the LOS matrices? 

317 S/A user 

7 What is the mode that you want ROAD S/A user 
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for the matrices? 

8 Do you want the distance, time, 

domestic distance or extra cost 

LOS matrix? 

Time S/A user 

9 What type of vehicle class (or 

total) do you want for the 

VEHICLES and TONNES 

matrices? 

202 S/A user 

Table 25 Change matrix format application catalog keys. 

Regarding key no. 2, CSV format refers to Comma Separated Values, DBF refers to Database 

Format and GDB refers to Geodatabase format. If the matrix is exported to a geodatabase, it will 

be created as a table inside an existing geodatabase or a new geodatabase containing this table 

will be created, depending on the choices made by the user. 

To understand the usage of the keys 5-9, and how to export the correct values, an explanation of 

the size and the structure of the matrices is required. 

The following table (Table 26) presents how the LOS matrices are saved in the scenario folder, 

how many matrices that are saved in each matrix file and what their names are. For the OD 

matrices, see the next table (Table 27). 

 

Folder Name of matrix file Name of matrix Descriptio

n 

Total 

number 

of 

matrices 

{Scenari

o_Dir} 

COST_ROAD_{SCENA

RIO_SHORTNAME}.MA

T 

D101_{SCENARIO_SHORTNAME}, 

D102_{SCENARIO_SHORTNAME}, 

D103_{SCENARIO_SHORTNAME}, 

D104_{SCENARIO_SHORTNAME}, 

D105_{SCENARIO_SHORTNAME} 

Distance 

(km) for 

vehicle type 

101-105 

25 

T101_{SCENARIO_SHORTNAME}, 

…, T105_{SCENARIO_SHORTNAME} 

Time (hours) 

for vehicle 

type 101-

105 

X101_{SCENARIO_SHORTNAME}, 

…, 

X105_{SCENARIO_SHORTNAME} 

Extra costs 

for vehicle 

type 101-

105 

CG101_{SCENARIO_SHORTNAME}, 

…, 

CG105_{SCENARIO_SHORTNAME} 

Generalized 

cost for 

vehicle type 

101-105 

DD101_{SCENARIO_SHORTNAME}, 

…, 

DD105_{SCENARIO_SHORTNAME} 

Domestic 

distance 

(km) for 

vehicle type 

101-105 

{Scenari COST_RAIL_{SCENARI D201_{SCENARIO_SHORTNAME}, Distance 40 
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Folder Name of matrix file Name of matrix Descriptio

n 

Total 

number 

of 

matrices 

o_Dir} O_SHORTNAME}.MAT D202_{SCENARIO_SHORTNAME}, 

D204_{SCENARIO_SHORTNAME}, 

D205_{SCENARIO_SHORTNAME}, 

D206_{SCENARIO_SHORTNAME}, 

D207_{SCENARIO_SHORTNAME}, 

D208_{SCENARIO_SHORTNAME}, 

D209_{SCENARIO_SHORTNAME} 

(km) for 

vehicle type 

201, 202, 

204-209 

T201_{SCENARIO_SHORTNAME}, 

T202_{SCENARIO_SHORTNAME}, 

T204_{SCENARIO_SHORTNAME}, 

…, T209_{SCENARIO_SHORTNAME} 

Time (hours) 

for vehicle 

type 201, 

202, 204- 

209 

X201_{SCENARIO_SHORTNAME}, 

X202_{SCENARIO_SHORTNAME}, 

X204_{SCENARIO_SHORTNAME}, 

…, 

X209_{SCENARIO_SHORTNAME} 

Extra costs 

for vehicle 

type 201, 

202, 204-

209 

CG201_{SCENARIO_SHORTNAME}, 

CG202_{SCENARIO_SHORTNAME}, 

CG204_{SCENARIO_SHORTNAME}, 

…, 

CG209_{SCENARIO_SHORTNAME} 

Generalized 

cost for 

vehicle type 

201, 202, 

204-209 

DD201_{SCENARIO_SHORTNAME}, 

DD202_{SCENARIO_SHORTNAME}, 

DD204_{SCENARIO_SHORTNAME}, 

…, 

DD209_{SCENARIO_SHORTNAME} 

Domestic 

distance 

(km) for 

vehicle type 

201, 202, 

204-209 

{Scenari

o_Dir} 

COST_SEA_{SCENARI

O_SHORTNAME}.MAT 

D301_{SCENARIO_SHORTNAME}, 

D302_{SCENARIO_SHORTNAME}, 

…, 

D321_{SCENARIO_SHORTNAME} 

Distance 

(km) for 

vehicle type 

301-321 

105 

T301_{SCENARIO_SHORTNAME}, 

T302_{SCENARIO_SHORTNAME}, 

…, T321_{SCENARIO_SHORTNAME} 

Time (hours) 

for vehicle 

type 301-

321 

X301_{SCENARIO_SHORTNAME}, 

X302_{SCENARIO_SHORTNAME}, 

…,  

X321_{SCENARIO_SHORTNAME} 

Extra costs 

for vehicle 

type 301-

321 

CG301_{SCENARIO_SHORTNAME}, 

CG302_{SCENARIO_SHORTNAME}, 

Generalized 

cost for 
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Folder Name of matrix file Name of matrix Descriptio

n 

Total 

number 

of 

matrices 

…, 

CG321_{SCENARIO_SHORTNAME} 

vehicle type 

301-321 

DD301_{SCENARIO_SHORTNAME}, 

DD302_{SCENARIO_SHORTNAME}, 

…, 

DD321_{SCENARIO_SHORTNAME} 

Domestic 

distance 

(km) for 

vehicle type 

301-321 

{Scenari

o_Dir} 

COST_AIR_{SCENARI

O_SHORTNAME}.MAT 

D401_{SCENARIO_SHORTNAME} Distance 

(km) for 

vehicle type 

401  

5 

T401_{SCENARIO_SHORTNAME} Time (hours) 

for vehicle 

type 401 

X401_{SCENARIO_SHORTNAME} Extra costs 

for vehicle 

type 401 

CG401_{SCENARIO_SHORTNAME} Generalized 

cost for 

vehicle type 

401 

DD401_{SCENARIO_SHORTNAME} Domestic 

distance 

(km) for 

vehicle type 

401 

Table 26 Matrix table: LOS matrices. 

 

Table 27 presents how the Vehicle, Tonne, and Empty Vehicle OD-matrices are saved in the 

scenario folder, how many matrices that are saved in each matrix file and their names .The 

matrices in Table 27 have an index (0 in the table) that represents the commodity class number 

(e.g., ROAD_VHCLFLOW0_{SCENARIO_SHORTNAME}.MAT). The value 0 refers to all commodities, and 

a specific number in the range 1 to 35, or STAN1 to STAN12, represents the respective 

commodity selection.  
 

 

Folder Name of matrix 

file 

Name of matrix Descripti

on 

Total 

of 

matric

es 

{Scenario_

Dir} 

ROAD_VHCLFLOW0_

{SCENARIO_SHORTN

AME}.MAT 

101_{SCENARIO_SHORTNAME}, … 

105_{SCENARIO_SHORTNAME}, 

Road_{SCENARIO_SHORTNAME} 

OD 

vehicles by 

vehicle 

type 101-

6 
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Folder Name of matrix 

file 

Name of matrix Descripti

on 

Total 

of 

matric

es 

105 and 

total for 

road mode 

{Scenario_

Dir} 

RAIL_VHCLFLOW0_{

SCENARIO_SHORTN

AME}.MAT 

201_{SCENARIO_SHORTNAME}, 

202_{SCENARIO_SHORTNAME}, 

204_{SCENARIO_SHORTNAME},... 

209_{SCENARIO_SHORTNAME}, 

Rail_{SCENARIO_SHORTNAME} 

OD 

vehicles by 

vehicle 

type 201, 

202, 204-

209 and 

total for rail 

mode 

9 

{Scenario_

Dir} 

SEA_VHCLFLOW0_{S

CENARIO_SHORTNA

ME}.MAT 

301_{SCENARIO_SHORTNAME}, … 

321_{SCENARIO_SHORTNAME}, 

Sea_{SCENARIO_SHORTNAME} 

OD 

vehicles by 

vehicle 

type 301-

321 and 

total for 

sea mode 

22 

{Scenario_

Dir} 

AIR_VHCLFLOW0_{S

CENARIO_SHORTNA

ME}.MAT 

AIR_{SCENARIO_SHORTNAME} OD 

vehicles by 

vehicle 

type 401 

and total 

for air 

mode 

1 

{Scenario_

Dir} 

ROAD_TON0_{SCEN

ARIO_SHORTNAME}.

MAT 

101_{SCENARIO_SHORTNAME}, … 

105_{SCENARIO_SHORTNAME}, 

Road_{SCENARIO_SHORTNAME} 

OD tonnes 

by vehicle 

type 101-

105 and 

total for 

road mode 

6 

{Scenario_

Dir} 

RAIL_TON0_{SCENA

RIO_SHORTNAME}.M

AT 

201_{SCENARIO_SHORTNAME}, 

202_{SCENARIO_SHORTNAME}, 

204_{SCENARIO_SHORTNAME}, … 

209_{SCENARIO_SHORTNAME}, 

Rail_{SCENARIO_SHORTNAME} 

OD tonnes 

by vehicle 

type 201, 

202, 204-

209 and 

total for 

mode rail 

9 

{Scenario_

Dir} 

SEA_TON0_{SCENAR

IO_SHORTNAME}.MA

T 

301_{SCENARIO_SHORTNAME}, … 

321_{SCENARIO_SHORTNAME}, 

Sea_{SCENARIO_SHORTNAME} 

OD tonnes 

by vehicle 

type 301-

321 and 

total for 

sea mode 

22 

{Scenario_

Dir} 

AIR_TON0_{SCENARI

O_SHORTNAME}.MA

AIR_{SCENARIO_SHORTNAME} OD tonnes 

by vehicle 

type 401 

1 
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Folder Name of matrix 

file 

Name of matrix Descripti

on 

Total 

of 

matric

es 

T and total 

for air 

mode 

{Scenario_

Dir} 

ROAD_EMP0_{SCEN

ARIO_SHORTNAME}.

MAT 

101_{SCENARIO_SHORTNAME}, … 

105_{SCENARIO_SHORTNAME}, 

Road_{SCENARIO_SHORTNAME} 

OD 

vehicles by 

vehicle 

type 101-

105 and 

total for 

road mode 

6 

{Scenario_

Dir} 

RAIL_EMP0_{SCENA

RIO_SHORTNAME}.M

AT 

201_{SCENARIO_SHORTNAME}, 

202_{SCENARIO_SHORTNAME}, 

204_{SCENARIO_SHORTNAME}, … 

209_{SCENARIO_SHORTNAME}, 

Rail_{SCENARIO_SHORTNAME} 

OD 

vehicles by 

vehicle 

type 201, 

202, 204-

209 and 

total for 

mode rail 

9 

{Scenario_

Dir} 

SEA_EMP0_{SCENAR

IO_SHORTNAME}.MA

T 

301_{SCENARIO_SHORTNAME}, … 

321_{SCENARIO_SHORTNAME}, 

Sea_{SCENARIO_SHORTNAME} 

OD 

vehicles by 

vehicle 

type 301-

321 and 

total for 

sea mode 

22 

{Scenario_

Dir} 

AIR_TON0_{SCENARI

O_SHORTNAME}.MA

T 

AIR_{SCENARIO_SHORTNAME} OD 

vehicles by 

vehicle 

type 401 

and total 

for air 

mode 

1 

Table 27 Matrix table with file structure for OD matrices for number of vehicles (loaded and 

empty) and tonnes. 

Potentially, as many as 2759 matrices with different level of aggregation could exist in the 

scenario folder. See Table 28 below which values to set in the keys in order to print out a specific 

matrix.  

 

Catalog key name  Choices 

available 

 Description Refer to 

matrix 

table 

Select commodities for the Logistics 

Module (for all commodities, select 0) 

   

 0 All commodities  
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 1-35, STAN 1-12 Single commodity or STAN group  

Do you want to export in CSV, DBF or 

GDB format?  

   

 CSV Comma Separated Values  

 DBF Database Format  

 GBD Geodatabase table  

Do you want to create a new 

geodatabase or use an existing one? 

   

 Create   

 Existing   

Define the gdb where export matrix:  An existing or new geodatabase, 

depending on choice for previous 

key 

Table 25 

 

What kind of matrix do you want to 

export? 

   

 COST LOS matrix Table 26 

 VHCLFLOW OD Vehicles matrix Table 27 

 TON OD Tonnes matrix Table 27 

 EMP OD Empty Vehicles matrix Table 27 

Which vehicle class do you want to 

select for the LOS matrices? 

 Vehicle type for the LOS matrices Table 26 

 101-105, 201, 202, 

204-209, 301-321, 

401 

Vehicle types  

What is the mode that you want for the 

matrices? 

 Mode for the LOS matrices Table 26 

 ROAD, RAIL, SEA, 

AIR 

  

Do you want the distance, time, 

domestic distance or extra cost LOS 

matrix? 

 Specification for the LOS matrix Table 26 

 Distance D101-D105, D201, …  

 Time T101-T105, T201, …  

 Domestic Distance DD101-DD105, DD201, …  

 Extra cost X101-X105, X201, …  

What type of vehicle class (or total) do 

you want for the VEHICLES and 

 Specification for the OD matrix Table 27 
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TONNES matrices? 

 101-105, 201, 202, 

204-209, 301-321 

Select a specific vehicle type  

 Road, Rail, Sea, Air  Select a mode  

Table 28 Choice order. 

Based on the choices made in the catalog keys described above, the Change matrix format 

application creates a CSV or DBF file, or a table inside an existing or a new geodatabase, with 

the structure Origin zone, Destination zone and matrix value. The matrix file is found in the 

scenario folder and will have a name that gives the specifications made in the catalog keys, e.g.: 

{Scenario_DIR}\COST_RAIL_DD202_VOY.CSV  

Where the first part (COST) defines the type of matrix (COST, VHCLFLOW, TONNES or 

EMPTYVEHICLEFLOW), the second part (RAIL) the mode (RAIL, ROAD, SEA or AIR), the third 

part (DD) the type of matrix for the LOS matrices (DD, D, T or X), the fourth part (202) the vehicle 

type and the fifth part gives whether the user is an Emme or a Voyager user.
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4. General instructions 

This chapter gives instructions for how to start using the Samgods GUI. Please note that the 

procedure is described for Standard user or Advanced user mode since the available parameter 

settings are different if developer mode is used.  

4.1.  Open the model 

 Open Cube by clicking on the icon on the desktop 

 On the Welcome Screen select “Open catalog” 

 Browse to Samgods catalog (file name: Samgods.cat – default folder C:\Samgods) 

 Click on “Open” 

4.2.  Set the model to Standard user or Advanced user mode 

 Select “Properties” on the menu bar under section “scenario (see Figure 22) 

 In the Catalog Properties window, select the “Model User” tab (see Figure 23) 

 Select “Model user" to "Model Applier" mode 

 Select "Current Applier Group" among "Developer", "Standard User" or "Advanced User" 

 

Figure 22 How to access “Catalog Properties”. 
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Figure 23 How to set the model to Model Applier>Standard user mode. 

 

 

Figure 24 How to save catalog file using icon. 

 

Tip: Each time changes have been made to the catalog, such as creating a new scenario, 

creating new output data by running the model or deleting data, the catalog should be saved. 

This is done by clicking the “save catalog” icon (see Figure 24) or going to “File” menu and 

choosing “Save” -> “Catalog” (see Figure 25). It is recommended to do this often when working 

with the model. 
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Figure 25 How to save the catalog file using the menu bar. 

4.3.  General guidelines for how to work with the model 

After having opened the model and set it to Standard User mode, the user can start working with 

the model. Instructions for each specific action can be found in the chapter 5. However, it is 

necessary to also know which actions that should be taken  and what to look for in the manual. 

This section gives some guidelines for the order of doing different things. 

Working with the model is done by using the different applications and via the Data Section 

window. In order to use an application for a specific scenario: 

 Double-click on the scenario name in the Scenarios window and select the application in 

the window that opens 

 When using the Data Section window, select the scenario you want to work within the 

Scenarios window by clicking on it and then open the file you want to use from the Data 

Section window 

In order to work with the input data, i.e. to set up a scenario, the input data must be made 

editable. This is done by: 

 Running the Create the editable files application, see Section 4.5 for instructions. This 

must be done also if you just want to view the input data and it is mandatory to run the 

application at least once for every scenario you want to use in the model 

 When the editable data has been created, it could be edited according to the instructions 

in Chapter 5 (for example). This is done by using the Edit the data application. Via the 

application, the editable data can be accessed (see Section 4.5 for instructions). An 

alternative to use Edit the data application to access the editable data, is to use the Data 

Section window 

 When all edits to the input data have been made, the edits must be saved before running 

the actual Samgods model. This is done by running the Edit the data application (until 

this point the application has only been used to access the editable data, but it has not 

been run). For a locked scenario, such as the base scenario, no edits can be saved. 

However, the application can still be used to view the data 
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At this point the Samgods model can be executed, by running the Samgods Model application 

(see Section 4.6). By doing that, the output data is produced and can be compared or exported 

according to the instructions in the following chapters. 

Different sets of output could be produced for different runs for the same scenario, for example if 

the model is run for two different commodity groups for the Standard Logistics module. In order 

to run the same scenario for different commodities, first run the Create the editable files 

application and then Edit the data as described above (the Edit the data application doesn’t have 

to be run for a locked scenario as e.g. the Base2006 scenario). Then select the commodity group 

and run the Samgods Model application. After this another commodity can be selected and the 

Samgods Model can be run again. The different sets of outputs will be saved separately. 

In the scenario folder (under Scenario_Tree, see Table 1), the name of the specific output 

database is OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group. In the 

interface, just one set of output for one scenario can be accessible at the time. In order to access 

a specific set of output, double-click on the specific scenario, select the Samgods Model 

application and select the specific commodity group in the catalog key “Select commodities for 

the Logistics Module (…)”. Click “Save” (not “Run”). In this way the correct set of output is 

activated and can be accessed from the Data Section window. The scenario selected under 

scenario window always filter the data shown under data panel. This is a peculiar characteristic 

of Cube and catalog file. All the logical relations are maintained in a coherent frame. The 

selection of a particular scenario will specify the values of catalog keys, the folder where results 

will be saved, and the data will be shown under data panel. 

Whenever a scenario has been deleted or several runs have been made, the geodatabase files 

should be compressed in order to save disk space – see Section 4.9 for instructions. When 

working with the model and making changes to the catalog, such as adding a scenario or making 

changes to the geodatabase, it is recommended to save the catalog often. This is done by 

clicking the save button (the black floppy disk icon above the Scenarios window. 

An exception is the output for Rail Capacity Management, since it can be run only with all the 

commodities (X=0 always) and its results will be always produced in 

Output0_{SCENARIO_SHORTNAME}.mdb. 

 

4.4. Create a new scenario 

To create a new scenario it is necessary to copy the scenario specific tables from another 

scenario, then merge the scenario specific tables with the base tables and finally visualize them 

in the graphical interface. To create a new scenario, do the following:  

1) In the first step, create the scenario name in the catalog: 

a) In the Scenarios window, right-click on “Scenario_Tree” and select “Add Child” 

b) Type the scenario name (it is neither allowed to use blank entries or to start with 

a number, nor to start with the following letters n f t) and press “Enter” 

c) In the Scenario Properties window, which then is opened, set a scenario code 

(or use the default one) and click “OK”. It is recommended to use a short code 

that can be associated with the scenario name 

d) The Scenario manager window is opened automatically 

2) In the second step, run the Create the editable files application as described below: 

a) In the Scenario manager window, select the Create the editable files in the 

Application scroll down menu 
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b) Define from which scenario to copy the scenario specific tables from (e.g., 

Base2006) by typing the scenario name in the catalog key ”Which scenario do 

you want to use? (Default is Base2006)” 

c) Click “Run” 

d) At the end of the run, click “OK” 
The temporary geodatabase is now available in the scenario folder (located in the Scenario_Tree 

folder, see Table 1 in Section 1.5) with all the scenario data. To visualize the tables and the 

layers of the scenario, change the application from Create the editable files to Edit the data in the 

Scenario manager window. In Figure 29, Figure 30 and Figure 31 the default values of the 

catalog keys are displayed. The first set of catalog keys (

 

Figure 29) lists the scenario parameters and each catalog key has an editing box (a box where a 

numerical value or label is expected), a scroll down menu, or a check box. 

 

Figure 26 Catalog keys in first window for Edit the data application 
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The second set of catalog keys (Figure 30, accessed by clicking “”Next…” in the window in 

 

Figure 29) consists of tables and layers of scenario data. By clicking the “Edit...” button on the 

right, the data is opened in the correct format (i.e., a table in a database window or a layer in a 

GIS window). Descriptions of the keys and of how to use them for editing and displaying the data 

are given in Section 3.4. 

 

Figure 27 Catalog keys in second window for Edit the data application 
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Figure 28 Catalog keys in third window for Edit the data application 

 

3) Set the catalog keys according to the instructions in Section 3.4 and edit the data. For 

instructions on how to edit the scenario data, see Chapter 5. 

4) To save the edits that have been made in the temporary geodatabase, the Edit the data 

application must be run. During this phase the scenario specific tables will be created 

and saved into the main geodatabase. Also, the report file “Report for the edit phase” 

with information or errors from running the Edit the data application will be created in 

Scenario Outputs\Edit the data Report in the Data Section window. 

a) Click “Run” 

b) During the execution, the program will prompt with the question: “Do you really 

want to save the scenario {SCENARIO_SHORTNAME}?”. If “No” is selected, the 

temporary geodatabase will be deleted. No changes will then be made to the 

main geodatabase. If “Yes” is selected, the scenario specific tables will be saved 

into the main geodatabase. Whether the temporary geodatabase is deleted or 

not depends on the choice made for the catalog key “Do you want delete the 

temporary geodatabase?” 

c) At the end of the run, click “OK” 

d) Close the Scenario Manager window. To the question “Do you want to create the 

scenario {SCENARIO_SHORTNAME}?”, click “Yes” 

Tip: To visualize all the layers in a map, click the “Edit...” button, next to the ArcMap GIS Project 

File catalog, key shown in Figure 30, pointing at the file Input_Data.mxd. All the geographical 

data will be loaded with a few default legends. The same file is available via Scenario 

Inputs\Editable Data\ Input_Data.mxd in the Data Section window. 

Tip: Information on errors or results from running the Edit the data application is available in 

Scenario Outputs\Edit the data Report\Report for the edit phase in the Data Section window. 

For information on this and other log reports, please refer to Chapter 7. It is recommended to 

consult the reports to make sure no errors have occurred in the input data. 
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When changes have been made to the catalog, such as adding a new scenario, the catalog file 

should be saved. This is done by clicking the black floppy disk icon to the left above the catalog 

in the interface.

4.5. Visualize and/or edit an existing scenario 

In terms of the general structure and terminology of the Samgods GUI, an existing scenario 

means that the scenario specific tables are already included in the main geodatabase. To 

visualize the data, the scenario-specific tables must be merged with the base scenario tables, 

and the appropriate layer (or feature class) for the data that is graphically represented in a map 

needs to be created. A layer can be described as the visual representation of a geographic 

dataset in any digital map environment. More information on the layers is given in Section 5. We 

have already introduced how the applications Create the editable files and Edit the data work 

together to guarantee consistence and coherence in the input data (see Sections 3.3 and 3.4). 

Please note that it is not allowed to rename a scenario, due to the way input and output data 

are handled in the model. 

There are two possible statuses of a scenario (see Section 3.4 for further explanation): 

 The scenario is still editable (the key “Do you want to lock the scenario from further 

editing?” in Edit the data was set to “No” when Edit the data was run and the scenario 

was saved) 

 The scenario is locked, either because it is the base scenario or because the user has 

locked it (the key “Do you want to lock the scenario from further editing?” was set to 

“Yes” when the scenario was saved by the Edit the data application) 

4.5.1.  Editable Scenario 

To visualize and edit an existing scenario, two steps must be performed.  

First, the Create the editable files application should be run: 

1) Double-click on the scenario name in the Scenarios window 

2) To the right, the Scenario manager window appears 

3) In the Application scroll down menu, select Create the editable files (by default this 

application is selected) 

4) Click “Run” 

5) Click “OK” at the end of the run 
After the run, the temporary geodatabase is available in the scenario folder (located in the 

Scenario_Tree folder, see Table 1 in Section 1.5) containing all scenario data. To visualize the 

tables and the layers of the scenario, switch the application from Create the editable files to Edit 

the data in the Application scroll down menu in the Scenario manager window. The Scenario 
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manager window will then look as in 

 

Figure 29 and Figure 30. 
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Figure 29 The first set of catalog keys for the Edit the data application. 

The first set of catalog keys (

 

Figure 29) lists the scenario parameters and each catalog key has an editing box (a box where a 

numerical value or label is expected), a scroll down menu, or a check box. The second set of 
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catalog keys (Figure 30, accessed by clicking “Next…” in the window in 

 

Figure 29) consists of tables and layers of scenario data. By clicking the “Edit...” button on the 

right, the data is opened in the correct format (i.e., a table in a database window or a layer in a 

GIS window). Another way to access the data is to use the Data Section window, where the 

scenario data can be found in the folder Scenario Inputs\Editable data. 

 

 

 

Figure 30 The second set of catalog keys for the Edit the data application. 

The second step to edit an existing scenario is to save the scenario data into the main 

geodatabase. This is done by running the Edit the data application. During this phase, the 

scenario specific tables are created and saved into the main geodatabase. Also, the report file 

Tip: To visualize all the layers in a map, use the first catalog key (“ArcMap GIS Project File”) 

shown in Figure 30, pointing at the Input_Data.mxd file. Click the “Edit…” button and all the 

geographical data will be loaded with only a few default legends. The same file is also available 

via the Data Section window, in Scenario Inputs\Editable Data\ Input_Data.mxd. 
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“Report for the edit phase” is created in the folder Scenario Outputs\Edit the data, which is found 

in the Data Section window. 
If the scenario still should be editable, select “No” in the first catalog key (first group of catalog 

keys, 

 

6) Figure 29) (to lock the scenario, select “Yes) 

7) Select whether the temporary geodatabase should be deleted or not in the scenario 

folder 

8) Make any edits in the scenario data (see Chapter 5 for instructions) 

9) Click “Run” 

During the execution, the program will prompt with the question: “Do you really want to save the 

scenario {SCENARIO_SHORTNAME}?”. If “No” is selected, the temporary geodatabase will be 

deleted.  No edits will then be saved into the main geodatabase. If “Yes” is selected, the scenario 

specific tables will be saved into the main geodatabase. Whether the temporary geodatabase is 

deleted or not depends on the choice made for the catalog key “Do you want delete the 

temporary geodatabase?”. 

10) At the end of the run, click “OK” and close the Scenario Manager window.  

 

4.5.2.  Locked Scenario 

For a locked scenario, the first step (i.e., running the Create the editable files application and 

visualizing the data using the Edit the data application) is exactly the same as for an editable 

scenario. It is sufficient to run the Create the editable files application once and leave the 

temporary geodatabase in the scenario folder so that it is accessible each time the user wants to 

display the input data. It is only necessary to run the Edit the data application if the temporary 

geodatabase should be deleted. 

Tip: In the log report in Scenario Outputs\Edit the data Report\Report for the edit phase in the 

Data Section window, information is given on any errors or on the results of the process during 

the execution of the Edit the data application. For information on this and other log reports, 

please refer to Chapter 0. It is recommended to consult these reports to make sure no input data 

errors have occurred. 
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4.6.  Run the Samgods model 

The different ways to run the Samgods model are described in Sections 3.5 and Section 5. The 

following paragraph describes the procedure to run the Samgods model as a Standard user.  

1) Open the scenario that you want to run by double clicking on it in the Scenarios window. 

The Create the editable files application as well as the Edit the data application must be 

run before running the Samgods model, otherwise the error message ReturnCode=2 will 

be shown. Please refer to Section 4.5 for an explanation on how this should be done 

2) Select the Samgods Model application in the Application scroll down menu. The catalog 

key "Number of zones in network" has shown, its value should be consistent with the 

input network and its value should be modified in Edit the data 

3) Under “Run Selections”, make appropriate selections for the keys below:  

a) “Run only one step, or run all steps”; choices: All (full run), LOS Calculation, 

Logistics Module, Assignment, Reports, Standard LogMod, Rail Capacity 

Management 

b) "Year of PWC matrices", choices: 2006, 2030 or 2030BnM 

c) “Select the mode for the LOS Calculation and Assignment steps”; choices: All, 

Road, Rail, Sea, Air (Choice available only for LOS Calculation, Assignment, 

Reports) 

d) “Select commodities for the Logistics Module”; choices: 0 for all the commodities 

or the commodity number for a specific commodity (1-35, or STAN1-STAN12) 

(Choice available only for Logistics Module, Assignment, Reports) 

4) Under “Other options”, make appropriate selections for the keys below: 

a) “Do you want to save the LOS matrices?”; tick if you want to save the LOS 

matrices 

b) For the key “Do you want to produce buildchainxx.log files?”, choose whether to 

produce the log files from the Buildchain program, containing any warnings from 

the execution 

5) Under “Logistics Module settings – advanced”, make appropriate selections for the keys 

below: 

a) “Do you want to run the Logistics Module on several processors?”; tick “Yes” or 

“No” 

b) “How many processors would you like to run simultaneously?”; indicate 1-16 

processors 

c) “Scaling factor for outputs”, select “Thousands”, “Millions” or “Billions”. 

6) Under “Stop points – settings”, make appropriate selections for the keys below: 

a) “Do you want to pause the run waiting for your action on steps LOS, 

Logmod,LP0,LP1,L1b?" tick “Yes” or “No” 

b) “Step completion:” represents witch event will prompt the user when reach the 

completion of Logmod, LP0, etc. Choices are Sound (play a music), Email 

(sending an email at the email address specified via key " Insert the email 

address for status on run:", Both or None 

7) Under “Rail Capacity Management – settings”, make appropriate selections for the keys 

below: 
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a) “Cut off criteria for RCM process (will consider links with V/C > XX% where XX is 

the value defined)": provide a number between 50 and 80. In setting up the 

linear programming problem all links with V/C equals or above this number (that 

is expressed as percentage, e.g. 50%) will be enter in the problem. 

Recommendable numbers are in the below range, default value is 50 

b) “Options to save output files from RCM process:”, each LP or AdjustLP produces 

a full set of files (see document listed in Section 10.7 ) that could be saved in 

specific folders under LogMod. This catalog key will control the option to save all 

the performed loops or just the last one 

c) "Maximum number of loops for Linear Programming process (LP)": number of 

LP loops the user would like to perform. Provide an integer value between 0 and 

9. 0 will perform only LP0, The LogMod process will produce the best solutions 

and the suboptimal solutions (in terms of transport chains), the number of 

suboptimal solutions is controlled by the catalog key " Number of transport chain 

solutions for the Logistics Module". It is recommended to not change these 

settings and leave the default value 

d) "Maximum number of loops for Adjust Capacity Procedure": number of Adjust 

Capacity Procedure to perform. A value among 0 and 100 could be selected. 0 

means that the process will be skipped. Strong runtime implications suggest to 

use a conservative value from 1 to 3. Please note that with the setting of empty 

rail flow OD construction in December 2014 not allowing asymmetric empty flow 

generation, this procedure will not be required unless the LP model solution is 

infeasible. 

8) Click “Run” 

9) A message window appears that informs whether the scenario is locked or still editable –

click “OK” 

10) At the end of the run, the message window ”Task Run Result” indicates that “VOYAGER 

Run of Application Samgods Model, 01 is complete” (or a corresponding message for the 

Emme user). Click “OK”. 

 

 

 

4.7.  Compare scenarios 

The comparison of outputs from running scenarios is always made between the current scenario 

and an alternative scenario. The comparison encompass the following results: 

Tip: Each time changes have been made to the catalog, such as creating a new scenario, 

creating new output data by running the model or deleting data, the catalog should be saved. 

This is done by clicking the save icon (the black floppy disk above the Scenarios window). It 

is recommended to do this often when working with the model. 

Tip: The run time for the Samgods model varies depending on the selected options. If a full 

run with all commodities and modes is selected together the RCM, it may be appropriate to 

use multiple processors to reduce the run time.  

In the current model version the program used to solve the Linear Programming Problem 

can use only a single processor. Therefore this is the only part that will not have any benefit.  
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1. differences in LOS matrices (dist, ddist, time and extracost) for all modes and vehicle 

types 

2. differences in OD tonnes, empty and loaded vehicles for all modes and vehicle types for 

STD 

3. differences in tonne flows per mode rail, road and sea  for STD and RCM 

4. differences in vehicle flows in terms per mode rail, road and sea for STD and RCM 

 

The Samgods Model application must be run for the specific commodity or commodity group 

(STAN group or all commodities) for both the current scenario and the scenario selected for 

comparison before it is possible to compare the outputs. To run the Compare scenarios 

application, do the following: 

1) Select the Compare Scenarios application in the Applications window 

2) In the Scenarios window, open the scenario that you want to compare to the base 

scenario by double clicking on it 

3) Select the commodity class that you want to compare. It is mandatory to select a 

commodity class (0 for all commodities, a STAN number for a specific STAN group or 

the commodity number (1-35) for a specific commodity) 

4) Select what you want to compare. The alternatives are LOS matrices, Logistics Module, 

Assignment or all of them 

5) Update "Scenario's name to use in comparison:" catalog key with the name you want to 

use in the comparison against the current scenario 

6) Update "Scenario folder for comparison:" giving information of folder and geodatabase 

name containing the scenario you want to compare 

7) Click “Run”. At the end of the run, click “OK”. 

The results from the comparison between scenarios are saved in their corresponding scenario 

folders, with the commodity class number indicated in the file name. The .MAT files for the OD 

matrices from the Logistics Module and LOS matrices will be saved directly in the scenario 

folder, while the networks from the Assignment step will be saved inside the output 

geodatabases. All output can be visualized from the Data section window, in Scenario 

Outputs\Compare (see Table 2). 

An example of values for the different catalog keys is shown in the following picture: 

 

Figure 31 Catalog key values example. 

 

4.8.  Delete a scenario 

Please note: It is the user’s responsibility to control whether the outputs to compare exist in the 

scenario folder. Control this in Scenario Outputs\Samgods Report\Existing Outputs in the Data 

Section window, for the base scenario and for the scenario that is selected for the comparison. If 

one or more outputs are missing, the run will be terminated with return code 2. 
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Deleting a scenario requires two steps in different windows. 

1) First step: Scenario manager window 

a) Select the scenario that you want to delete in the Scenarios window 

b) Double click on the scenario name. In the Scenario manager window, select the 

Handling scenario application 

c) Under the “Handling scenario” catalog key group, tick the catalog key “Do you 

want to delete the current scenario?” 

d) Disable all the other catalog keys in the catalog key group “Handling Scenario” 

(“Do you want to compact the geodatabase files?” – disable, “Select how you 

want to use the export function” – (3) Do Nothing, “Do you want to control the 

imported scenario?” – No) 

e) Because of software settings, all catalog keys must be set. However, the key 

“Where do you want to export the model (1) or scenario (2)?” will not be used in 

this case. A random character could be typed in 

f) Click “Run” 

g) During the execution, a warning window will prompt: ”Do you really want to 

delete the scenario {SCENARIO_SHORTNAME}?”. Selecting “No” means that 

the scenario will not be deleted. If “Yes” is selected, the scenario will be deleted 

h) At the end of the run, click “OK” 

i) Close the Scenario manager window by clicking “Close” 

2) Second step: Scenarios window 

a) Right-click on the scenario name in the Scenarios window and select ”Delete” 

b) To the question “Ok to delete the data directories for this scenario and its 

children?”, click “Yes”; 

c) Run the Compact function, see Section 4.9 below. 

3) Save the catalog by clicking on the saving icon (black floppy disk, above the Scenarios 

window) 

 

Please note: If the scenario is in read-only mode (i.e., the scenario is locked), this step will have 

no effects on the scenario regarding the scenario specific tables. The scenario specific tables will 

remain in the main geodatabase. 

4.9. Compress the geodatabase files 

The Compact function compresses the files and deletes all the temporary edits stored in the 

geodatabase. Data that has been deleted previously are permanently deleted when the Compact 

function is run. This reduces the size of the geodatabase and cleans among the files that are 

stored in the geodatabase by only keeping the necessary data. Running the Compact function is 

required every time that a scenario is deleted or when several runs have been made, and it will 

influence: 

 The main geodatabase containing all the input data (i.e., Input_data.mdb) 

 The geodatabase containing all the outputs of a specific scenario in the scenario folder 

(i.e. OutputX_{SCENARIO_SHORTNAME}.mdb, where X is the commodity group – 0, 1-

35 or a STAN group). 
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The choice to compact a specific output geodatabase is only related to the selected scenario. 

However, when the Compact function is employed, the input data (main geodatabase, 

Input_data.mdb) will also be compacted. Run the Compact function in the following way: 

1) In the Scenarios window, double click on the scenario that you want to compact 

2) In the Scenario manager window, select the Handling scenario application 

3) Under “Run Selections” (catalog key “Select commodities for the Logistics Module (…)”), 

set the commodity or commodity group corresponding to the set of output that you want 

to compact 

4) Under the “Handling scenario” catalog key group, tick the catalog key “Do you want to 

compact the geodatabase files?” 

5) Disable all the other catalog keys in the “Handling scenario” catalog key group (Do you 

want to delete the current scenario? – disable, “Select how you want to use the export 

function” – (3) Do Nothing, “Do you want to check the imported scenario?” – No) 

6) Because of software settings, all catalog keys must be set. However, the key “Where do 

you want to export the model (1) or scenario (2)?” will not be used in this case. A random 

character could be typed in 

7) Click “Run” 

8) At the end of the run, click “OK” 

 

 

 

4.10. Export and import a catalog 

The Scenario Export function can be used to export a catalog into a new catalog, including a 

scenario that will be the base scenario in the new catalog. It can also be used to export a single 

scenario into an existing catalog – see the next chapter. 

To export the entire catalog into a new catalog directory and create a new base scenario, the 

following is required: 

1) In the Scenarios window, double click on the scenario that you want to use as the base 

scenario in the new catalog 

2) In the Scenario manager window, select the Handling scenario application 

3) For the catalog key “Select how you want to use the export function?”, select “(1) Do you 

want to export the model into a new folder using the current scenario as base?” 

4) Disable the other catalog keys in the “Handling scenario” catalog key group (“Do you 

want to delete the current scenario?” – disable, “Do you want to compact the 

geodatabase files?” – disable, “Do you want to control the imported scenario?” – No) 

5) To set the value for the catalog key “Where do you want to export the model (1) or 

scenario (2)?”, type in the destination folder in the editing box 

6) To set the value for the catalog key “Name of the base scenario in the new model (1), 

(2)”, type in the new name you want to use for the current scenario, when it has been 

exported as the base scenario in the new catalog, in the editing box 

7) Click “Run” 

8) At the end of the run, click “OK” 

Tip: Run the Compact function every time a scenario is deleted or several runs have been made, 

to reduce the amount of data stored in the geodatabase. 
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Please note: A new folder has to be defined for the Scenario export function. If the destination 

catalog already exists, the user will be informed by a prompt saying “The model already exists”; 

“This might be an error. The process will be terminated. Check the folder”. In the Samgods GUI, 

it is never possible to overwrite an existing catalog. 

To complete the export of a catalog properly by controlling that the scenario parameters in the 

new catalog correspond to the imported ones, the Scenario Import function must be run. The 

required actions are: 

1) Close the old catalog by clicking on the x 

2) Open the new catalog created during the export 

3) Update the paths for the applications as described in Section 1.5 and run the Installation 

application (type in the new base scenario name according to the name specified in the 

Scenario Export function in the corresponding catalog key; please refer to Section 1.5 for 

further instructions) 

4) The Scenario_Tree in the Scenarios window in the new catalog only contains one 

scenario, which has the name “Rename”. It should be renamed to the name that was 

specified when running the Scenario Export function. This is done by right-clicking on the 

scenario name and selecting “Rename”. The code should also be updated, which is 

done by right-clicking and selecting “Properties”. Define a short code that is similar to the 

scenario name 

5) In the Applications window, select Handling scenario and then double click on the new 

scenario in the Scenarios window. Tick the catalog key “Do you want to check the 

imported scenario?” under the “Handling scenario” catalog key group 

6) Disable all other catalog keys in the “Handling scenario” catalog key group (“Do you want 

to delete the current scenario?” – disable, “Do you want to compact the geodatabase 

files?” – disable, “Select how you want to use the export function”  – (3) Do nothing) 

7) Because of software settings, all catalog keys must be set. However, the key “Where do 

you want to export the model (1) or scenario (2)?” will not be used in this case. A random 

character could be typed in 

8) Click “Run” 

9) At the end of the run, click “OK” 

10) Check the report in Scenario Outputs\Scenario_Import_function_Report\Report for 

the Import Phase in the Data Section window 

11) If any scenario parameters need to be changed according to the report, change those 

catalog key values for the imported scenario, under “Scenario Parameters” in the 

Handling scenario application and run the application again. Check the report again and 

repeat if necessary. 

4.11. Export and import a scenario 

To export a scenario into an existing catalog already containing a base scenario, the following 

actions are required: 

Tip: Each time changes have been made to the catalog, such as creating a new scenario, 

creating new output data by running the model or deleting data, the catalog should be saved. 

This is done by clicking the save icon (the black floppy disk above the Scenarios window). It 

is recommended to do this often when working with the model. 
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1) In the Scenarios window, double click on the scenario that you want to export. In the 

Applications scroll down menu in the Scenario manager window, select the Handling 

scenario application 

2) For the catalog key “Select how you want to use the export function?”, select “(2) Do you 

want to export the current scenario into another model?” 

3) Disable the other catalog keys in the “Handling scenario” catalog key group (“Do you 

want to delete the current scenario?” – disable, “Do you want to compact the 

geodatabase files?” – disable, “Do you want control the imported scenario?” – No) 

4) To set the value for the catalog key “Where do you want to export the model (1) or 

scenario (2)?”, type in the path of the folder where the .cat file for the new catalog is 

located, in the editing box 

5) In the field for the catalog key “Name of the base scenario in the new model (1), (2)”, 

type in the name of the base scenario in the destination catalog; 

6) Click “Run” 

7) At the end of the run, click “OK” 

 

Please note: The exported scenario will have the same scenario name in the new catalog as in 

the catalog that it was exported from. 

 

To complete the export of a scenario properly by controlling that the imported catalog key values 

correspond to the ones in the new catalog, the Scenario Import function must be run. The 

required actions are: 

1) Close the catalog from where the scenario was exported (i.e., the one that is open) by 

clicking on the x 

2) Open the catalog to where the scenario has been exported 

3) Create a new scenario, with the same name as set in the export phase, in the catalog 

(right-click on Scenario_Tree in the Scenarios window and select “Add child”, type in the 

name and press Enter. Define the scenario code and click “OK”) 

4) In the Scenario Manager window, select the Handling scenario application in the 

Scenario manager window. Tick the catalog key “Do you want to control the imported 

scenario?” under the “Handling scenario” catalog key group 

5) Disable all other catalog keys in the “Handling scenario” catalog key group (“Do you want 

to delete the current scenario?” – disable, “Do you want to compact the geodatabase 

files?” – disable, “Select how you want to use the export function” – (3) Do nothing) 

6) Because of software settings, all catalog keys must be set. However, the key “Where do 

you want to export the model (1) or scenario (2)?” will not be used in this case. A random 

character could be typed in 

7) Click “Run” 

8) At the end of the run, click “OK” 

9) Control the report Scenario Outputs\Scenario_Import_function_Report\Report for 

the Import Phase in the Data Section window to see if any edits are necessary 

10) Change any catalog key values listed in the report for the imported scenario, under 

“Scenario Parameters” in the Handling scenario application and run the application 

again. Check the report again and repeat if necessary 
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4.12. Produce PWC Matrices in Voyager format 

To produce the PWC matrices in Voyager format, do the following: 

1) Double click on a scenario (it does not matter which scenario) in the Scenarios window 

and select the PWC_Matrices application in the Scenario manager window 

2) Select the year you want to convert in Voyager format among 2006, 2030 or 2030BnM 

using " Year of PWC matrices" catalog key 

3) Click ”Run” 

4) At the end of the run, click “OK” 

The matrices are now available in the folder 01_Programs\LogMod\Input\PWC\{Year}\VY_F\, 

found in the Samgods folder (see Table 1 in Section 1.5). In order to display the matrices for a 

commodity via the Data Section window, do the following: 

1) Double click on a scenario (it does not matter which scenario) in the Scenarios window 

and select the Samgods Model application in the Scenario manager window; 

2) Select a commodity using the catalog key “Select commodities for the Logistics Module 

(…)”. Only the numbers 1-35 are allowed here (not 0 for all commodities or any STAN 

group); 

3) Click “Save” to save the settings; 

4) The matrices for the selected commodity are now available in the Data Section window, 

in Scenario Inputs\PWC_Matrices\PWC matrix for commodity.

4.13.  Change matrix format 

To export a matrix in CSV or DBF format, or as a table in a geodatabase (GDB format): 

1) In the Scenarios window, double click on the scenario corresponding to the matrix you 

want to export 

2) In the Scenario manager window, select the Change matrix format application and make 

appropriate selections for the desired matrix (see the details in Section 1.1) 

3) Click “Run” 

4) At the end of the run, click “OK” 

The output is found in the scenario folder with a CSV or DBF extension or as a table inside a 

geodatabase, depending on the selections made. 

4.14. Visualize the outputs 

In the Data Section window, the results that are produced in all steps are available. Please refer 

to Section 2.3 for details. 

4.15. General information on the GIS Window 

The ArcMap GIS Project file (Input_data.mxd) is opened from the Data Section window by 

opening the folder Scenario Inputs\Editable data and double-clicking on the .mxd file. The .mxd 

file can also be visualized from the Edit the data application, by opening the scenario, clicking the 

Tip: Each time changes have been made to the catalog, such as creating a new scenario, 

creating new output data by running the model or deleting data, the catalog should be saved. 

This is done by clicking the save icon (the black floppy disk above the Scenarios window). It 

is recommended to do this often when working with the model. 
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“Next…” button to reach the second set of catalog keys and finally clicking the “Edit…” button for 

the ArcMap GIS Project File key. The map document (.mxd) contains the following information: 

1) Details of all input data that can be visualized in a map (data with [Geodata] label) with 

the following layers (where the default values are indicated in parenthesis): 

a) Frequency_network (disabled) (i.e., frequencies of services between terminals, 

for more information on this network, see the appendix section 11.3) 

b) Nodes_commodities (disabled) (i.e., which commodities that can be handled at 

the terminals) 

c) Nodes (disabled) 

d) Ports_swe (disabled) 

e) Network – Link and Node layer (active) 

f) Samgods_zones (active). 
A set of default legends () for the node and the link attributes for the layers: 

a) Nodes_commodities: Type of terminal 

(1) Nodes: Type of terminal 

(2) Port area 

b) Ports_swe: Swedish Ports 

c) Network: 

i. Network_Node:  
 



Scenario setup -  

General information on the GIS Window 

 

111 
 

 

Figure 32 Enable the layer and select the set of legends as in the figure. Example of default 

legends, for the Network_Node layer. 

 

Legends 

Click here to enable/disable legends 
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Figure 33 The Table of contents. 

 

2) For the network node and link layers, a set of filter conditions to switch on/off specific 

modes are also available. To enable/disable the filters, right-click on the node/link layer 

in the TOC and select “Properties”. In the scroll down menu “Selection Group”, select the 

desired group and then tick the “Active” check box to activate the option. The filters are 

by default set as in the last session, which means that a filter can be active even if no 

check boxes are ticked. To be sure to turn all filters off, tick and then un-tick an “Active” 

check box. The available groups for the network node layer are:  

a) Road Network 

b) Rail Network 

c) Sea Network 

d) Ferry Network 

e) Air Network 

f) Zones 

The same groups are available for the link layer, except the last one. The advantages of 

enabling a filter are the possibilities to: 

 visualize only the selected entities 

 select and edit only the visualized entities (and thereby avoid selecting the 

wrong links) 
The best way of using these filters is in conjunction with the default legends: First activate the 

desired filter(s) for the layer(s) you want to work with and then enable and/or edit the 

corresponding set(s) of default legends using the icons shown in Figure 27. 

The layers ticked in the TOC are the ones that are visualized in the GIS window. A layer is 

selected by clicking on it in the TOC. By selecting Datasets -> Set Selectable Layers… it is 

possible to set which layers that allow selecting elements. E.g., if the Samgods_zones layer is 

selected in the TOC but not set as selectable, the zones are shown in the GIS map but cannot 

be selected with the Select features tool (see below). The default is that all layers are selectable. 

When editing the GIS data, the layer containing the data that is edited must be selected in the 

“Layers” drop down menu in the Editor toolbar (see below).  

Table of contents 
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Each layer has an attribute table, which is accessed by right-clicking on the specific layer in the 

TOC. In the attribute table it is possible to view the attributes of each layer, but not to edit any 

values. Any edits must be made in the Feature Explorer window (or using the Compute function) 

and in Edit mode (see below for explanations). 

More information on the GIS window can be found in the help section, accessed from the main 

toolbar: Help -> Cube Help -> Cube Base -> GIS Window. 

4.15.1. Tools in the GIS window 

To select/edit/modify the layers, the following tools are available from the interface: 

 Select elements, (fixed) zoom in/out in the map, pan, full extent, refresh view, select 

features: 

      

 Select/view elements via SQL queries based on the attributes in the layers: On the menu 

bar, select Datasets -> Select by Attributes… and type an SQL syntax, for example all 

railway nodes in the Stockholm region, in a node layer: 

 

 The Editor toolbar, which is used when editing the network: 

 

 Add/remove attributes in the layer’s table (node or link table) by selecting Node (or Link)  

-> Attribute -> Add/Delete on the menu bar; 

 Visualize the attributes for a specific selected element – after an element has been 

selected using the “Select Features” tool (see first bullet above), the attributes will be 

displayed in the Feature Explorer window, see Figure 34. In the Edit mode, it is also 

possible to edit and save the new values directly in the Feature Explorer window. To 

change to Edit mode, click on Editor -> Start Editing on the Editor toolbar; 
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Figure 34 Feature Explorer window 

 Modify values based on a condition. Under Link or Node (depends on the type of layer) 

on the menu bar, the “Compute” option is available when the session is in Edit mode. By 

selecting “Compute”, access is given to the Feature Class Attribute Calculation window, 

shown in Figure 35. In this window, it is possible to edit the values and apply a condition 

(in the example in Figure 35, the capacities for all ports in the Lysekil region are updated, 

more details on this specific example can be found in Section 5.7).  

 

 

Figure 35 The Feature Class Attribute Calculation window. 

4.15.2. Attributes available in the node and link layers 

It is possible to select an element in a node layer using the following attributes: 

 ID_COUNTRY; 

 ID_REGION (primary key if used in combination with ID_COUNTRY). A list of the 

country and region codes can be found in the Data Section window, under Scenario 

Inputs\General tables\Zoning System; 

 MODE_N (1 – Road terminal, 2 – Rail terminal, 3 – Port, 4 – Ferry terminal, 5 – Airport). 

For example, to select all the nodes in a region, the user only needs to select the layer in the 

TOC and then specify the ID_REGION attribute using Datasets -> Select by attribute… on the 

main toolbar: 
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Figure 36 Select by attribute tool 

 

To view all attributes possible to select, right-click in the blank field in the Select Specification 

window.  

For the network link layer the attribute corresponding to MODE_N is MODE_L. To select all the 

links in a region, do the following: 

1) Select the desired region in the map using the Select Features tool (as a suggestion, the 

Samgods_zones layer should be ticked in the TOC so that the regions are visible) 

2) Activate the layer where you want to select elements, in this case the “Network_Link” 

layer, by clicking on it in the TOC 

3) On the menu bar, select Datasets -> Select by Location… 

4) In the Select by Location window, set the values indicated in Figure 37 

5) Click “Apply”, and then “Cancel” when all specifications have been made 
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Figure 37 The Select by Location tool. 
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5. Scenario setup 

As for Chapter 4, this chapter describes how to use the Samgods GUI in Voyager Standard user 

mode. The parameter settings etc. that are described are visible in Standard user mode – e.g. in 

developer mode all catalog keys are possible to set, in Advance Mode some extra catalog keys 

but not all as per developer mode.  

After edits have been made to the scenario according to the instructions below, the changes 

must be saved to the main geodatabase before running the model. This should be done 

according to the instructions in Section 4.5. 

If you are not sure on how to use the GIS window, the layers, filters and legends, we refer to 

Section 4 above for a short introduction. 

5.1. Import EMME network 

An option to made edits on the network in Emme environment is available in the GUI interface. In 

this paragraph the actions that must be performed are outlined ,and general suggestions on how 

to avoid inconsistencies in the model are provided. 

In order to import an Emme network together the speed definition for links, do the following: 

1) Select "Edit the data" and double click on scenario under Scenario Window; 

2) Set the values for the following catalog keys: 

Figure 38 Catalg keys to import Emme network 

 

a) Change "Select  from which interface you want to import your edits:" to "EMME 

(importing Emme network and speed table) 

b) Specify the location for Emme network using "Use Emme network file:" catalog key 

The file must have *.211 extension to be recognized by the system 

c) Specify the location for link speed file using "Use Emme speed table:" catalog key 

The file must have *.DAT extension to be recognized by the system 

d) From Emme network *.211 identify the number of zones present in the table (see 

below for details on this) and set the catalog key "Number of zones in network (see 

value in scenario network):" to that value 

3) Click on "Run". 

The main elements in this import are the number of zones and the file structure for the Emme 

network and the speed link table.  

The Emme network in *.211 has two distinct parts, t nodes init and t links init. The records 

between those two strings represent the node table. An example has shown in the following 

picture: 
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Figure 39 Node table 

The values present in each record has a similar meaning to the attributes present in a Voyager 

network: 

• a: just a label used in Emme program , not relevant for the system 

• *: if present the record refers to a zone. if not present it is a regular node 

• 711400: Emme number 

• 1620.00: x coordinate 

• 6601.00: y coordinate 

• 1: ID_COUNTRY 

• 114: ID_REGION 

• 0: MODE_N 

• 0000 : user field not relevant for the model. 

During the import ID_COUNTRY, ID_REGION and MODE_N will be verified in terms of 

consistency with the base scenario. If one or all of them will be missed, in 

{SCENARIO_DIR}\REPORT_ED_{SCENARIO_CODE}.TXT will be listed the errors (see chapter 

7 for list of messages and possible actions). The errors must be correct in the *.211 and the 

process must be rerun until no messages will be displayed in the report.  

To identify the maximum number of zones in the Emme network browse along the node table 

until a first record without "*" in the second position has identified. For instance: 

Figure 40 Last zone in node table. 

Since the text window in Cube gives the row number (number on the left hand side grayed), the 

number of zones will be simply identified as difference of the current row number and 5 (first 

record in the table containing a node record). In the example 1125-5 =1120. 

This is the value that must be provided to the catalog key "Number of zones in network (see 

value in scenario network):". 

The system will not perform checks on the link table rather than consistency with the node table. 

Therefore before use the network in Samgods the categories associated to the links must be 

checked and corrected. The CATEGORY attribute (6th field in the Emme link table, denoted link 

type) must be consistent to the list of allowed categories in A_LinkGategories. 
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The UL3 attribute (user link data number 3) in the link table (11th field in the Emme link table) 

has been used to specify a capacity constraint in sea mode. Therefore those sea links for which 

the user wants to apply a constraint, a number must be coded.  

It is worth noting that the nodes and links are not sorted in normal emme output order from a 

Cube/Voyager. export Introducing a link-based cost 

There are different ways to add taxes, tolls and extra costs to one or several links. All of them are 

added for each vehicle class separately. 6 attributes with different purposes are defined: 

 Extra fixed cost per link or set of links (SEK) 

 Extra kilometres based cost per link or set of links (SEK/km) 

 Country tax: kilometres based tax per country (SEK/km) 

 Link class tax: fixed tax per link, per link category (SEK) 

 Link tax: fixed tax per link (SEK) 

 Toll for bridges, fixed tax per link (SEK) 

How to edit each one of them is described in the following paragraphs. The three types of taxes 

(country tax, link class tax and link tax) work together, so that only one of them can be applied to 

a specific link at once. In short the priorities are the following: 

COUNTRY TAX  <LINK CLASS TAX <LINK TAX 

 How the different taxes are prioritized in detail is described below, namely in the section about 

the link tax. The toll for bridges is added to any tax on a link. It can also be applied to road and 

rail links that are not bridges. All these four attributes (the three taxes together with the toll for 

bridges) are edited via tables. 

Then there are the two extra cost attributes. They could represent any fee, tax or other cost and 

are added to any other taxes or tolls for the links where they are defined. They are edited via a 

GIS layer. 

5.2.1.  Extra cost on a specific link or set of links  

In order to add a specific cost to a specific link in the network for a specific vehicle class, do the 

following: 

4) Open the GIS file (Input_Data.mxd), in one of the two possible ways: 

e) Open the Scenario manager window by double clicking on the scenario name in the 

Scenarios window. In the Scenario manager window, select the Edit the data 

application. Click the “Next…” button and then “Edit…” for the catalog key “ArcMap 

GIS Project File”; 

f) Alternatively, select the scenario by clicking on it in the Scenarios window and open 

the file from the Data Section window, under Scenario Inputs\Editable 

data\Input_Data.mxd; 

5) Select the Network_Link Layer in the TOC window; 

6) On the menu bar, select Link -> Attribute -> Add; 

7) In the first popup window, enter the name for the new attribute by considering the 

following: 

a) If you want to add an attribute as a fixed cost (independent of distance), the label 

name EC_VXXX, where XXX represents the vehicle type, should be used (in the 

network all the attributes depend on the vehicle type); 
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b) If you want to add an attribute as a parametric cost depending on the distance, the 

label name EC_KM_VXXX should be used; 

8) In the second popup window, fill in the variable type (numerical (N) or text (T)); 

9) Enter the specification for the next new attribute as in 5) and 6). When all attributes have 

been added, continue to 8); 

10) Leave the attribute name blank (without typing anything) and click “OK”. 

 

Please note: The label names for the two attributes are managed by two catalog keys in the Edit 

the data application: 

 “Attribute name for the extra cost to a specific link [SEK]” – default: EC_V; 

 “Attribute name for the extra cost to a specific link [SEK/km]” – default: EC_KM_V. 

To change the defaults the user only needs to type the new label names in these catalog keys. If 

the defaults are changed, the new label names must be used when setting the attributes as 

described above, The vehicle type code has to be placed at the end of the attribute name, e.g.  

 COST_KM101; 

 FEES_201. 

So if the user e.g. wants to use the attribute name “COST_KM101” for vehicle type 101, the 

catalogue key should be set to “COST_KM”. Examples of erroneous definitions (beginning with a 

number or containing blank entries) are: 

 105COST; 

 204 test; 

 204test. 

 

Each link in the network will now have the structure displayed in Figure 41 below. The user can 

see this in the Feature Explorer window by selecting a link using the “Select Features” tool. 



Scenario setup - Introducing a link-based cost 

121 
 

 

Figure 41 Feature Explorer window. 

11) In the Editor toolbar, select Editor -> Start editing. In the “Layers” drop down menu select 

the “Network_Link” layer 

 To edit a single link, do the following: 

1) Use the “Select features” tool  to select the specific link 

2) In the Feature Explorer window, type in the value of the tax or cost in the new 

attribute cell 

3) Save the edit by clicking the green icon on the top left 

4) Close the Feature Explorer window 

5) In the Editor toolbar select Editor -> Stop Editing 

6) To the question “Do you want to save your edits?”, click “Yes” 

7) Close the GIS window by clicking on the X icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, the 

map could be saved, otherwise this is not necessary). 

 To edit a list of links based on attribute conditions, do the following: 

1) Under the main toolbar, select Datasets -> Select by Attributes… 

2) In the Select Specification window, right click in the blank field to see the 

attribute list (note: it only shows attributes from the active layer – to access other 

attributes, select another layer in the TOC), select the attribute for  applying the 

condition (in the example in Figure 42, select all the links on mode 5 – air) 

New attributes for 

extra costs on links 
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Figure 42 The Select Specification window. 

3) Click “Create New Set” 

4) Select Link -> Compute... in the menu bar to access the Link Attribute 

Calculation window, see Figure 43 

 

Figure 43 The Link Attribute Calculation window. 

5) Fill in the fields, see Figure 43. To insert edits in the main field in the middle, 

right click and select “Insert”. A window, “Insert Equation”, pops up – right-click in 

the blank field and select the attribute you want to edit, e.g. EC_KM_V401 as in 

Figure 43, and type in “=” followed by the value. More attributes could be edited 

by repeating the procedure. In the “Applies To:” drop down menu, select 

“Selected items” 

6) Click ”Apply”. An information window shows the total number of links updated. 

Click “OK” and then “Close” 

7) Under the Editor toolbar, select Editor -> Stop Editing 

8) To the question “Do you want to save your edits?”, click “Yes” 
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9) Close the GIS window by clicking on the X icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, 

the map could be saved, otherwise this is not necessary). 

 To edit a list of links based on a geographical selection, do the following: 

1) Select the “Samgods_zones” layer in the TOC 

2) In the main toolbar, select Datasets -> Select by Attributes… 

3) In the Select Specification window, right click in the blank field to see the 

attribute list (note: it only shows attributes from the active layer – to access other 

attributes, select another layer in the TOC), and select the attribute for applying 

the condition (in the example in Figure 44, select the Stockholm region). For a 

list of the region and country codes, open the table Scenario Inputs\General 

tables\Zoning Systems in the Data Section window 

 

 

Figure 44 The Select Specification window. 

4) Click “Create New Set” 

5) Select the “Network_link” layer in the TOC 

6) On the main toolbar, select Datasets -> Select by Location... to access the 

window in Figure 45 where appropriate changes can be done 

 

Figure 45 The Select by Location window. 
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7) Click “Apply”. An information window shows the total number of links selected. 

Click “OK” and then close the window by clicking “Cancel” 

8) Select Link -> Compute on the main toolbar to access the Link Attribute 

Calculation window, see Figure 46 

 

Figure 46 The Link Attribute Calculation window. 

9) Fill in the fields. To insert edits in the main field in the middle, right click and 

select “Insert”. A window, “Insert Equation”, pops up – right-click in the blank 

field and select the attribute you want to edit, e.g. EC_V101 as in Figure 46, and 

type in “=” followed by the value. More attributes could be edited by repeating 

the procedure. In the “Applies To:” drop down menu, select “Selected items” 

10) Click “Apply”. An information window shows the total number of links updated. 

Click “OK” and then “Close” 

11) On the Editor toolbar, select Editor -> Stop Editing 

12) To the question “Do you want to save your edits?”, click “Yes” 

13) Close the GIS window by clicking on the X icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, 

the map could be saved, otherwise this is not necessary). 

5.2.2.  Country tax – kilometer-based 

The user can apply a country tax for road and rail modes, differentiated by the vehicle type. For 

the other modes (sea, ferry and air), the tax can only be differentiated between inside and 

outside of Sweden, since the links for these modes are not divided between other countries in 

the Samgods model. To edit the country tax, do the following: 
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1) Click the “Edit…“ button for the “Table with tax by country (SEK/km) [Table]”catalog key 

in the Edit the data application, or open the Scenario Inputs\Editable data\Tax by country 

Table from the Data section window, for the selected scenario 

2) To modify existing values, just type a new value in the SEK_KM attribute and press 

Enter 

3) To add a new tax, the user must know the country code (ID_COUNTRY). To access the 

country codes, please refer to the table Scenario Inputs\General tables\Zoning system 

in the Data section window 

a) Add a new row in the Tax by Country table by clicking the “+” icon; 

b) Type in the country code, the vehicle type and the SEK_KM value (the country name 

is not required) 

4) Close the Tax by Country table by clicking on the X icon in the top right corner and click 

“Yes” to the question: 

  

 

Please note: For sea, ferry and air modes (vehicles class numbers greater than 209) the user 

can only apply two country codes: 

 ID_COUNTRY=1 for Sweden (as above); 

 ID_COUNTRY=-1 for all countries outside Sweden. 

5.2.3.  Link class tax 

The user can apply a tax per link for a specific category of links in the network. This is done in 

the following way: 

1) Click “Edit“ for the “Tax by Category (SEK) [Table]” catalog key in the Edit the data 

application or open Scenario Inputs\Editable data\Tax by Linkclass from the Data 

Section window for the specific scenario; 

2) To modify existing values, just type in a new value in the SEK attribute and press Enter; 

3) To add a new tax, the user must know the category (LINKTYPE). To access the category 

codes, open Scenario Inputs\General tables\LinkCategories values from the Data 

section window; 

a) Add a new row in the Tax by Link class table by clicking the “+” icon; 

b) Type in the LINKTYPE value, the vehicle type and the SEK value; 

4) Close the Tax by Link class table by clicking on the X icon in the top right corner and 

click “Yes” to the question: 
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5.2.4.  Link tax 

The user can apply a tax for a specific link in the network. This is done in the following manner: 

1) Click “Edit…“ for the “Tax by Link (SEK) [Table]” catalog key in the Edit the data 

application, or open Scenario Inputs\Editable data\Tax by Link from the Data section 

window for the specific scenario 

2) To modify an existing value, just type in a new value in the SEK attribute and press Enter 

3) To add a new tax, the user must know the start (A) and end (B) node for the link in the 

network. To visualize the network, open the Input_Data.mxd file, e.g. from the Data 

Section window. The A and B node numbers can be accessed e.g. by selecting the link 

with the Select Features tool and looking in the Feature Explorer window; 

a) Add a new row in the Tax by Link table by clicking the “+” icon 

b) Type in the A and B values (start and end node for the link), the vehicle class 

and the SEK value. In order to have the tax in both directions of the link, the link 

must be added twice, one row for each direction (where the A and B nodes are 

exchanged in the second row) 

4) Close the Tax by Link table by clicking the X icon in the top right corner and click “Yes” to 

the question 

 

 

Please note: Introducing a link with a zero tax value for a specific vehicle type has the effect that 

all the extra costs (in term of taxes) are set to zero. The same principle applies to the Tax by Link 

class table regarding the Country tax value. 

The general rule applied in the model is that 

TAX_COUNTRY <- TAX_LINKCLASS <- TAX_LINK 

If several tax values are assigned to a specific link, e.g. one from the country table, another one 

from the link class table and a third one from the link table, each value will be overwritten by the 

subsequent value in the order above, i.e. the smaller scale always overrides the larger 

(disregarding  the actual value of the tax). 

Please observe that this rule does not apply to the Toll bridges table or the extra cost values in 

the network – they are added to any other taxes. 
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5.2.5.  Toll bridges 

In the network, there are a few bridges with fixed tolls. The Toll bridges table contains the values 

of the tolls. The user can modify them or add new bridge tolls in the following manner: 

1) Click “Edit…“ for the “Toll for bridges (SEK) [Table]” catalog key in the Edit the data 

application, or open Scenario Inputs\Editable data\Toll bridges from the Data section 

window for the specific scenario 

2) To modify an existing value, just type in a new value in SEK attribute and press Enter 

3) To add a new toll, the user must know the start (A) and end (B) node for the link in the 

network. To visualize the network, open the Input_Data.mxd file, e.g. from the Data 

Section window. The A and B node numbers can be accessed e.g. by selecting the link 

with the Select Features tool and looking in the Feature Explorer window 

a) Add a new row in the Toll bridges table by clicking the “+” icon 

b) Type in the A and B values (start and end node for the link), the vehicle class 

and the SEK value. In order to have the tax in both directions of the link, the link 

must be added twice, one row for each direction (where the A and B nodes are 

exchanged in the second row) 

4) Close the Toll bridges table by clicking the X icon in the top right corner and click “Yes” 

to the question: 

 

5.3. Change the loading costs and times in terminals for different types 
of cargo 

The costs and times for loading cargo inside the terminals are specified for different types of 

cargo – containers, general cargo non containers, dry bulk non containers and liquid bulk non 

containers. 

1) Open the vehicle parameters table by clicking “Edit…” for the “General parameters of 

vehicle classes [Table]” catalog key in the Edit the data application, or open Scenario 

Inputs\Editable data\Vehicles Parameters from the Data section window for the specific 

scenario 

2) For each vehicle class, edit the values for the attributes below by typing in the new value 

and the press Enter: 

 load time containers in hours/vehicle (not divided by type of commodity) – attribute 

CONT_LTI 

 load cost containers in SEK/tonne (not divided by type of commodity) – attribute 

CONT_LCO 

 load time general cargo non containers in hours/vehicle – attribute NC_LTI_GC 

 load time dry bulk non containers in hours/vehicle – attribute NC_LTI_DRY 

 load time liquid bulk non containers in hours/vehicle – attribute NC_LTI_LIQ 
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 load cost general cargo non containers in SEK/tonne – attribute NC_LCO_GC 

 load cost dry bulk non containers in SEK/tonne – attribute NC_LCO_DRY 

 load cost liquid bulk non containers in SEK/tonne – attribute NC_LCO_LIQ 

3) Close the table by clicking the X icon in the top right corner 

4) On request, click “Yes” to save the edits 

 

5.4. Change vehicle data 

Change vehicle parameters (e.g. cost per km and hour, capacity, etc,) in the Vehicles 

Parameters table the following way: 

1) Open the Vehicles Parameters table by clicking the “Edit” button on the “General 

parameters of Vehicle classes [Table]” catalog key using the Edit the data application, or 

open Scenario Inputs\Editable data\Vehicles Parameters from the Data section window 

for the specific scenario (same table as in Section 5.3); 

2) Edit the values for any attribute(s) by vehicle class; 

3) Close the table by clicking the X icon in the top right corner; 

4) On request, click “Yes” to save the edits. 

In the vehicles Parameters table is also the parameter that governs whether the empty vehicle 

matrices will be produced or not. For each vehicle class it is possible to set the parameter 

“EMPTY_V” to 1 (i.e. produce empty vehicle matrices) or 0 (i.e. not produce empty vehicle 

matrices). If the user chooses not to produce the empty vehicle matrices, the matrices will 

instead be filled out with zeroes. For more information on the computation of empty vehicles, see 

appendix section.11.2. 

5.5. Change parameters for specific commodities and vehicle types 

In the following cases it is possible to define specific values for particular commodities or STAN 

group and vehicle type. The options available are: 

 A CAPACITY value for commodity 15, denoted in the table as CAP_15; 

 specific km costs and hour costs for commodity 17, denoted in the table as KMCOST_17 

and HRCOST_17 

 specific km costs for STAN groups 10 and 11 - attribute KMCOS10S11 (same parameter 

as KMCOST) 

 load time containers in hours/vehicle (per STAN groups 10 and 11) – attribute 

COLTI10S11 (same parameter as CONT_LTI) 

 load cost containers in SEK/tonne (per STAN groups 10 and 11) – attribute 

COLCO10S11 (same parameter as CONT_LCO) 

 load time dry bulk non containers in hours/vehicle (per STAN groups 10 and 11) – 

NCLCD10S11 attribute (same parameter as NC_LTI_DRY) 

• load cost dry bulk non containers in SEK/tonne (per STAN groups 10 and 11) – 

attribute NCLTD10S11 (same parameter as NC_LCO_DRY) 

 

Figure 47 Special settings for particular vehicle type. 
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For specific commodities and vehicle types (in the table 205, 207, 208, 209) the values applied 

will differ from those specified in the “General parameters of vehicle classes [Table]”. In principle 

this is implemented as an override function in which positive entries are used as revised values, 

and negative values indicate that the standard values should be used, Thus, in the table only 

the revised values that the user wants to apply should be entered. For the values that the use 

wants to maintain from the general table value -1 must be coded.. 

1) Open the vehicle parameters table by clicking “Edit…” for the “Specific parameters of  

Vehicle Classes in some commodities [Table]” catalog key in the Edit the data 

application, or open Scenario Inputs\Editable data\Vehicle Parameters Exceptions from 

the Data section window for the specific scenario 

2) For each vehicle class, edit the values for the attributes (KMCOST_17, HRCOST_17, 

KMCOS10S11, NCLCD10S11, NCLTD10S11, COLCO10S11, COLTI10S11, CAP_17) 

3) Add a new vehicle class (from the existing vehicle classes in the general table) and edit 

the attributes 

4) Close the table by clicking the X icon in the top right corner 

5) On request, click “Yes” to save the edits 

 

 

 

5.6.  Change the average value (SEK) of the commodities  

1) Open the commodity table by clicking on “Edit” on the “Commodity data [Table]” catalog 

key using the Edit the data application, or open Scenario Inputs\Editable data\Cargo 

Table from the Data section window, for the specific scenario 

2) Edit the values by commodity class for: VALUE_SEKT (SEK/Tonne) 

3) Close the table by clicking the X icon in the top right corner 

4) On request, click “Yes” to save the edits. 

5.7.  Change capacity in ports 

The user can change the values for the following port parameters: 

 MaxDwtCont (maximum deadweight tonnage, container vessel) 

 MaxDwtRoRo (maximum deadweight tonnage, ro/ro vessel) 

 MaxDwtOthe (maximum deadweight tonnage, other vessels) 

This is done in the following way: 

1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario 

2) Select the “Nodes” layer in the TOC window and tick the check box if it is not already 

ticked 

3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar) 

4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar 
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5) Select the terminal(s) by using the Select Features tool, or by setting a selection 

condition (e.g., rail terminals: MODE_N=2 in Sweden). For instructions on how make a 

selection based on attributes, please refer to Section 0 

6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in 

the middle) and select “Insert” (e.g., MAXDWTRORO=100000, see Figure 48. To see 

the available parameters, right-click in the blank field in the Insert Equation window) and 

select which items the edits should apply to (all or selected). Click “Apply”. When 

finished, click “Close” 

 

7) On the Editor toolbar, select Editor -> Stop Editing 

8) To the question “Do you want to save your edits?”, click “Yes” 

9) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be 

saved, otherwise this is not necessary). 

5.8. Change capacity in Trollhätte canal (also denoted Vänern canal) 

The user can change the values for the following port parameters specifically for Vänern canal: 

 MaxDwtCont (maximum deadweight tonnage, container vessel); 

 MaxDwtRoRo (maximum deadweight tonnage, ro/ro vessel); 

 MaxDwtOthe (maximum deadweight tonnage, other vessels). 

This is done in the following way: 

1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario 

2) Select the “Nodes” layer in the TOC window and tick the check box if it is not already 

ticked 

3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar) 

4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar 

Figure 48 The Feature Class Attribute Calculation window. 



Scenario setup - Transoceanic impedances for small ports 

131 
 

5) Select the terminal(s) by using the Select Features tool, or by setting a selection 

condition (e.g., Varner ports: PORTAREANR=14). For instructions on how make a 

selection based on attributes, please refer to Section 4 

6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in 

the middle) and select “Insert” (e.g., VANERNCAN=4001, see Figure 48. To see the 

available parameters, right-click in the blank field in the Insert Equation window) and 

select which items the edits should apply to (selected). Click “Apply”. When finished, 

click “Close” 
 Figure 49 The Feature Class Attribute Calculation window. 

7) On the Editor toolbar, select Editor -> Stop Editing 

8) To the question “Do you want to save your edits?”, click “ 

Figure 50 The Feature Class Attribute Calculation window. 

 

9) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be 

saved, otherwise this is not necessary). 

5.9. Transoceanic impedances for small ports 

The current model provides a tool to avoid transshipments between small domestic ports and 

international ports. The nodes table has a new attribute, called TRANOCEFAC, that has a value 

10 for domestic ports that represent an impedance applied to the times in case a movement 

between the small port and a transoceanic port is selected. For details on the implementation 

refer to document listed in Section 10.7. To modify the set of ports or the default value (10) the 

following steps could be performed: 

This is done in the following way: 

1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario 

2) Select the “Nodes” layer in the TOC window and tick the check box if it is not already 

ticked 

3) Start an Edit session (select Editor -> Start Editing on the Editor toolbar) 

4) Select the “Nodes” layer in the “Layers” scroll down menu on the Editor toolbar 
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5) Select the terminal(s) by using the Select Features tool, or by setting a selection 

condition (e.g. MODE_N=3&ID_COUNTRY=1 will select all the domestic ports). For 

instructions on how make a selection based on attributes, please refer to Section 4 

6) Select Node -> Compute and type in the equations by right-clicking in the largest field (in 

the middle) and select “Insert” (e.g., TRANOCEFAC=10, see Figure 48. To see the 

available parameters, right-click in the blank field in the Insert Equation window) and 

select which items the edits should apply to (selected). Click “Apply”. When finished, 

click “Close”  

Figure 51 The Feature Class Attribute Calculation window. 

7)  On the Editor toolbar, select Editor -> Stop Editing 

8) To the question “Do you want to save your edits?”, click “Yes” 

9) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be 

saved, otherwise this is not necessary) 

 

5.10.  Introduce new infrastructure 

When adding new infrastructure it is recommended to use the filter function as described below. 

Then only links and nodes with specific modes and/or categories are shown in the GIS window. 

However, a new link has category = 0. When having created a new link, the attributes, including 

the link category, could be edited directly as described below. However, if the editing of the link is 

interrupted, e.g. by selecting another element or closing the Feature Explorer window before the 

edits are finished, the new link can become invisible in the map because of the filter. In order to 

be able to select it again and continue the edits, the filter must be disabled. 
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The edits made are not always visible at once in the Feature Explorer. In order to see exactly 

which edits that have been made for a selected link, close the Feature Explorer and open it again 

to refresh it. 

5.10.1. New roads 

1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario 

2) Activate the filter for the road mode both in the network node and the link layers by right-

clicking on the respective layer in the TOC, selecting “Properties” and tick the “Active” 

check box for road mode 

3) Select the Network_Link layer in the TOC 

4) Select the node default legend “2:Node type – Road” in the menu accessed by clicking 

on the left downwards-pointing arrow:  

5) Start an edit session (click Editor -> Start editing) 

6) Select the Network_Link layer in the “Layers” drop down menu 

 

 

 

 

 

 

 

7) Select the pencil icon 

8) Draw the new link. This is done by clicking where the new link should start and for each 

new click on the map, a new vertex is created. At the end of the link, double-click 

9) The following window will appear if new a node is added (i.e. if the link does not start and 

end in existing nodes):  

 

10) Click “Yes” and then select a node value greater than 2000 (values up to 1999 are only 

for terminals and zones), see Figure 52 

11) Click “OK” 

 

Tip: Instead of specifying the new link from the beginning, as described in this 

paragraph, it is possible to select an existing nearby link, with attributes similar to the 

new link, and in the Feature Explorer window use the copy function.  Click , and 

then create the new link as described below and change only the attributes that differ 

from the other link. In this way it is easier to avoid making mistakes when specifying 

the attributes. 
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Figure 52 The Add New Node window. 
In the Feature Explorer window (see 

 

12) Figure 41), specify the following values. In order to assign the same values to both 

directions (A to B and B to A), make sure that both ways are selected in the Feature 

Explorer window. 



Scenario setup - Introduce new infrastructure 

135 
 

Figure 53 Feature explorer window. 

a) ALL_M=1 (always equal to 1, which means that it is an open link) 

b) LORRY_40T=1 (1 if open for vehicle types 102, 103 and 104, 0 otherwise) 

c) LORRY_60T=1;(1 if open for vehicle type 105, 0 otherwise) 

d) CAR=1 (1 if open for vehicle type 101, 0 otherwise)  

e) Leave all the other modes as zero 

f) CATEGORY: type the category number – see available numbers and 

descriptions in the Data Section window, under Scenario Inputs\General 

tables\Link Categories 

g) NLANES: number of lanes in each direction 

h) FUNCTION: speed flow curve – see V101/102 tables in the Data Section 

window under Scenario Input/General tables (values between 1 and 50, 61 only 

for connectors and other modes) 

i) SPEED_1:speed in km per hour for vehicle class 101 

j) SPEED_2: speed in km per hour for vehicle classes 102, 103, 104 and 105 

k) DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool 

as displayed in Figure 54 (note that “Selected items” must be selected in the 

“Applies To:” field) 

l) MODE_L=1, because it is a road link 
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Figure 54 The Link Attribute Calculation window. 

 

Please note: It is recommended to round the distance values to avoid excessive 

number of digits after the comma. 

13) Select in the Feature Explorer window the node or nodes created (they can be found to 

the left of the table of attributes). Answer “Yes” to the question whether the edits should 

be saved. Edit the following attributes: 

a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning 

system feature class. Select the zone and it will be visualized in the Feature 

Explorer window with the attributes for the zone (this is preferably done before 

starting to edit the new link/node, since selecting the zone will un-select the new 

link and node). As an alternative, the table “Zoning System”, found in Scenario 

Inputs\General tables in the Data Section window, can be consulted 

b) MODE_N=1 because it is a road node 

c) All the other attributes will be filled in automatically by the model 

14) On the Editor toolbar, select Editor -> Stop Editing 

15) To the question “Do you want to save your edits?”, click “Yes” 

16) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be 

saved, otherwise this is not necessary). 

5.10.2. New railroad 
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1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario 

2) Activate the filter for the rail mode, both in the network node and the link layer by right-

clicking on the respective layer in the TOC, selecting “Properties” and tick the “Active” 

check box for rail mode 

3) Select the Network_Link layer in the TOC 

4) Select the node default legend “3:Node type-Rail”, in the menu accessed by clicking the 

left downwards pointing arrow:  

5) Start an edit session (select Editor -> Start Editing) 

6) In the “Layers” drop down menu, select the Network_Link layer 

 

 

 

 

 

 

 

7) Select the pencil icon 

8) Draw the new link. This is done by clicking where the new link should start and for each 

new click on the map, a new vertex is created. At the end of the link, double-click 

9) The following window will appear if a new node is added (i.e. if the link does not start and 

end in existing nodes): 

 

10) Click on “Yes” and then select a node value greater than 2000 (values between 1120 

and 1999 are only for terminals and zones), see Figure 55 

 

Tip: Instead of specifying the new link from the beginning, as described in this 

paragraph, it is possible to select an existing nearby link, with attributes similar to the 

new link, and in the Feature Explorer window use the copy function.  Click , and 

then create the new link as described below and change only the attributes that differ 

from the other link. In this way it is easier to avoid making mistakes when specifying 

the attributes. 
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Figure 55 The Add New Node window. 

11) Click “OK” 

12) In the Feature Explorer window, specify the following values. In order to assign the same 

values to both directions (A to B and B to A), make sure that both ways are selected in 

the Feature Explorer window. 

a) ALL_M=1 (always equal to 1, which means that it is an open link) 

b) COMBI=1 (1 if open for vehicle type 201, 0 otherwise) 

c) FEEDER1=1 & FEEDER2=1 (1 if open for vehicle type 202, 0 otherwise) 

d) STAX225=1 (1 if open for vehicle type 204, 0 otherwise) 

e) STAX25=1 (1 if open for vehicle type 205, 0 otherwise) 

f) STAX30=1 (1 if open for vehicle type 206 , 0 otherwise) 

g) WAGONLOAD=1 (1 if open for vehicle type 207,208,209, 0 otherwise) 

h) CATEGORY: type the category number – see available numbers and 

descriptions in the Data Section window, under Scenario Inputs\General 

tables\Link Categories 

i) NLANES: number of lanes in each direction 

j) FUNCTION=61 (always this value except for road mode) 

k) SPEED1: Speed in km/h 

l) SPEED2=0 

m) DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool 

as displayed in Figure 56 (note that “Selected items” must be selected in the 

“Applies To:” field)  

n) MODE_L=2, because it is a rail link 
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Figure 56 The Link Attribute Calculation window. 

 

Please note: it is recommended to round the distance values to avoid excessive 

number of digits after the comma. 

 

13) Select in the Feature Explorer window the created node or nodes (they can be found to 

the left of the table of attributes). Answer “Yes” to the question whether the edits should 

be saved.  Edit the following attributes: 

a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning 

system feature class. Select the zone and it will be visualized in the Feature 

Explorer window with the attributes for the zone (this is preferably done before 

starting to edit the new link/node, since selecting the zone will un-select the new 

link and node). As an alternative, the table “Zoning System”, found in Scenario 

Inputs\General tables in the Data Section window, can be consulted 

b) MODE_N=2 because it is a rail node 

c) All the other attributes will be automatically filled by the model 

14) On the Editor toolbar, select Editor -> Stop Editing 

15) To the question “Do you want to save your edits?”, click “Yes” 

16) Close the GIS window by clicking the X icon without saving the ArcGIS Map Document 

(*.mxd) (if any edits to the legends and/or the layout have been made, the map could be 

saved, otherwise this is not necessary). 

5.10.3. New sea, ferry and air links 
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New links for these modes could also be added, in a similar manner as for the road and rail links. 

An important exception is about the UL3 link attribute for sea and ferry links. 

UL3 represents the maximum vessel capacity allowed on a sea or ferry link. The value coded in 

this attribute will ban vessel types where the capacity of the vessel exceeds the value UL3. 

The vessel capacity is recorded in the general parameters for vehicles (attribute CAPACITY) and 

it will compare with UL3 prior the LOS calculation. Two cases are possible: 

• If UL3 > CAPACITY: the specific vessel type will be able to use the link; 

• if UL3 < CAPACITY the specific vessel type will not use the particular link. 

5.10.4. New terminals 

The terminals are represented inside the network as zones
3
. They could be distinguished from 

the actual zones by their node number, which does not end with 00 (“actual” zones here means 

starting and ending points for trips, whereas terminals are intermediate steps. Actual zones could 

also be terminals, in the case of Direct Access. The actual zones have NORIG numbers that end 

with 00). 

To add a new terminal, different actions are required depending on the mode of the terminal. The 

new terminal needs to be added in three layers: the Network layer, the Nodes_commodities 

layer, and the Nodes layer. 

Road terminal 

Network layer: 

1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario 

2) Activate the filter for road mode both in the network node and link layer (please refer to 

Section 0‎4.15 for instruction on how to do this) 

3) Select the node default legend “2:Node type – road” (see Section 4.15) 

4) Select the Network_Node layer in the TOC 

5) Start an edit session (on the Editor toolbar, select Editor -> Start Editing) 

6) In the “Layers” drop down menu, select the Network_Node layer 

7) Select the pencil icon 

8) Add the new node by clicking on the location and selecting a node number between the 

highest zone number and 2000 (select a number less than 2000 in the range specified in 

the window “Current Unused Numbers”) 

9) Click “OK” 

10) In the node table in the Feature Explorer window, type in the following information: 

a) ID_COUNTRY and ID_REGION: the values are easily identified using the zoning 

system feature class. Select the zone and it will be visualized in the Feature 

Explorer window with the attributes for the zone (this is preferably done before 

starting to edit the new node, since selecting the zone will un-select the new 

                                                           
3
 The zone numbering referred to are Swedish zone number system used in emme networks and in the 

logistics model. For a conversion to Cube/Voyager node number a node-to-node map is required. All zone 
numbers in emme format starts with node numbers above 700000, whereas all corresponding node 
numbers in Cube/Voyager are less than 2000. 
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node). As an alternative, the table “Zoning System”, found in Scenario 

Inputs\General tables in the Data Section window, can be consulted 

b) MODE_N=1, because it is a road terminal 

11) In order to change the number of zones for the entire network, right-click on the Network 

layer in the TOC and select “Properties”. Change the Highest Zone No. to the number of 

the just added terminal and click “OK”, see Figure 57 

 

 

Figure 57 How to change the number of zones for the entire network. 

12) Select the Network_Link Layer in the “Layers” drop down menu. To the question whether 

the changes should be saved, answer “Yes”. Using the new node as a starting node, 

draw a link connector from the node to the road network, as described in the New roads 

section above. Then type in the following information in the Feature Explorer window. In 

order to assign the same values to both directions (A to B and B to A), make sure that 

both ways are selected in the Feature Explorer window: 

a) ALL_M=1 (always equal to 1, which means that it is an open link) 

b) LORRY_40T=1 (1 if open for vehicle types 102, 103 and 104, 0 otherwise) 

c) LORRY_60T=1  (1 if open for vehicle type 105, 0 otherwise) 

d) CAR=1 (1 if open for vehicle type 101, 0 otherwise) 

e) Leave all the other modes as zero 
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f) CATEGORY=110 or 201 (see available numbers and descriptions in the Data 

Section window, under Scenario Inputs\General tables\Link Categories); 

g) NLANES=1 

h) FUNCTION=61 

i) SPEED_1=50 

j) SPEED_2=0 

k) DIST_KM: update using the SHAPE_LENGTH value using Link -> Compute tool 

as displayed in Figure 58  

l) MODE_L=1 because it is a road link 

 

 

Figure 58 The Link Attribute Calculation window. 

 

Please note: it is recommended to round the distance values to avoid excessive 

number of digits after the comma 

Nodes_commodities layer: 

1) In the “Layers” drop down menu, select the Nodes_commodities layer. Answer “Yes” to 

the question whether to save the changes to the selected feature 

2) Tick and select the Nodes_commodities layer in the TOC 

3) Add a new node by clicking in the map and give it exactly the same node number as the 

terminal (it doesn’t matter if it is located in another position; it is only the node number 

that is important). The node number is specified by assigning it to the attribute “N” 
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4) Type in the TRANSF_TYPE value – for a terminal with transfer road to road, 

TRANSF_TYPE=1 (a list of the transfer types is located in the Data section window in 

Scenario Input\General tables\Transfer type of terminal) 

5) For each commodity, disable (0) or enable (1) transfer at the terminal 

6) If there is another transfer type (e.g., transfer road-train – for road mode, possible values 

for transfer type is 1 to 6) to edit, add the same node again in the same way as for the 

previous transfer type, by setting the same node number and change all the other values 

for the specific case 

Nodes layer: 

1) In the “Layers” drop down menu, select the Nodes layer. On request, answer “Yes” to 

save the changes made 

2) Tick and select the Nodes layer in the TOC 

3) Add a new node with exactly the same node number as the terminal, in the same 

manner as in the Nodes_commodities layer 

4) Define the following attributes: 

 If a zone has direct access to the terminal, ZONET=the number of zone. If no zone 

has direct access, define ZONET=0 

 DOMESTIC=1 if the terminal is Swedish, 0 otherwise; 

 C_TECH_FAC and T_TECH_FAC=1 

5) On the Editor toolbar, select Editor -> Stop Editing. Answer “Yes” to the question(s) 

whether to save the changes made 

All the three node layers will now have the new terminal. Figure 59 below shows the Feature 

Explorer window for the three layers, displaying some of the attributes of the terminal. 

 

 

 

Figure 59 Feature Explorer windows for the Nodes_commodities layer, the Network_Node layer and 

the Nodes layer, all displaying the attributes of the new terminal. 

Nodes_commodities 

layer 

Network node layer Nodes layer 
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Rail terminal 

The required actions for adding a rail terminal are similar to the ones for a road terminal. Of 

course the attributes specific to the mode should be set for rail and railway vehicles instead of for 

road. The attributes that differ from the case with the road terminal are: 

 MODE_N = 2 

 Possible values for TRANSF_TYPE (please refer to the table Scenario Inputs\General 

tables\Transfer Type at terminals in the Data Section window) 

 CATEGORY=211 for the rail link connection 

The terminal must have a rail link to connect it to the rail network and a road link to connect it to 

the road network, see Figure 55 (if there is direct access from a zone to the terminal, the road 

connector is not mandatory). Please refer to the instructions for a new road terminal and for how 

to add a new railroad.  

 

Figure 60 Nodes layer illustration for rail terminal, connected to the rail network by a rail link and 

to the road network by a road link. 

 

Sea terminal 

A new sea terminal is added in the same way as a rail terminal (except for the mode specific 

attributes), except that the Ports_swe layer also must be edited, by adding the new terminal to it 

in a similar way as in the Nodes_commodities layer. The attributes necessary to edit in the 

Ports_swe layer are 

 N = the same number as in the other three layers 

 MODE_N = 3 

 The pilot fees for each one of the vehicle types 

Ferry terminal 

A new ferry terminal is added in the same way as a rail terminal (except for the mode specific 

attributes). 

Air terminal 

A new air terminal is added in the same way as a rail terminal (except for the mode specific 

attributes). 
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5.11. Change speed on different links 

1) Click “Edit” on the “ArcMap GIS Project File” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\Input_Data.mxd from the Data section 

window for the specific scenario 

2) Select the Network Link Layer in the TOC 

3) Start an edit session (Editor -> Start editing) 

4) Select the Network Link layer in the “Layers” drop down menu on the Editor toolbar 

5) Make a selection (one or several links) and change the speed values in the Feature 

Explorer window based on the selection made. For each mode, the speed is managed in 

a different way, see below 

5.11.1. Road Mode 

1) Activate the filter for Road Mode (please refer to Section 4.15 for instructions) 

2) If SPEED_1 and SPEED_2 for a link/links inside Sweden are equal to 0, the default 

values in the general tables will be applied. The default values for the base speed are in 

the delay tables in the Data Section window, Scenario Inputs\General tables\V101/V102 

speed flow curves (V101 – applied to class 101, V102 – applied to classes 102-105) 

3) The SPEED_1 field is defined as km per hour for vehicle class 101 

4) SPEED_2 defines the speed for all other road vehicle classes (102-105) 

5) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 4.15 0 for 

instructions). Edit the values directly in the Feature Explorer window or using Link -> 

Compute 

6) When all edits have been made, , select Editor -> Stop Editing on the Editor toolbar 

7) On the request “Do you want to save your edits?”, click “Yes” 

8) Close the GIS window by clicking on the X icon at the top right corner, without saving the 

ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been 

made, the map could be saved, otherwise this is not necessary) 

 

5.11.2. Rail Mode 

1) Activate the filter for Rail Mode (please refer to Section 0 for instructions); 

2) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 0 for instructions). 

Edit the speed value in the SPEED_1 attribute (in km/h) directly in the Feature Explorer 

window or using Link -> Compute (the SPEED_2 attribute is only used for road mode 

and should be set to 0 for all other modes) 

3) On the Editor toolbar, select Editor -> Stop Editing 

4) On the request “Do you want to save your edits?”, click “Yes” 

5) Close the GIS window by clicking on the X icon at the top right corner without saving the 

ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been 

made, the map could be saved, otherwise this is not necessary). 
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5.11.3. Sea Mode – enclosed waterways (CATEGORY=80 in Sweden and 540 

outside Sweden) 

1) Activate the filter for Sea Mode (please refer to Section 4.15 for instructions) 

2) Select a link or set of links with CATEGORY=80 or 540, using the Select Features tool or 

Datasets -> Select by attributes… or Select by location… (see Section 4.150 for 

instructions). Edit the speed value in the SPEED_1 attribute (in km/h) directly in the 

Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used 

for road mode and should be set to 0 for all other modes) 

3) For the other sea categories, the default values in the Vehicles Parameters table are 

applied (see the next section) 

4) On the Editor toolbar, select Editor -> Stop Editing 

5) On the request “Do you want to save your edits?”, click “Yes” 

6) Close the GIS window by clicking on the X icon at the top right corner without saving the 

ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been 

made, the map could be saved, otherwise this is not necessary) 

5.11.4. Sea Mode – All the other categories 

1) Open the Vehicles Parameters table by clicking “Edit…” for the “General parameters of 

Vehicle Classes [Table]” catalog key using the Edit the data application or open Scenario 

Inputs\Editable data\Vehicles Parameters from the Data Section window for the specific 

scenario 

2) Edit the speed values in the SPEED attribute for the vehicle types 301-317 

3) Close the table by clicking on the X icon at the top right corner 

4) On request, click “Yes” to save the edits 

5.11.5. Ferry Mode 

1) Activate the filter for Ferry Mode (please refer to Section 4.15 for instructions) 

2) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 0 for instructions).  

Edit the speed value in the SPEED_1 attribute (in km/h) directly in the Feature Explorer 

window or using Link -> Compute (the SPEED_2 attribute is only used for road mode 

and should be set to 0 for all other modes) 

3) On the Editor toolbar, select Editor -> Stop Editing 

4) On the request “Do you want to save your edits?”, click “Yes” 

5) Close the GIS window by clicking on the X icon at the top right corner without saving the 

ArcGIS Map Document (*.mxd) (if any edits to the legends and/or the layout have been 

made, the map could be saved, otherwise this is not necessary) 

5.11.6. Air Mode 

1) Activate the filter for Air Mode (please refer to Section 4.15 for instructions) 

2) Select a single link using the Select Features tool or select a group of links using 

Datasets -> Select by attributes… or Select by location… (see Section 4.15 for 

instructions).  Edit the speed value in the SPEED_1 attribute (in km/h) directly in the 

Feature Explorer window or using Link -> Compute (the SPEED_2 attribute is only used 

for road mode and should be set to 0 for all other modes) 
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3) On the Editor toolbar, select Editor -> Stop Editing 

4) On the request “Do you want to save your edits?”, click “Yes” 

5) Close the GIS window by clicking on the X icon without saving the ArcGIS Map 

Document (*.mxd) (if any edits to the legends and/or the layout have been made, the 

map could be saved, otherwise this is not necessary)

5.12. Edit the capacities for rail links 

The Rail Capacity Management process requires input in terms of the number of trains per day 

allowed on each domestic link (a link flow capacity). This information is provided via the capacity 

link table. In this section are described the steps to update this table: 

1) Click “Edit” on the “Table with rail capacity [Table]” catalog key using the Edit the data 

application, or open Scenario Inputs\Editable data\RailCapacity table from the Data 

section window for the specific scenario 

2) Sort the table on the attribute ID_LINK clicking on the attribute name 

3) Browse to the end of the table 

4) Add a new empty record clicking on the button  

5) Edit the A and B numbers for the new link in Voyager format 

6) Edit the ID_LINK value as the first available from the list (e.g. if the last record has 388, 

use 389); 

7) Edit the ORIGCAP as number of trains per day bidirectional (e.g. total number of trains in 

both the direction) 

8) Add another new empty record clicking on the button  

9) Edit the A and B numbers where A is the B value introduced in the previous record and 

B is the A value introduced in the previous record (basically each time two records must 

be introduced, one with A->B and one with B->A) 

10) Edit the ID_LINK using the same value as previous record (e.g. 389) 

11) Edit the ORIGCAP value using the same value as previous record 

12) Close the table by clicking the X icon in the top right corner; 

13) On request, click “Yes” to save the edits. 

 

Important note! 

The links present in capacity table MUST be consistent with the links present in the network. This 

consistency is related to: 

- a rail link in the capacity table must be present in the network 

- a domestic rail link in the network must have a capacity value in the rail capacity table 

- the links must be always bidirectional, therefore two records must always be present 

- the ID_LINK must be sequential and no gaps are allowed 

- two links with same node numbers (A to B and B to A) must have the same ID_LINK 

The user has all these checks already available in the "Edit the data" application. During the run 

report #8 will be produced under Report_ED_{Scenario_shortname}.txt. It is strongly 

recommended to check this file prior to running the Samgods model. 
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6. Advanced user options 

The advanced user rights have been specified for users having a good familiarity with the model 

and that require a more complex set up in terms of functionalities. In this chapter each 

functionality is described. 

6.1. Consolidation factors 

The consolidation factors in can be specified using two different levels: 

• First level: using the catalog keys catalog keys 21
st 

and 22
nd 

in Table 7: 

• Lower bound for consolidation factor (new) (applied to all commodities) 

• Upper bound for consolidation factor (new) (applied to all commodities) 

• Second level: CONSOL<Mode> table under Input_data.mdb and contains the 

lower and upper bound for consolidation factor by sub-mode and per specific 

STAN groups, using catalog key 7
th
 in Table 17 

The value provided at the first level will be overridden by the values present at the second level. 

In the current model some extra consolidation factor are provided for STAN groups 2, 8 and 9. 

The table has the following values: 

Figure 61 Default CONSOL<Mode> values and per STAN 2, 8 and 9. 

The steps to perform if the Advanced user wishes to modify these values using a different set 

are: 

1) Open Data Manager from Cube Interface  clicking on the 

icon in the red rectangle; 

2) Open Input_data.mdb in data manager: 
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3) Select BuildChain_CONSOL in data manager window 

4) Right click and select "Copy" 

5) Select Input_Data,mdb in Data Manager window, right click and select "Paste" 

6) Refresh Data Manager window clicking on  

7) Browse to BuildChain_CONSOL_1 (this is the copied table from BuildChain_CONSOL) 

and double click on it. Made desired changes and close the window clicking on X 

8) Select Samgods application and scenario under scenario window 

9) Double click on scenario name to open the scenario window 

10) Click next until reach the catalog key Consolidation factors table 

11) Click on "Browse" , select in the left window Input_Data.mdb and in the right window 

BuildChain_CONSOL_1 

12) Click on OK 

13) Click "Save" 

With the above changes the Samgods application is ready for the run. 

For an exhaustive description on how those parameters work in the logistic module see  

document listed in Section 10.3 pg. 32. 

6.2. Wait time for prompt messages 

In some applications some prompt windows will pop up during the execution. The prompt 

windows always require an action from the user since the process will be in pause until a choice 
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will be made within a determined time (10 minutes). The prompt windows give information on the 

run, normally warnings and failure messages.  

The advanced user has the option to modify these settings and cutting down the wait time to a 

few seconds when he/she wishes to run several scenarios in sequence. 

To change the waiting time perform the following steps: 

1) Select "Create the editable files"  application and "Scenario_Tree" scenario under 

scenario window 

2) Double click on scenario name to open the scenario window 

3) Under " Wait time for prompt messages during execution (default 10 minutes=600 

secs):" catalog key type 1 (1 will be 1 second) 

4) Click "Save" 

5) Click "Close" 

6.3. Locking solutions option for Rail Capacity Management 

A new feature allows locking the transport chain solutions for a set of large flows in particular. 

This is done by specifying the cases that need special attention in a text file.  

An example of its structure is: 

Figure 62 LockedSTDLogMod.txt file example. 

The values provided are: 

• P: commodity group (in the example 15 commodity) 

• Key: transport chain solution number in ChainChoi15_01.out 

The transport chains listed in this file will be excluded in the evaluation of the new alternatives 

during the Rail Capacity Management process. Their impact on the rail capacity consumption is 

of course still accounted for in the LP-model.. 

To specify a different set of locked solution the user should: 

1) Create a new text file in Notepad (or any other editing software); 

2) Provide the list of commodities and Key he/she wishes to lock 

3) Place the new file under {CATALOG_DIR}\01_Programs\LogMod\RCM 

4) The file's naming convention must follow the general rules for scenario naming (no 

blank, special characters, etc.) 

5) Select Samgods application and scenario under scenario window 

6) Double click on scenario name to open the scenario window 

7) Click next until reach the catalog key "File with list of locked solutions for RCM:" 

8) Edit the file name in the edit box: 

 

9) Click "Save" 

10) Click "Close
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6.4. Empty vehicle fractions 

The Extract procedure reads the output files from LogMod and RCM and produces the OD 

matrices for tonnes and number of loaded and empty vehicles respectively. It comprises a 

stepwise linear function for deriving the number of empties as fraction of the loaded vehicles.  

The applied curve is shown below: 

 

Figure 63 Curve of empty vehicle fractions. 

From version 1.0 of the logistics model the curve could be specified via the interface updating the 

table " Empty vehicle fractions per vehicle type and distance" under data panel (Scenario 

Inputs\General tables\). The structure of the table is as follow:  

Figure 64 Input table for empty vehicle fractions. 

The attributes in the table represent the points of the curve the user wants to apply: 
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• DIST1: first distance (km) where will be applied the EMPFAC1 value (with a flat 

distribution) 

• DIST2: second distance (km) where will be applied the EMPFAC2 value (with a 

linear function between EMPFAC1 and EMPFAC2 for distances between DIST1 

and DIST2) 

• If DIST1 and DIST2 are zero, a constant level curve with the value EMPFAC1 will 

be applied. 

The above attributes in other words shape the function used in the extract procedure. The 

attribute ASYM provides a threshold distance above which asymmetric flows will generate empty 

vehicles. The asymmetric part is determined as the absolute value of the difference in the loaded 

flows in pairwise, opposite OD-relations. To illustrate the calculation consider an OD-relation (the 

asymmetric part is abs(120 – 100) = 20): 

• Distance = 70 km 

• OD-flow ij= 120 vhcls 

• DO-flow ji = 100 vhcls 

• Empty vehicle fraction at 70 km = 0.1 

If ASYM=50 the distance (70) is above the threshold value so asymmetric flows will generate 

empty vehicles (according to empties := symmetric term + asymmetric term): 

• OD-flow empties ji = 0.1*100 

• DO-flow empties ij = 0.1*120 + 20

6.5. Restart from failure 

In the event of a crash during a Samgods run different actions could be performed by the user 

depending on the crashed application. 

The model failure can occur under different circumstances: 

 hard disk space insufficient to save output 

 locked mdb that prevents move data in Input_data.mdb (if the geodatabase has been 

open in GIS interface or is MS Access the .ldb file could reside in the system and protect 

the mdb in read mode) 

 failure in running in  the LP solution with LP_solve.exe  

 wrong settings for some keys. 

 

If the failure happens in Standard LogMod or in some of its sub steps (LOS, Logistic Module, 

Assignment, Report) it is possible to rerun the process until the next sub step and after that run 

each remaining sub step selecting " Run only one step, or run all steps" with the appropriate 

value. 

 

For instance if the process crashes in "Logistics module\Save Reports" group it is required to run 

this and next sub group "Assignment\Conversion From Logmod to VY". The instructions below 

must be performed for those two groups with the same execution order shown in the interface 

(first Save Reports, second Conversion From Logmod to VY). After this the Assignment , Report, 

Rail Capacity Management steps will be run separately. 

To rerun a specific subgroup the following actions must be undertaken from the Cube interface: 



Advanced user options - Restart from failure 

 

153 
 

1) Select the scenario that failed 

2) Open the application that failed 

3) Click on "Run" (see icon in red rectangle in following picture) 

4) On "Run Application" window select "Run Application now from Task Monitor' 

5) Tick "Run Current Group Only" 

6) Click on "OK" 

The single subgroup will be run.
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7. Log reports 

In this chapter, log reports from running some of the applications are presented. The reports 

include messages that help the user to better analyze and understand the results. 

7.1. Edit the data application 

The Edit the data log report is created when the Edit the data application is run. Possible 

messages inside the log report file Report_ED_{Scenario_shortname}.txt under the scenario 

specific folder, or accessible from the Data section window under Scenario outputs\Edit the data 

Report, are listed and explained in Table 29. 

 

Number of 

message 

inside the 

log report 

Purpose Example of messages Message explanation 

#1 Inform whether 

the scenario is 

editable or not 

Report #1 – the scenario 

is still editable. 

The scenario is in editable mode.  

Report #1 – the scenario 

is locked. 

Changed the scenario into read 

only mode. It is not possible to 

change it back from the interface.  

#2 Verify the 

Port_swe table 

Report #2: the terminal 

N(6.0) TERMINAL 

N(6.0) is not a sea 

terminal!! Please check 

the ”Ports Sweden” 

layer. 

The terminal number that is not a 

sea terminal is printed out. In the 

Ports_swe table there should be 

only sea terminals. If the terminal is 

not a port, it will not be saved in the 

table. 

Verify if a 

domestic port 

has the 

PortArea 

number 

specified 

Report #2: the terminal 

N(6.0) is missing the 

Port Area attribute. 

Please associate a port 

area number. See table 

"A_Port_areas" for the 

attribute names 

Each domestic port must be 

allocated to a port area since some 

calibration parameters are 

associated to this attribute. It is also 

used for reporting procedures. 

Correct the PortArea number with 

appropriate number. 

#3 Information on 

the number of 

zones 

Report #3: the number 

of zones is MAX 

NETWORK(5.0) 

Maximum number of zones in the 

highway network 

#3 Verify the 

coherence 

between 

network and 

nodes 

Report #3: the number 

of zones is not the same 

in the network and the 

node table. 

In the network there are  

MAX NETWORK(5.0) 

and in the nodes table 

MAX NODES(5.0). 

Please check the 

Scenario network.  

In this step the application updates 

the variable ZONES_M inside the 

general tables and gives the report.  

MAX NETWORK(5.0) is the 

variable used to count the 

maximum number of zones in the 

network 

MAX NODES(5.0) is the variable 

used to count the maximum 

number of zones in the node s 

table. During the run they will be 
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substitute by the zone node 

numbers. 

#4 Verify the 

coherence 

between tables 

Report #4: Please add 

the node ZONE(6.0) to 

the node table. 

The zone is in the network but not 

in the nodes table. 

Report #4: Please add 

the node ZONE(6.0) to 

the network. 

The zone is in the nodes table but 

not in the network. 

Report #4: Please add 

the sea terminal 

ZONE(6.0) to the 

network. 

The sea terminal is in the 

Node_Terminals but not in the 

network. 

Report #4: Please add 

the commodity node 

ZONE(6.0) to the 

network. 

The node is in the 

Nodes_commodities table but not 

in the network. 

Report #4: Please add 

the frequency node 

ZONE(6.0) to the 

network. 

The node is in the 

Frequency_Data_Node table but 

not in the network. 

Report #4: Please add 

the frequency node 

ZONE(6.0) to the 

network. 

The node is in the 

Frequency_Data_Link table but not 

in the network. 

#5 Verify the 

numbering 

system 

Report #5 – numbering 

system.  

Node / Code_error / 

Description 

Header of the message 

N / 1 / Missed the mode! 

– must be correct! 

Missed the mode for node N – must 

be correct in the node table 

N / 2 / Missed the ID 

COUNTRY or the ID 

REGION code – must be 

correct! 

Missed the ID_COUNTRY or the 

ID_REGION code in the node table 

for node N 

#6 View the errors 

during the 

creation of 

NORIG 

numbers for the 

zones 

List of errors during the 

creation of SCBSTANN 

for the zones 

Header of the message 

NORIG is the emme node number 

and its specification comes from a 

set of rules when edits are made in 

GIS interface. From Emme network 

it is the value already present. 



Log reports – Edit the data application 

156 
 

The node is without 

MODE_N. Please check 

the data. 

The mode for the zone is missing 

The node has no values 

available. Please check 

the data. 

There are no node numbers 

available for the zone 

#7 View the errors 

during the 

creation of 

NORIG 

numbers for the 

nodes 

List of errors during the 

creation of NORIG for 

the nodes  

Header of the message 

No more node numbers 

are available. Please 

check the data 

There are no node numbers 

available for the node 

#8 Check the 

consistency of 

rail capacity 

table with Rail 

Network 

Report#8: There are 

mistakes in the rail 

capacity table. Please 

check the rail capacity 

table. 

The link A B ID_LINK is 

not a rail link 

The link listed is not a rail link. 

Check the node numbers A and B 

in the rail network and identify the 

proper node number. (NOTE: the 

links must be only Swedish links). 

The link A B ID_LINK is 

not present in the 

network.  

The link listed is not present in the 

rail network. Two possible actions 

are: 

1) amend the A and B nodes 

because the link is in the network; 

2) add the link in the network 

because the link is missing. 

The link A B is in the rail 

capacity table but has 

not any capacity 

The links listed in the rail capacity 

table MUST have a capacity value 

greater than zero. The capacity is 

number of BIDIRECTIONAL trains 

per day. 

The ID_LINK sequence 

is wrong. for the 

following links: 

A B 

A B 

... 

 

Links with opposite direction but 

same node number MUST have 

same ID_LINK. 

Example: 

2001-2000 and 2000-2001 

The ID_LINK sequence 

is wrong.  

The ID_LINK must start from 1 to 

the highest number. No gaps could 

be present.  

 

Table 29 Reports for Edit the data application. 
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7.2. Samgods Model application 

The Existing Outputs log report is created when the Samgods Model application is run. The 

messages inside the log report file Report_SG_{Scenario_shortname}.txt under the scenario 

specific folder, or accessible from the Data Section window in Scenario outputs\Samgods 

Report\Existing Outputs, are listed and explained in Table 30. 

 

Number of 

message 

inside the log 

report 

Purpose Example of messages Message explanation 

#1 Analyze 

inconsistencies 

between input data in 

different runs 

The output OUTPUT for the 

commodity ID_COM(2.0) was 

created with a different Input 

data. Please check the 

scenario data. 

The previous run has 

DATE_E and the current run 

has DATE_L. 

Warning that the input 

data has been 

modified between the 

last run and the current 

run. 

 

 List of output files 
The results have been 

computed by Voyager. 

The output under path is 

available. 

List of all available 

output files and their 

locations. 

Table 30 Reports for the Samgods Model application. 

7.3.  Handling scenario application 

The Report for the import phase is created when the Import function in the Handling Scenario 

application is run. The messages inside the log report file Report_HL_{Scenario_shortname}.txt 

under the scenario specific folder, or accessible from the Data Section window under Scenario 

Outputs\Import function Report\Report for the import phase, are listed in Table 31. 

 

Possible messages Required actions 

All the catalog keys have the 

correct value. No actions are 

requested. 

Nothing 

List of catalog keys that have 

to be changed and how. 

Change the listed catalogue keys for the imported scenario 

under “Scenario Parameters” in the Handling Scenario 

application and run the application again. Check the report again. 

Table 31 Reports for the Handling scenario application. 
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8. Check-list when errors occur 

 Do you have the required administrative rights to install and run the Samgods GUI? 

 Is the model user role correct? Model Standard user is typically used when running 

scenarios etc., while Model developer typically is used during installation and setting up 

the system. Model Advanced user is used when some main parameters in the model 

setup should be changed for sensitivity tests 

 What is the ReturnCode no? ReturnCode 2 is a fatal error – view the error report 

 Is the name of the scenario correct? Geodatabase format does not allow:  

o Begin the name with numbers (i.e., 01_scenario is not allowed, but scenario_01 

is OK) 

o Special characters (like space “ “ or -,+, n f t ) 

o Too long names 

 Spaces, use underscore (“_”) instead. 

 Some errors (regarding delimiter problems with “.” and “,”) could be solved by setting the 

National settings for the PC to British 

 If the logistics module stops operating, the reason could be that the execution is split up 

into too many processors. RAM per processor should be at least 1.5 GB. The number of 

processors to use is set in the interface, via a catalog key in the Samgods model 

application, see Section 3.5 

 Warning messages as the picture below: 

 
will interrupt the model run (with Return Code =3). They refer to the LP setup (made by a 

set of batch files called in sequence). In this case a failure is occurred in MPS.jar 

program or LP?solve.exe program. To debug the problem refers to documents listed in 

Section 10.1 and 10.2 
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9. Maps on outputs 

The model produces outputs that can be classified into two main groups: 

• tabular reports 

• geodatabase networks 

The first group can be visualized via Cube interface, Access or ArcMap. The second group can 

be visualized via Cube interface or ArcMap. In this chapter we will provide the procedure to 

create maps for the second group. 

9.1. List of networks 

The available networks are: 

ID Data panel Name Notes 

1 Scenario 

Outputs\Samgods 

Report\Assignment 

Road Assigned Network  

Rail Assigned Network  

Sea Assigned Network  

Air Assigned Network  

2 Scenario 

Outputs\Samgods 

Report\Reports 

Assigned Network  

3 Bidirectional tons per mode 

STD 

 

4 Scenario 

Outputs\RCM 

Report\Assignment 

Road Assignment Network 

(RCM) 

 

Rail Assignment Network 

(RCM) 

 

Sea Assignment Network 

(RCM) 

 

Air Assignment Network 

(RCM) 

 

5 Scenario 
Outputs\RCM 
Report\Reports 

Assigned Network  

6 Report #15b Rail Capacity 
Network 

Only for RCM 

7 Bidirectional tons per mode 
RCM 

 

Table 32 Geodatabase networks in output. 

9.2. Create a map 

To create a map in GUI interface: 

1) Select the scenario from which you want to create a map 

2) Select from data panel the geodatabase network you want to visualize (in the example 

Report #15b Rail Capacity Network) and double click on it 

3) The GIS window will be open having in TOC only the network (named Rail_BiDir) 
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4) Clicking on "Add data>Geodatabase Data" add background layer placed under 

{CATALOG_KEY}\Input_Data.mdb\Samgods_zones. This is used only for cosmetic 

purposes 

5) Clicking on "Add data>Shapefile" add background shapefile placed under 

{CATALOG_KEY}\03_Gis_Data. This is used only for cosmetic purposes 

6) In the TOC drag and drop Rail_BDir on the top of all the layers 

7) Untick the network node layer (Rail_BDir_node) 

At this point the map will looks like: 

Figure 65 Map with geodatabase network and general layers. 

8) Click on GIS Analysis tab in the interface and click on Multi-Bandwidth tool 
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9)  The Highway Layer Link Bandwidth Setting window will pop up. Select the attribute to 

visualize in the map (TOT_EMPT) and Dynamic Color in the dialog screen. This option 

allows specification of different colors for different value ranges for the selected attribute 

10) Enter in the Name input frame, the name of the map (in the example Empty trains 

bidirectional per day) 

11) Click on "Color" and specified in the following window: Number of groups (6), the Color 

Range clicking on colored icon (green and red). Click on Apply Color Range and Apply 

Value Range. Accommodate the High Value in the range of values per desired class. 

Click on OK 
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12) Click on OK 

13) Click on OK 

The resulting map will be: 

14) Click on X to close the map, the system will prompt if it is necessary save the map giving 

a location and a name. Select the scenario folder and give the name "RCM.mxd". 
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9.3. Copy existing maps in new scenarios 

The practice to start from scratch is not recommended and will be extremely time consuming. A 

useful option is to inherit/copy all the settings specified with Multi-Bandwidth (or any tool in the 

graphical interface) from one scenario to another scenario by copying those settings  from the 

vpr file. 

The vpr file, normally created and saved alongside the output.mdb, takes the name of the 

geodatabase which it refers to. In Samgods model its name is 

output{Commodity}_{Scenario_shortname}.vpr and it is placed under the scenario folder. If it is 

not present, it means that no maps are yet specified for the scenario. 

The vpr file saves all the settings specified in the mxd document which refer to elements loaded 

according to the TOC.  

To import in a new scenario the legends, Multi-Bandwidths, labels specified in another scenario 

proceed in the following manner: 

1) Perform step 1 to step 7 for the current scenario 

2) Right click on RailBdir_Link layer 

3) On the window select "Copy Layer Settings From Another Layer"  
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4) Select the Vpr file from scenario having the map you want to use (in the example 

Base2006R64 folder and Output0_Base2006R64.vpr file) 

5) Select the layer having the same name of the current network (e.g. Rail_BDir) 
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6) Click on GIS Analysis tab in the interface and click on Multi-Bandwidth tool. The legend 

specified in the other network will be prompted automatically. 

7) Click on OK 

8) Click on X to close the map, the system will prompt if it is necessary save the map giving 

a location and a name. Select the scenario folder and give the name "RCM_64.mdx". 

9.4. Attributes names for maps 

The available attributes that could be visualize in a map for networks 1,2,4,5 in Table 32 are 

listed under 11.4.2. Here the attributes in networks 3,6 and 7 in Table 32 are listed. 

Attribute Meaning Network 

TOT_ROAD_T
M_BD 

Bidirectional tonne flows on road in 
millions 

Loaded_Bid_STD (Bidirectional 
tonnes per mode STD) 

Loaded_Bid_RCM (Bidirectional 
tonnes per mode RCM) 

TOT_RAIL_TM
_BD 

Bidirectional tonne flows on rail in 
millions 

TOT_SEA_TM_
BD 

Bidirectional tonne flows on sea in 
millions 

TOT_EMPT Bidirectional empty train flows per day 

Rail_Bdir (Report #15b Rail 
Capacity Network) 

TOT_ASS 
bidirectional per day total train flows 
(empty + loaded 

TOT_LOAD 
Bidirectional number of loaded trains 
per day 

CAP Bidirectional capacity [#trains/day]  

FLAG_OVCAP 
1 if over capacity load of 1 train/day, 
otherwise 0 

FLAG_PER 1 if over capacity load of 1%, otherwise 0 

FLAG_TOT 1 if FLAG_PER=1 or FLAG_OVCAP=1 

DIFF_VC 
Differences in number of trains over 
capacity  

Table 33 Attributes in geodatabase networks. 
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11. Appendices 

11.1. Dimensions in the model 

The following tables are copied from the program documentation (reference no.1 on previous 

page, Appendix A). 

Table A-1: Overview of commodity types: 
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Table A-2: Overview of vehicle type numbers, and aggregate modes for container transport and 

non-container transport. 
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Table A-3: Transport chains used for Sweden 

 

Number Potential Chain Explanation 

1 A Direct transport by heavy lorry, using containers (see Table 3) 

2 ADA Heavy lorry, Kombi train - heavy lorry, with containers 

3 ADJA Etc. 

4 ADJDA   

5 ADKL   

6 AJ   

7 AJA   

8 AJDA   

9 AKL   

10 APA   

11 B   

12 BR   

13 BRB   

14 BS   

15 BSB   

16 C   

17 CGH   

18 CGHC   

19 CGHM   

20 CH   

21 CHG   

22 CHGC   

23 CM   

24 CMC   

25 CMI   

26 CMT   

27 CMU   

28 CPC   

29 CUM   

30 GH   

31 GHC   

32 GHG   

33 GHM   

34 GHMI   

35 GHMT   

36 GHMU   

37 GHQH   

38 HC   

39 HG   

40 HGC   

41 I   

42 IM   
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Number Potential Chain Explanation 

43 IMC   

44 IMHG   

45 J   

46 JA   

47 KL   

48 LK   

49 LKA   

50 LKDA   

51 M   

52 MC   

53 MHG   

54 MHGC   

55 MI   

56 MT   

57 MU   

58 RB   

59 SB   

60 T   

61 TM   

62 TMC   

63 TMGH   

64 U   

65 UM   

66 UMC   

67 UMGH   
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11.2. Empty vehicles description 

The computation of the empty vehicles matrices in the current version of the model is based on a 

non-linear, non-separable model. Therefore the output in terms of empty vehicle flows in general  

will depend on the set of commodities included in the logistics model simulations. The flows of 

empty vehicles will be correctly estimated only if the model is run for all commodities. An 

exception to this observation is the set of user defined empty vehicle modelling functions 

introduced in December 2014, in which empty train flows are modeled as strictly proportional to 

the number of loaded trains. With this setting the rail empty flows are strictly proportional to the 

loaded flows, and the results can be aggregated to total volumes from any disaggregated level.  

To obtain between scenarios comparable results it is therefore recommended that the model is 

run for all commodities. There are two cases: 

 EMPTY_OK: the catalogue key for selecting the commodity group is set to 0, which 

means that all commodities are selected for the logistics model simulation; This 0 is also 

added to the vehicle OD-matrix names as for example OD_Tonnes201_0.314, which 

during the railway capacity management procedure are renamed to 

OD_Tonnes201_STD.314, where STD stands for STanDard logistics model. 

 EMPTY_ERROR: all other cases, i.e. the model is run for one commodity or STAN group 

only. In this case the empty vehicle flows will in general be  according to non-separable 

relationships. 

The program originally gives three kinds of output matrices: The number of empty vehicles, the 

total number of (loaded and empty) vehicles and the number of tonnes transported. In the 

EMPTY_ERROR case, the total number of vehicles will be incorrect as well. This issue is dealt 

with in two ways, presented below.  

 

1: Compute the number of loaded vehicles.  

Instead of producing the total number of vehicles (empty + loaded), the program now produces 

the number of loaded vehicles. This is done by default, by computing  

 

the number of loaded vehicles = total number of vehicles – number of empty vehicles  

 

in an intermediate step in Cube, after the logistics model. This operation will always give the 

correct result, since the estimated number of empty vehicles (with any errors) is subtracted from 

the total number of vehicles in all OD relations (containing the same errors). The output in the 

current version is thus made up by the three types of matrices: 

 

 Number of loaded vehicles (always correct values); 

 Number of empty vehicles (comparable and correct only in case EMPTY_OK); 

 Tonnes (correct values). 

 

Furthermore, the total number of vehicles will be computed (by adding the empty and loaded 

vehicles outputs) in the case EMPTY_OK. For the other case – EMPTY_ERROR – the total 

number of vehicles will be replaced by zeros in order to reduce the risk of using incorrect values. 

This gives the extra output 
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 Total number of vehicles (correct in case EMPTY_OK, set to zero otherwise). 

 

The output in terms of total number of vehicles appears in some of the tables, but not in any of 

the networks. Generally, in the outputs, the number of vehicles always refers to the number of 

loaded vehicles, if nothing else is said.  

 

 

2: Skip estimation of the empty vehicles 

The user is given the option to not produce the empty vehicle matrices at all. The choice is made 

by setting the attribute  

EMPTY_V = 1  to produce empty vehicle matrices, or 

EMPTY_V = 0  to not produce empty vehicle matrices. 

The attribute is set for each vehicle class separately, in the table “Vehicle Parameters” (see 

Section 5.4). If EMPTY_V=0, the empty vehicle matrices will be filled with zeroes.  

 

Summarizing all the possibilities, we have the following cases and the result in each case: 

 EMPTY_V=0 EMPTY_V=1 

EMPTY_OK Empty vehicles = 0 

Total vehicles = loaded vehicles 

Empty vehicles ≠ 0 

Total vehicles = empty + loaded 

EMPTY_ERROR Empty vehicles = 0 

Total vehicles = 0 

Empty vehicles ≠ 0 

Total vehicles = 0 

Table 34 All different cases for the empty and total vehicles calculation. 

The empty vehicles calculation was designed for lorries, but is used for all vehicles as described 

above. 

 

11.3. Frequency network 

The frequency networks are saved and can be displayed as GIS maps in the Samgods model 

and could be edited as any other GIS layers, using the Compute function or the Feature Explorer 

window. However, editing these layers in the GIS window is rather difficult and slow. New 

terminals are given default frequencies, so that the user does not have to edit the frequency 

networks unless any specific frequencies should be changed. The reason for saving the 

frequency data as GIS layers instead of a matrix is that it saves hard disk space. The user just 

has to think of the node layer as the diagonal elements of the imagined frequency matrix (giving 

the frequencies within zones) and the link layer as the non-diagonal elements, giving the 

frequencies between zones. By default, the frequency network layers are initially filtered to show 

only the links and nodes connected to Stockholm.  

11.4. Variable names and their meaning 

Below, some of the variable names in different tables in the interface are listed and explained. 

Table 2 in Section 2.3 also gives information to help to understand the contents of the tables. 

11.4.1. Variables in the output tables 
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In the output tables, different variable names appear. Below Table 36 is giving the variables, their 

meaning and in which data set (in the Data Section window) they appear. These data sets are 

found in Scenario Outputs\Samgods Report\Logistics Module\OD Covered and Scenario 

Outputs\Samgods Report\Reports. 

Generally, the following abbreviations are used, separated by an underscore sign: 

NV Number of vehicles 

KM Kilometer 

TON Tonne 

TKM Tonne Kilometer 

VKM Vehicle Kilometer 

DOM Domestic 

DTOT Total domestic (domestic + domestic part of 

international) 

INT International 

TOT Total (in the sense total domestic + 

international) 

L Loaded (vehicle) 

E Empty (unloaded vehicle) 

A All (in the sense loaded + empty vehicles) 

Table 35 Abbreviations used for variable names 

 

 

Data set Variable Meaning 

Output by vehicle type NV_DTOT Number of vehicles, total 

domestic 

Output by vehicle type NV_INT Number of vehicles, international 

Output by vehicle type NV_TOT Number of vehicles, total 

Output by vehicle type, 

Output by chain 

KM_DTOT Number of kilometers, total 

domestic 

Output by vehicle type, 

Output by chain 

KM_INT Number of kilometres, 

international 

Output by vehicle type, 

Output by chain 

KM_TOT Number of kilometres, total 

Output by vehicle type, 

Output by chain 

TON_DTOT Number of tonnes, total 

domestic 

Output by vehicle type, 

Output by chain 

TON_INT Number of tonnes, international 

Output by vehicle type, 

Output by chain 

TON_TOT Number of tonnes, total 

Output by vehicle type, 

Output by chain 

TKM_DTOT Number of tonne kilometres, 

total domestic 

Output by vehicle type, 

Output by chain 

TKM_INT Number of tonne kilometres, 

international 
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Data set Variable Meaning 

Output by vehicle type, 

Output by chain 

TKM_TOT Number of tonne kilometres, 

total 

Output by vehicle type ALF_DOM Average loading factor, domestic 

Output by vehicle type ALF_INT Average loading factor, 

international 

Output by vehicle type ALF_TOT Average loading factor, total 

Output by vehicle type AVDIST_DOM Average distance, domestic 

Output by vehicle type AVDIST_INT Average distance, international 

Output by vehicle type AVDIST_TOT Average distance, total 

Output by chain COST_DOM Logistic cost, domestic 

Output by chain COST_DTOT Logistic cost, total domestic 

Output by chain COST_INT Logistic cost, international 

Output by chain COST_TOT Logistic cost, total 

Output by chain AC_TKM_DOM Average cost per tonne 

kilometre, domestic 

Output by chain AC_TKM_INT Average cost per tonne 

kilometre, international 

Output by chain AC_TKM_TOT Average cost per tonne 

kilometre, total 

Report #1 NV_A_TOT Number of vehicles, loaded + 

empty, total domestic + 

international 

Report #1 NV_A_DTOT Number of vehicles, loaded + 

empty, total domestic 

Report #1 VKM_A_TOT Number of vehicle kilometres, 

loaded + empty, total domestic + 

international 

Report #1 VKM_A_DTOT Number of vehicle kilometres, 

loaded + empty, total domestic 

Report #1 NV_L_TOT Number of loaded vehicles, total 

domestic + international 

Report #1 NV_E_TOT Number of empty vehicles, 

domestic + international 

Report #1 VKM_L_TOT Number of loaded vehicle 

kilometres, domestic + 

international 

Report #1 VKM_E_TOT Number of unloaded vehicle 

kilometres, domestic + 

international 

Report #1 NV_L_DTOT Number of loaded vehicles, total 

domestic 

Report #1 NV_E_DTOT Number of empty vehicles, total 
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Data set Variable Meaning 

domestic 

Report #1 VKM_L_DTOT Number of loaded vehicle 

kilometres, total domestic 

Report #1 VKM_E_DTOT Number of empty vehicle 

kilometres, total domestic 

Report #4 TON_DTOT Number of tones, total domestic 

Report #4 TON_INT Number of tones, international 

Report #4 TON_TOT Number of tones, dom. + int. 

Report #4 TKM_DTOT Number of tonne kilometres, 

total domestic 

Report #4 TKM_INT Number of tonne kilometres, 

international 

Report #4 TKM_TOT Number of tonne kilometres, 

total domestic + international 

Report #9 VKM_L_ROAD Number of loaded vehicle 

kilometres, road mode 

Report #9 VKM_E_ROAD Number of empty vehicle 

kilometres, road mode 

Report #9 VKM_A_ROAD Number of vehicle kilometres, 

empty + loaded vehicles on road 

Report #9 TKM_ROAD Number of tonne kilometres on 

road 

Report #9 VKM_L_RAIL Number of loaded vehicle 

kilometres, rail mode 

Report #9 VKM_E_RAIL Number of empty vehicle 

kilometres, rail mode 

Report #9 VKM_A_RAIL Number of vehicle kilometres, 

empty + loaded vehicles on rail 

Report #9 TKM_RAIL Number of tonne kilometres on 

rail 

Table 36 Variable names used in the output files in the folders Scenario Outputs\Samgods 

Report\Logistics Module\OD Covered and Scenario Outputs\Samgods Report\Reports in the 

Data Section window 

11.4.2. Variables in the assigned networks 

Below, some of the variables found in the attribute tables of the assigned networks are listed and 

explained. The outputs in terms of assigned networks are found in the folders Scenario Outputs\ 

Samgods Report\Assignment (assigned networks per mode), Scenario Outputs\Samgods 

Report\Reports (assigned network with all modes) and Scenario Outputs\Compare\Assignment 

(differences between the current scenario and the base scenario in loaded vehicle flows for all 

modes). In the assigned networks (except the compared vehicle flows, see below), the rule for 

the variable names is the following: 

Each vehicle type has a label (the labels are found in the table Scenario Inputs\Editable 

data\Vehicles Parameters in the data Section window). For example, vehicle class 101 has the 
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label LGV3. For each vehicle class there are three attributes in the network, which for the 

example for LGV3 are LGV3 (only the label), LGV3T (label + T) and LGV3E (label + E). LGV3 

then gives the number of loaded LGV3 vehicles per year on the link, LGV3T gives the number of 

tonnes transported by LGV3 vehicles per year and LGV3E gives the number of empty (unloaded) 

LGV3 vehicles per year. There is one exception from this rule and that is the attribute 

FS_TRAIN, which cannot be found in the Vehicles Parameters table. FS_TRAIN is the sum of 

the attributes FEEDV and FEEDW which are two separated assignments for vehicle class 202 

(Feeder/shunt train). 

Except the attributes for each vehicle class, there are also aggregated numbers in the networks 

(for air mode there are no aggregated numbers, since there is only one vehicle type for air mode 

(label FLYG)): 

Variable Meaning 

TOT_ROAD Total number of loaded road vehicles 

TOT_RAIL Total number of loaded rail vehicles 

TOT_SEA Total number of loaded sea vehicles 

TOT_ROAD_T Total numbers of tonnes transported by road vehicles 

TOT_RAIL_T Total numbers of tonnes transported by trains 

TOT_SEA_T Total numbers of tonnes transported by sea vehicles 

TOT_ROAD_E Total number of empty road vehicles 

TOT_RAIL_E Total number of empty rail vehicles 

TOT_SEA_E Total number of empty sea vehicles 

VOLTO Total number of loaded vehicles 

TONTO Total number of tonnes transported 

EMPTO Total number of empty vehicles 

Table 37sea vehicles 

VOLTO Total number of loaded vehicles 

TONTO Total number of tonnes transported 

EMPTO Total number of empty vehicles 

Table 38 Variable names in the assigned networks and their meanings. 

For the compared assigned network, only the loaded vehicle flows are included and they are 

represented by the vehicle class label, with the prefix DIF. For the example used above, the 

variable DIF_LGV3 gives the difference in number of loaded LGV3 vehicles, between the current 

scenario and the base scenario. Also there are differences in aggregated loaded vehicle flows, 

represented by e.g. DIF_ROAD and DIF_VOLTO (the latter gives the compared flows summed 

for all vehicle types). 
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